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About the Author

John Kaufeld got hooked on computers a long time ago. Somewhere along the way, he
discovered that he enjoyed helping people understand how computers worked (a trait
his Computer Science friends generally considered a character flaw. John graduated with

a B.S. degree in Management Information Systems from Ball State University and became

the first PC support technician for what was then Westinghouse, outside Cincinnati,
Ohio. He learned about online services in the Dark Ages of Telecommunication (the
1980s) by guessing, failing, and often doing unmentionable things to his modem.

Today, John is the president of Access Systems, a computer consulting firm. He still
does troubleshooting, conducts technical and interpersonal skills seminars for up-and-
coming computer gurus, and writes in his free moments.

John’s other IDG Books titles include Global Network Navigator For Dummies, Access For
Windows 95 For Dummies, FoxPro 2.6 For Windows For Dummies, and Paradox 5 For
Windows For Dummies. He regularly uses America Online (where he’s known as
JKaufeld) and other online services. He loves to get e-mail and valiantly attempts to
answer every message he gets.

John lives with his wife, two children, one overbearing canary, and a lovable American
Eskimo dog in Indianapolis, Indiana.

Dedication

To Jenny, for keyword testing above and beyond the limits of sanity. To J.B. and the Pooz,

for being incredibly patient. Now it’s time for Chuck E. Cheese! To my friends and compatri-

ots at IDG Books Worldwide, Inc., for the opportunity of a lifetime. Thank you, one and all.

Author's Acknowledgments

First,  want to thank my Project Editor, Pam Mourouzis, for a really great job. Due to
stamina beyond understanding (and patience beyond comprehension), Pam successfully
survived yet another round of updates. Let’s all hope that her hair grows back soon.

Special thanks also to my Technical Reviewer, Matt Converse, who made extra-special-
sure the book was actually correct. Without Matt’s help, | never could have kept up with
the myriad updates from America Online’s Department of Name Changing group.

Further up the Editorial Food Chain, thanks to Diane Steele and Milissa Koloski for being
the best folks to work with on the planet. Way out at the other end of the known world,
thanks to Gareth Hancock (who runs my particular corner of the Dummies Press
Acquisitions Department).

At America Online, thanks go to Marshall Rens, Pam McGraw, and Kelly Richmond.
Extra-special you're the greatest thanks to Bob Kenyon and Howard Rosenman, who rank
just below chocolate in my mind. And a special tip of the hat to Steve Case for the
original vision that spawned AOL.

Finally, my sincere thanks to (in alphabetical order) Barb, Brian, Jen, John, Lisa, Melanie,
Patricia, Susan, and all my other online friends and acquaintances. Jen gets an extra

virtual cookie for being an accountant (after all, somebody has to do it) and because she
let me use the profile of a certain reindeer as an example in this book. Let’s JKPARTY, y’all!
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ABOUT IDG BOOKS WORLDWIDE

Welcome to the world of IDG Books Worldwide.

1DG Books Worldwide, Inc., is a subsidiary of International Data Group, the world’s largest publisher of
computer-related information and the leading global provider of information’services on information technology.
IDG was founded more than 25 years ago and now employs more than 8,500 people worldwide. IDG publishes
more than 275 computer publications in over 75 countries (see listing below). More than 60 million people
read one or more IDG publications each month.

Launched in 1990, IDG Books Worldwide is today the #1 publisher of best-selling computer books in the

"United States. We are proud to have received eight awards from the Computer Press Association in recognition
of editorial excellence and three from Computer Currents’ First Annual Readers’ Choice Awards. Our best-
selling ...For Dummies® series has more than 30 million copies in print with translations in 30 languages. IDG
Books Worldwide, through a joint venture with IDG’s Hi-Tech Beijing, became the first U.S. publisher to
publish a computer book in the People’s Republic of China. In record time, IDG Books Worldwide has become
the first choice for millions of readers around the world who want to learn how to better manage their
businesses.

Our mission is simple: Every one of our books is designed to bring extra value and skill-building instructions
to the reader. Our books are written by experts who understand and care about our readers. The knowledge
base of our editorial stafl comes {rom years of experience in publishing, education, and journalism —
experience we use to produce books for the *90s. In short, we care about books, so we attract the best people.
We devote special attention to details such as audience, interior design, use of icons, and illustrations. And
because we use an efficient process of authoring, editing, and desktop publishing our books electronically,
we can spend more time ensuring superior content and spend less time on the technicalities of making books.

You can count on our commitment to deliver high-quality books at competitive prices on topics you want

to read about. At IDG Books Worldwide, we continue in the IDG tradition of delivering quality for more than
25 years. You'll find no better book on a subject than one from IDG Books Worldwide.

. /éyéwao_/

Z John Kilcullen
President and CEQ
IDG Books Worldwide, Inc.

WINNER

WINNER

WINNER WINNER

Eighth Annual . Eleventh Annual
Computer Press . - Computer Press
Awards 31992 Ninth Annual Tenth Annual Awards 221995
Computer Press Computer Press
Awards anm Awards 81994

{DG Books Worldwide, Inc., is a subsidiary of International Daia Group, the world's largest publisher of computer-related lnforrmuon and the ludmg global provider of & ion services on information technology.
Daa Group publishes over 275 computer publications in over 75 countries. Sixty million people read one or more | Data each month. ional Data Group's publications include: ARGENTINA:

Buyer's Guide, Computerworld Argeniina, PC World Argentina; AUSTRALIA: Ausiralian Macworld, Australian PC World, Ausmlun R:se et News, Computerworld, IT Casebook, Network World, Publish, Webmaster; AUSTRIA:
mful:r\lcll Osterreich, Networks Austria, PC Tip Austria; BANGLADESH: PC World Bangladesh; BELARUS: PC World Belarus; BELGIUM: Data News; BRAZIL: Annudrio de Informaiica, Compul:rwnrid Connections, Macworld,
layer, PC World, Publish, Reseller News, - BULGARIA: C id Bulgaria, Network World Bulgaria, PC & MacWorld Bulgaria; CANADA: CIO Canada, ClienvServer World, ComputerWorld Canada,
InfoWorld Canada, NetworkWorld Canada, WebWorld; CHILE: Computerwortd Chxle PC \\’orhfa Chile; COLOMBIA: Computerworld Colombia, PC World Colombia; COSTA RICA: PC World Centro America; THE CZECH
AND SLOVAK REPUBLICS: Computerworld Czechostovakia, Macworld Czech Republic, PC World Czechoslovakia, DENMARK: Communications World Danmark, Computerworld Danmark, Macworld Danmark, PC World
Danmark, Techworld Denmark; DOMINICAN REPUBLIC PC \\’orld R:Pubhcz Dominicana; ECUADOR: PC World Ecuador; EGYPT: Computerworld Middle East, PC World Middle East; EL SALVADOR: PC World Ceniro
America; FINLAND: MikroPC, X FRANCE: Hebdo, Info PC, Le Monde Informatique, Macworld, Reseaux & Telecoms, WebMaster France; GERMANY: Computer Partner, Computerwache,
Computerwoche Extra, Computerwoche FOCUS, Global Online, Mam:h PC Welt; GREECE: Amiga Computing, GamePro Greece, Multimedia World; GUATEMALA: PC World Ceniro America, HONDURAS: PC World Ceniro
Americz; HONG KONG: Computerworld Hong Kong, PC World Hong Kong, Publish in Asia; HUNGARY: ABCD CD-ROM, Computerworld Sumxus(cchmkz Internetto online Magazine, PC World Hungary, PC-X Magazin Hungary,
ICELAND: Tolvuheimur PC World Island; INDIA: Inft World, Information Systems Comp , PC World India, Pubhsh in Asia; INDONESIA: tnfoKomputer PC World, Komputek Computerworld,
Publish in Asia; IRELAND: ComputerScope, PC Live!; lSRAEL Macworld Israel, People & C Id; ITALY: Comp! d lialia, Macworld ftalia, Networking ltalia, PC World ltalia; JAPAN: DTP World,
Macworld Japan, Nikkei Personal Computing, 052 World Japan, SunWorld Japan, Windaws NT World, Windows World Japan KENVA PC World East Alrican; KOREA: Hi-Tech Information, Macworld Korea, PC World Korea;
MACEDONIA: PC World Macedonia; MALAYSIA: Computerworld Malaysia, PC Wortd Malaysia, Publish in Asia; MALTA: PC World Malta; MEXICO: Computerworld Mexico, PC World Mexico, MYANMAR: PC World Myanmar;
NETHERLANDS: Computer! Totaal, LAN Inteneiworking Magazine, LAN World Buyers Guide, Macworld Netheriands, Net, WebWereld, NEW ZEALAND: Absolute Beginners Guide and Plain & Simple Series, Computer Buyer,
Computer Industry Directory, Computerworld New Zealand, MTB, Netwark Warld, PC World New Zealand; NICARAGUA: PC World Centro America; NORWAY: Computerworld Norge, CW Rapport, Datamagasinet, Financial
Rapport, Kursguide Norge, Mzcworfd Norge, Mubiimediaworld Norge, PC World Ekspress Norge, PC World Neuverk, PC World Norge, PC World ProdukiGuide Norge; PAKISTAN: Computerworld Pakistan; PANAMA: PC World
Pznama; PEOPLE'S REPUBLIC OF CHINA: China Computer Users, China Computerworld, China infoWortd, China Telecom World Weekly, Computer & Communication, Electronic Design China, Electronics Today, Electronics
Weekly, Game Software, PC World China, Popular Computer Week, Software Weekly, Software World, Telecom World; PERU: Computerworld Peru, PC World Profesional Peru, PC World SoHo Peru; PHILIPPINES: Click!,
Computerworld Philippines, PC World Philippines, Publish in Asia; POLAND: Computerworld Poland, Computerworld Special Report Poland, Cyber, Macworld Poland, Networtd Poland, PC World Komputer, PORTUGAL:
Cerebro/PC World, Computerworld/Correio Informdtico, Dealer World Portugal, Mac*In/PC*En Portugal, Multimedia \Vorlr PUERTO RICO: PC World Puerto Rica; ROMANIA: Computerworld Romania, PC World Romania,
Telecom Romania; RUSSIA: Computerworld Russia, Mir PK, Publish, Seti; SINGAPORE: Computerworld Singapore, PC World Singapore, Publish in Asia; SLOVENIA: Monitor, SOUTH AFRICA: Computing SA, Network World
SA, Software World SA; SPAIN: Communicaciones World Espafia, Computerworld Espatia, DnrrWurId Espafia, Macworld Espatia, PC World Espafta; SRT LANKA: tnfolink PC World; SWEDEN: CAP&Design, Computer Sweden,
Corporate Computing Sweden, internetworld Sweden, it branschen, Macworld Sweden, MaxiData Sweden, MikroDatorn, Natverk & Kommunikation, PC World Sweden, PCaktiv, Windows World Sweden; SWITZERLAND:
Computerworld Schweiz, Macworld Schweiz, PCtip; TAIWAN: Computerworld Taiwan, Macworld Taiwan, NEW ViSiON/Publish, PC World Taiwan, Windows World Taiwan; THAILAND: Publish in Asia, Thai Computerwortd;
TURKEY: Computerworld Turkiye, Macworld Turkiye, Neiwork Worrd Turkiye, PC World Turkiye, UKRAINE: Computerworld Kiev, Mukimedia World Ukraine, PC World U‘min:; UNITED KINGDOM: Acorn User UK, Amiga
Action UK, Amiga Computing UK, Apple Talk UK, Computing, Macworld, Parents and Computers UK, PC Advisor, PC Home, PSX Pro, The WEB; UNITED STATES: Cable in the Classroom, CIO Magazine, Computerworld, DOS
World, Federal Computer Week, GamePro Magazine, Inl foWorld, i-Way, Macworld, Network World, PC Games, PC World, Publish, Video Event, THE WEB Magazine, and WebMaster; online webzines: JavaWorld, N:Lsapc\\vbdd
and SunWorld Online; URUGUAY: InfoWorld Uruguay; VENEZUELA: Computerworld Venezuela, PC World Venezuela; and VIETNAM: PC World Vietnam, 02296
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Publisher’s Acknowledgments

We're proud of this book; please send us your comments about it by using the Reader Response Card
at the back of the book or by e-mailing us at feedback/dummies@idgbooks . com. Some of the
people who helped bring this book to market include the following:

Acquisitions, Development, and Editorial Production

Project Editors: Pamela Mourouzis, Associate Project Coordinator: Regina Snyder

William A. Barton Layout and Graphics: E. Shawn Aylsworth,

Assistant Acquisitions Editor: Gareth Hancock Linda M. Boyer, Elizabeth Cardenas-Nelson,
Dominique DeFelice, Angela F. Hunckler,
Product Devel tM » Mary Bed ’ ’
oduc velopment Manager: Mary Bednarek Todd Klemme, Jane Martin, Drew Moore,
Permissions Editor: Joyce Pepple Gina Scott, Kate Snell
Copy Editor: Tamara S. Castleman Proofreaders: Melissa D. Buddendeck,
Technical Editor: Matt Converse Rachel Garvey, Nancy Price, Dwight Ramsey,

Editorial Manager: Kristin A. Cocks Robert Springer, Carrie Voorhis, Karen York

- Li ingh
Editorial Assistant: Chris H. Collins Indexer: Liz Cunningham

General and Administrative
IDG Books Worldwide, Inc.: John Kilcullen, CEO; Steven Berkowitz, President and Publisher
IDG Books Technology Publishing: Brenda McLaughlin, Senior Vice President and Group Publisher

Dummies Technology Press and Dummies Editorial: Diane Graves Steele, Vice President and
Associate Publisher; Judith A. Taylor, Brand Manager; Kristin A. Cocks, Editorial Director

Dummies Trade Press: Kathleen A. Welton, Vice President and Publisher; Stacy S. Collins,
Brand Manager

1IDG Books Production for Dummies Press: Beth Jenkins, Production Director; Cindy L. Phipps,
Supervisor of Project Coordination, Production Proofreading and Indexing; Kathie S. Schutte,
Supervisor of Page Layout; Shelley Lea, Supervisor of Graphics and Design; Debbie J. Gates,
Production Systems Specialist; Tony Augsburger, Supervisor of Reprints and Bluelines; Leslie
Popplewell, Media Archive Coordinator

Dummies Packaging and Book Design: Patti Sandez, Packaging Specialist; Kavish+Kavish,
Cover Design

¢
The publisher would like to give special thanks to Patrick J. McGovern,
without whom this book would not have been possible.
¢
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W founded America Online, Inc., with a simple objective: to make online
services more accessible, more affordable, more useful, and more fun for
people from all walks of life. And that formula appears to be working. America Online
now serves more than 6,000,000 customers, and that number is growing daily. In fact,
AQL is the fastest growing consumer online service in the nation.

That success has been driven in large part by remaining faithful to our original
charter: making online services accessible to everyone. In designing the service, we
wanted to make it as “intuitive” as possible, meaning everybody from Fortune 500
executives to elementary school students could “surf” throughout our many depart-
ments. We didn’t want customers to labor over a copy-intensive book to get con-
nected, so we made the software easy to install and use. As a result, new America
Online customers are usually up and running in less than 15 minutes. Try doing that
with your VCR.

We've also worked hard to continually add new services through strategic partner-
ships with content providers. If it seems as if America Online is in the business
sections of major newspapers on an almost daily basis, it's because we are; we are
adding new content to our service at an incredibly rapid pace and have no plans to
slow down.

And still there’s more: With increased interest in the Internet and the World Wide
Web, we upgraded our Internet gateway to permit AOL subscribers full access to this
“network of networks” and all it has to offer. And it’s all there at a simple, affordable
price.

But as good as we've been at making the service simple to operate, the sheer volume
of information available has made the online world akin to trying to tour the
Smithsonian in one day. That’s where this book, America Online For Dummies, comes
in. Although we think America Online is already “dummy-proof,” John’s book makes
AOL just that much easier to enjoy. And enjoy you will as we continue to add unique
new services, sign on more content providers, and expand AOL subscribers’ access
to the Internet.

As you'll discover, America Online is a living, breathing “electronic community” that
bridges the lives of all our members in an engaging, interactive format. Every day,
tens of thousands of AQOL subscribers go online and scan their stock portfolios, talk
to friends, make airline reservations, read their favorite magazines and newspapers,
and actively participate in discussions about hundreds of different topics. We
provide the framework; beyond that, America Online is shaped by the collective
imagination of its participants.

How often do you get to take part in a revolution? A new interactive communications
medium is emerging, and it will change the way we live, work, and play. America
Online is at the forefront of this revolution, and we invite you to join us in shaping
this new medium.

Steve Case
President and CEO
America Online, Inc.
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Introduction

H — welcome to the neighborhood!”

That probably wasn't the first thing you expected to hear when you joined
America Online, but it’s just the first of many surprises awaiting you. America
Online is quite different from those other online services. Luckily for you,
America Online For Dummies, 3rd Edition, is equally unique.

This book is your friendly tour guide and road map to an intriguing corner of
the digital world. In here is everything you need to get started with (and get the
most from) the friendliest and fastest growing online service in the country:
America Online. The best part is that you don’t need to be some normalcy-
challenged computer technoid to make sense of it all. America Online For
Dummies, 3rd Edition, is written in plain language — the way everyone talked
back when computers interfaced and people had conversations. The book is
designed to give you the information you need quickly so that you can get back
to the fun stuff at hand.

But don’t just take my word for it — jump on in and discover what’s here for
you. I think you’ll be pleasantly surprised.

Who | Think You Are

To know you is to understand you, and goodness knows, if I can’t understand
you, I can’t help you. With that statement in mind (a challenge in itself), here's
what | know about you:

I~ You're either interested in America Online or are currently using it (and
. are feeling the effects).

+* You use an IBMcompatible or a Macintosh computer.
i; +* You have a modem attached to your computer.
+” You care more about dinner than about modems and computers combined.

|| v Terms such as BPS, download, and Internet nip at your heels like a pack of
: disturbed Chihuahuas.

If these statements sound familiar, this book is for you.
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It’s All English — Except for Parts in “Geek”

When you're working with America Online, it’s kind of like being in a two-way
conversation: You give commands to the system, and the system displays
messages back at you (so be careful what you say!). This book contains stuff
about both sides of the conversation, so keep in mind the following ways to help
you figure out who’s talking to whom:

If the text 'Td'ok"s' Tike ‘this, Amemca Online is say1ng some—
thmg c]ever on screen that you don t want to m1ss

If the text looks like tlus, it’s somethmg you need to tell America Online by
typing it somewhere on-screen. (Remember to be nice — no yelling.)

If it’s time to choose something from a menu, the text shows some options
separated by an arrow — for example, Mail>>Compose Mail. That means you
should choose the menu marked Mail and then click the Compose Mail option.

Because you're using America Online in either a Macintosh or Microsoft
Windows environment, you also must deal with the mouse. In this book, |
assume that you know the following basic mouse maneuvers:

Click Position the mouse pointer and then quickly press and release
the mouse button {specifically, the /eft button, if your mouse
has two to choose from).

Double-click Paosition the mouse pointer and then click twice — basically,
two regular clicks. (That's why they call it a double-click —
remember, the people who designed this stuff weren't hired to
be clever.)

Click and drag Position the mouse pointer and then press and hold the mouse
button as you move the mouse across the screen. As before,
use the left button if you have more than one button. After the
mouse pointer gets to wherever it's going, release the button.
You often use this technique to highlight some text on-screen,
such as when you're editing a mail message.

Right-click This doesn’t do anything in America Online, but at least it
makes you fee/ as if that other button is there for a reason.

If all this mouse stuff is news to you, | wholeheartedly recommend picking up a
copy of Windows 3.11 For Dummies, 3rd Edition, Windows 95 For Dummies, or
Macs For Dummies, 4th Edition, all from IDG Books Worldwide, Inc.
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Frolicking (Briefly) through the Book

This book is organized into five distinct parts, plus a couple of appendages —
oops, sorry — appendixes. To whet your appetite, here’s a peek at what
each contains:

Part I: Driver’s Ed for the Digital Traveler

This answers the stirring question, “Just what the heck is America Online and
why do 1 care?” Part 1 gives you a broad overview of what the whole service is
about. It explains what you need to know about online services in general,
walks you through an average America Online day, gives you some pointers for
making the place a little more like “home,” and concludes with some tips for
being a good online citizen. In short, it’s kinda like digital driver’s education.

Part Il: Surviving the Software

At least half (and possibly more) of working with America Online is dealing with
the custom communications software. It’s this software that really sets America
Online apart from its competitors. America Online’s software is a full-featured
program that does everything except wax your car (and I've heard they’re consider-
ing that for a future version). This part pushes the buttons, plays with the windows,
and generally fiddles with everything else that’s important to your online life.

Part I: Flipping through the Channels

In yet another attempt to keep you from completely shorting out when faced
with all the stuff America Online has to offer, the service is split into channels.
Part Ill looks behind all those doors and introduces each one in turn. You find
out what'’s available and where to look for the things that interest you. You
even get spaces to write in notes about additional services (because something
new is always popping up).

Part IV: Going Your Own Way

This part is especially for you — well, for you, your kids, your neighbors, and
various broad stratas of the country’s entire populace. You see, this part has a
chapter for just about everyone. That’s the whole point of Part IV: to give you a
view of America Online from whatever unique perspective you may have,
whether as a parent, a student, a small-business person. .. or something else.
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Note: If you're already an America Online user and are not using Version 3.0 of
the America Online software, you won'’t see the clever channel motif that the
AOL programmers came up with for this latest version, and you won'’t see 21
channels, either. They did some reorganizing this time around and turned the
14 departments into 21 channels. Always something.

[ strongly recomnmend that you upgrade to the 3.0 version as soon as possible,
which you can do with the enclosed disk if you're running Windows. Mac users
can call 1-800-827-6364 to get a copy of the Mac version when it’s available.

Part U: The Part of Tens

It just wouldn’t be a ...For Dummies book without a Part of Tens. You'll find here
what you need to make your money go further, make sense of what'’s happening
in the chat areas, and get a few more laughs in before the end of the day.

Appendixes

No, the Appendixes are not a chain of mountains in the outer reaches of
Mongolia; they're the last two chapters (sorta) in the book. The Appendixes tell
you how to install the America Online software on a Macintosh or in Microsoft
Windows 3.1 or 95. They explain the entire installation process (and even tell
the Macintosh folks how to get a free copy of the latest America Online software;
Windows users, of course, have the one included with this book — but don’t
gloat!). If your software is still languishing on a disk, this is the place to start.

Icons, Icons Everywhere

To make finding the important stuff in the book a little easier (and to help you

steer clear of the technical hogwash), this book has a bunch of icons scattered

throughout. Each icon marks something in the text that’s particularly vital to
oS Avg, your online existence. Here's a brief guide to what these little road signs mean:

This icon marks ideas that stretch your online dollars as far as possible. Put
enough of these to work and this book pays for itself (really — it will).

This icon notes details that you should keep in mind. Why? That’s an excellent
question. Because they’re important, that’s why.
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If you see a Remember icon, get out your highlighter, because the text is
definitely worth bearing in mind, both now and in the future.

You can benefit from my experience (both good and bad) whenever you spy a
Tip icon. Whether it marks a trap to avoid or a trick to make your life easier,
you can’t go wrong heeding a Tip.

Like it or not, I have to include some truly technical twaddle. To shield you from
it as much as possible, I mark the techie stuff with this icon. If you see this
turkey, flip — don’t lazily turn — to the next page. Really, it’s better for every-
one this way.

If you need to do something that’s just the tiniest bit dangerous (such as
walking the trail into the Grand Canyon while blindfolded and on laughing gas),
this icon tells you to proceed with caution. Pay close attention to these warnings;
they mark the most dire of pitfalls. (Don’t worry, though; they aren’t too
frequent in America Online.)

A few things work a little differently on the Mac than they do in Windows. This
icon points you Mac users to information and procedures that relate specifi-
cally to the Mac.

It’s Time to Get Started!

So much for the introductory stuff. Time to get out there and see what you can
do with America Online. If you're completely new to America Online, go through
Chapter 1 before doing anything else. You may also want to swing by Chapter 2
for some ideas of where to start. More experienced AOLers can go directly to
Parts lll and IV to catch up on the latest in America Online services.

Either way, go on out there and have some fun — and keep this book handy,
just in case you need a little help now and then. ’
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In this part . . .

river's Education class is the only thing holding this
country together. It’s a massively shared experience.
Everyone, at one time or another, learns how to drive. And
we all do it with white knuckles the first time, thinking that
20 miles per hour is kinda fast and that maybe we ought to
ease it down to a nice, pedestrian 10 miles per hour for
a while.

The first time you face the vast plains of the online world,
that old memory may rise up. Gripping the disks with white
knuckles, wondering if maybe 14,400 bps isn't just a little
fast and that perhaps you should just run the modem at
2,400 bps until you get the hang of it.

Hey — it’s going to be okay. The truth is that you can surf
the Internet, hold an interactive conversation with people all
over the country, and receive files from a computer that’s
7,000 miles away without knowing (or caring to know) the
details of how it all works.

This part gives you an overview of what this crazy America
Online thing is all about and what it can do. It also offers
some tips for getting comfortable in your new digital habitat
and a note or two about working and playing well with
others online,

Get ready for the ride of your life. Now, where did I put
those car keys?
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Chapter 1

What You've Gotten Yourself Into
(and What You Need to Get Qut)
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In This Chapter

p What this online thing is all about
» The stuff you need to make it work

» Details about hardware, software, modems, and more
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perhaps you just bought a new computer and happened across a stray icon
labeled America Online. Or maybe your parent, child, or significant other
decided that it was time for you to join the online revolution and endowed you
with all the goodies this revolution requires. Or perhaps you don’t quite know
what to make of all this talk about the Information Superhighway and worry that
you're getting left behind at the rest stop.

If you want to get an idea of what online means and understand what it takes to
get there with America Online, this is the place to start. This chapter explains
all this introductory stuif to prepare you for the real meat of the issue; actually
going online. { Don’t panic — that happens in the next chapter.) For now, kick
back and get ready to understand what your parent, child, or significant other
has been talking about all this time.

What Onfine Really Means

What is this online service stuff anyway? And does it have something to do with
the Information Superhighway? Do you even care? Why or why not? Please
write a detailed answer on the inside cover of a matchbook and then set the

whole thing on fire, watching with pleasure as it burns to a crisp. Don’t you feel
better now?
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If you do, you're not alone. Many people feel apprehensive about this mysteri-
ous electronic world you're entering. Take heart, though, because online
services used to be much more mysterious than they are today. Don't worry if
the whole concept seems more than a bit bizarre to you right now. That’s okay;
the reaction is normal. Mainly, those feelings prove you're not a nerd. Congratu-
lations on passing the test!

But back to the question at hand: What is an online service? Conceptually, it's a
lot like cable TV. You buy a subscription from your local cable company

and hook your television into its network with a funny looking box that freaks
out sometimes. A special wire connects the box to a wall socket. If everything
does what it’s supposed to, you turn on the TV and choose among

a wide variety of programming, depending on.your interests. When it doesn’t
work, the problem may be in your TV, with the used-to-be-funny-looking-but-is-
now-totally-brain-dead little box, or somewhere from the wall jack to the cable
company itself. At the end of the month, you get a bill that you grudgingly pay,
all the while wondering if cable TV is really worth all the money you spend on it.

With a few clever substitutions, the same analogy describes America Online
(and those other online services as well). You hook your computer to a funny
looking box called a modem (which, like its cable TV counterpart, sometimes
freaks out), and plug a plain phone cord from the modem to the phone jack on
the wall. With some special software, you sign up for an America Online ac-
count. If everything does what it’s supposed to do, you dial a local number and
contact America Online’s computers in Virginia. After connecting, you choose
among a wide variety of services, depending on your interests. When things
don’t work, the problem may be with your computer, the software, the modem
(stupid modems . . .), or somewhere from the wall jack to America Online itself.
At the end of the month, you get a bill that you gleefully pay, flush with the
memory of everything you did online.

By the way, the term online means “to be connected with.” If you're online
with America Online, a link is actually set up through the phone between your
computer and America Online’s computers. When you get right down to it, the
computers are having this swell digital conversation behind the scenes, while
you're busy reading the news, sending electronic mail, or doing whatever else
you do on America Online.

The entire process looks much like Figure 1-1. Your computer, running America
Online’s special software, tells the modem to call a particular phone number.
The modem dials the number and waits to hear from another modem. The two
modems whistle and beep at each other for a while (the technical term for this
is feature negotiation, although I always thought of it as some kind of electronic
flirting). After the modems settle down, they get to work completing your
connection to America Online’s computer system.
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America
Online’s
computers

America
Online's
modem

|
Figure 1-1:
Going online
usually
means

going “on-
phone-fine.”

Want to know something neat? That’s all you need to know about the technol-
ogy behind America Online. Really — I wouldn’t kid you about something like
this. All the cool things you can do, all the fun tricks, all the stuff that makes
America Online a really wild and woolly place — all these do require a lof of
technology, but it doesn’t matter to you. You don’t have to know any of this to
use America Online!

All It Takes Is a Bunch of Stuff |

Now that you have a conceptual picture of how all this online business hap-
pens, you're ready to dig a little deeper and get into some specifics. You need
four parts to make this online thing a reality: the America Online software, a

. computer, a modem, and a phone line. The following sections explore each
element just enough to give you a good understanding of what you need
without turning you into a computer nerd (ewww — the very thought gives me
the shivers).

If you're starting from scratch and need to get everything, | recommend finding a
computer guru to give you a hand. Depending on where you find your guruy, this
help may cost anywhere from a few dozen brownies to a few dozen greenbacks.
If you do seek expert help, make sure that your expert understands online
services ( preferably America Online) and gives sound, unbiased advice. Don’t
get help from someone you just met whose primary experience comes from
working at a computer store. Check with your friends for the name of a trusted
and handy computer guru you can borrow for a while.
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First, you need the vight software

America Online is a pretty special place, not only because of its content and
services but also for the look and feel of its interface (the buttons, menus, and
windows that are on-screen). America Online’s programmers reviewed how
other online services looked and worked. From this investigation came a
startling analysis: “Yuck. Where are the windows? And the mouse? What — no
buttons or drop-down menus? Geez, this is grim.”

America Online’s programmers decided to do things the right way from the
start. This decision meant a break with tradition, because people would need
special software to join America Online; they couldn’t use the good ol’ modem
program they knew and loved. It was arisk, but it paid off handsomely in better
features, ease of use, and consistency.

To sign on to America Online, you need the official America Online access
software -— accept no substitutes. You can’t use PROCOMM PLUS, MicroPhone,
or any other plain vanilla modem program. Nope, they just won’t work with
America Online. But don’t let that worry you, because the access software is
(lean in closer, I don’t want everybody to hear this) free. Better still, the latest
copy of the software for Windows is right in this book!

If you're a Macintosh user, please don't feel left out. You can get a copy of the
latest America Online software by calling 800-827-6364. ( Plus, you can give the
software for Windows that comes with this book to a friend who uses Windows
and then have someone to explore the service with.)

If the America Online software came preloaded on your computer, make sure that
you have the latest version. Table 1-1 shows the current software version
number for each kind of computer platform that America Online supports and
explains how to politely find out which version you have. You don’t have to be
(and, in fact, shouldn’t be) signed on to America Online to find out the software
version number.

Table 1-1 Version, Version, Who's Got Which Version?

Platform Current Version  How to Find the Version Number

DOS 16 With the America Online software running, choose
Help=>About from the Main Menu. The version
number is in the pop-up dialog box. (See the
impending sidebar for some important information.)

Macintosh 2.7 In the Finder, click the America Online icon once
and then choose File>Get Info from the Finder
menu or press 38+1. The version number is in the
pop-up information dialog box {see Figure 1-2).
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Figure 1-2:
Check the
version
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Macintosh
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the Finder.
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Platform

Current Version

How to Find the Version Number

Windows

3.0

With the America QOnline software running, choose
Help=>About America Online from the menu bar.
The version number is near the top of the screen
(see Figure 1-3).

=M= America Online v2.7 Info

&

Kind:
Size:

Yhere:
Created:
Modified:
Version:

Comments :

America Online ¥2.7
America Online v2.7

application program

833K on disk (851,009 bytes used)

Access: America Online ¥2.7

Folder:

Fri, Apr 12, 1996, 9.00 AM
Fri, Apr 12, 1996, 9:00 AM
27 Copyright ® 1987-1996
America Online, Inc. AN rights

D Locked

~Memory Requirements ..

i Suggested size:
Minimum size:

i Preferred size:

2000

2000 |k
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ofE Although knowing your program’s version number seems a little nerdy, you
have a good reason to find out what it is. This book covers the newest America
Online software. If you're using an older version, you’re going to get confused
very quickly (and that’s definitely not my goal). Also, if you're using the soft-
ware for DOS, now’s the time to consider upgrading to Windows (see the
sidebar “Alas, poor DOS, I knew it well” for details).

A computer is a must

You can’t get around this one: To use America Online, you must have a com-
puter. Sorry, but that's the way these things go. Having settled that point, the
next logical question is, “Okay, smart guy, what kind of computer?” “Well,” |
reply, “that’s up to you.”

Because America Online’s special access software comes in both Macintosh
and Windows versions, you have some leeway in choosing your computer.

(A DOS version also exists, but just pretend that it doesn’t.) Choose whichever
one you feel more comfortable with. Don’t worry if you use Windows at work
but prefer a Macintosh for home (or vice versa). You’'ll be able to share docu-
ments, spreadsheets, and many other files between your computers without
any problems.
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If you buy a new computer for your online adventures, make sure that it has the
following:

1~ A fast processor (at least a Pentium for Windows or a Power PC in a
Macintosh)

+” Plenty of random-access memory (8 to 16MB is good for either a
Macintosh or Windows)

1+ A quality color monitor (15 inches is a good size, 17 inches is better)
v Lots of hard disk space (800MB or more)

If all this computer jargon sounds foreign to you, pick up a copy of PCs For
Dummies, 4th Edition, or Macs For Dummies, 4th Edition, both from IDG Books
Worldwide, Inc.

A modem enters the picture

The next piece of the puzzle is a modemn, the device that converts your computer’s
electronic impulses into whistles, beeps, and various digital moose calls. It then

yells these noises through the phone line to another equally disturbed modem
attached to another computer.

The term modem is actually an acronym (and you thought you were safe, didn’t
you?). It stands for MOdulator/DEModulator, which is a computer nerd’s way of
saying that it both talks and listens. To learn more than you could possibly want
to know about modems, get a copy of Modems For Dummies, 2nd Edition, from
IDG Books Worldwide, Inc.

The main things you're looking for in a modem are a well-known manufacturer
and blazing speed. My recommendations are as follows:

& 17 Get a modem made by US Robotics or Hayes. Although many other
: modems are available, these manufacturers stand behind their products
better than all the rest.

»# If you're buying a new modem, make sure that it’s fast — 28,800 bits per
second ( bps) is above average these days, 14,400 bps is good and 2,400
bps is utterly out of the question.

v If you buy a 28,800 bps modem, get one that supports the V.34 standard.
# V.34 is the international screeching and whistling standard for 28,800 bps
modems. More importantly, you don’t want a modem that only supports
something called V.FC (a competing modem standard).

Many computers include a modem as part of the deal these days. If you aren’t
sure whether your PC includes one, glance at the back of the machine and look
for a place to plug in a phone cord. Congrats — there’s your modem!
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What about a phone line?

All this other stuff won't do you a whit of good if you don’t have a phone line
to connect it to. The phone is your link with beautiful, metropolitan Vienna,
Virginia, the home of America Online. Luckily, you don’t need a special phone
line — just about any phone line will work.

The key words in that last sentence are just about, because not all phone lines
are created equal. Many phone lines have been endowed by their subscribers
with certain very alien services — such as call waiting — that interfere with a
computer’s basic rights to life, liberty, and the pursuit of a connection with
America Online. .

(Sorry, I've been reading American history lately and got a little carried away. If [
had an “I'm so embarrassed” icon, rest assured I'd insert it here.)

To successfully use a modem, you need an analog phone line. If your home
has a single phone line (or two plain, old-fashioned phone lines), you have an
analog phone line. Fax machines need the same kind of phone line, so in
times of emergency, you can unplug the fax and use its phone line to reach
America Online.

At work, the story is a little different. Many office telephone systems use
digital phone lines. You shouldn’t plug a normal modem directly into one of
these lines. Please, for the sake of your modem, don’t try. At best, the modem
won’t work this time. At worst, the modem won't ever work again because it’s
fried. If you're planning to use America Online from the office, contact your
telephone folks and tell them that you have a modem and need something to
connect it to. Remember to ask nicely, or they may not give you the answer
you're looking for.
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Put your call waiting on hold

One final note about call waiting: You need to disable it when you call America
Online. I'm not saying that you have to disconnect call waiting, just that you
need to turn it off when your modem starts to dial. Luckily, doing so isn’t hard
at all. Those clever engineers at the phone company made it pretty simple —
and the America Online software will do it automatically every time you dial.
Just follow these steps:

1. Start the America Online software but don’t sign on to the service yet.
2. In the Welcome dialog box, click Setup.
Doing so opens the Network & Modem Setup dialog box.

This process is a little faster on the Mac. Instead of displaying yet another
dialog box, the Macintosh America Online software takes you directly to
the Connection Settings dialog box in Figure 14. Because you’re already
there, skip ahead to step 4 and wait for the Windows people to catch up.

3. Click the Home entry in the Choose Location list box and then click
Edit Location.

The Network Setup dialog box pops into view. If you have call waiting at a
different location than Home (the in-laws’ house, for example), choose that
location instead of Home.

4. In Windows, click the “Use the following command to disable call wait-
ing” check box, near the bottom of the dialog box, to have the software
automatically disable call waiting. On the Macintosh, the setting is
called “To disable call waiting, dial,” but it works the same way.

Figures 14 (for the Macintosh) and 1-5 (in Windows) show you how it’s
done. On the Macintosh, remember to click in the “To disable call waiting,
dial” checkboxes for both the primary and secondary phone numbers.
The generally accepted “please disable call waiting” code is *70,. The
comma right after the code tells the modem to wait a couple of seconds
before dialing America Online. This pause gives the phone company time
to get its act together and be ready for the phone number you're dialing. If
this code doesn’t work with your phone system (and your telephone
company may do things differently), call the operator and ask how to
disable call waiting. If she tells you it’s *67 where you live, change the
entry in the disable call waiting box from *70, to *67,. (I'm just using *67
as an example. In Indianapolis, the built-in *70, code works just fine.)
Don'’t forget to put in the comma after the new code if you change it.

5. Click Save to save your changes and close the dialog box.

If you're using a Macintosh, you’re done — and a step early, too!
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6. Click OK in the Network & Modem Setup dialog box to make it go away.

That'’s it — you're done. Every time you call America Online from Home (or
whatever location you changed), the software automatically dials the
special “make call waiting go away” code and then makes its computer
connection. Pretty cool, eh?

ETE=—— e |

Connection Settings
First Try Secand Try
Connection File: Connection File:
Connection Speed: | 14400 bp hd Connection Speed: {2400 bps hd
R
. Phone Number : Phone Number : | 299-6766
Figure1-4: | —  ———————
o reach outside Yine, dial {9, To reach outside line, dial
e T tside line, dial | 9 1
Connection &To disable call waiting, diau| *70, [0] To disable call waiting, dial
Settings PJ TouchTone B TouchTone
H Hardware Handshakin Hard Handshakin
dialog box, X 9 X Hardware "
readyfor | Comectionport: Comnestion Port:
your Modem Type : [Intel 14.4 €X - Modem Type:
changes.
9 (Help ] [ Cancel) ﬁ Save iﬂ
R

Network Setup

Location: liome I
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e | PM0N€ Number: [681-9300 |Phone Number: 977-1000 |
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One click | Netwark: [ AoLnet %]  Network: [ AoLnet ||
and.(_:a" {1 Use the following prefix to reach an outside line: '9, ,
waiting ) ,
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you again.
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Chapter 2

A Brief Romp through
an Average Day
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In This Chapter

p Starting your online day

p Checking your mail

p Reading the rags

p Making sense of your dollars

p Grabbing some new software

p Surfing the Internet wave

p Shopping — need more be said?
p Chatting with the neighbors

p- Relaxing with some online games
» And still there’s more

S 2000080 0C0CH80EHOC00000CE6OS0E0000C0000020006000e000e

eep Beep Beep Beep BEEP BEEP! [whack] {yawwn} <<strrreeetch>>

Ah, good morning! Nice to see you're up (and looking as bright-eyed and
bushy-tailed as ever, I might add). A full chapter lies ahead, so I'm glad you
slept well.

This chapter is a whirlwind tour through an average online day. Think of this
tour as a visual sampler, a platter of digital appetizers, each one delicious in
itself, but also tempting in the knowledge that more waits to be discovered.
Collectively, this chapter gives you a broad idea of what you can do with
America Online — and what it can do for you.

For now, kick back and read on. If something piques your interest, take a break
and try it online. Each section of the chapter includes the keywords and menu
instructions you need.
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First, You Need to Sign On

The online day has to start somewhere, and signing on to the service is as good
a place as any. Just follow these steps to sign on to America Online:

1. Turn on your computer, monitor, modem, stereo, food processor, and
cordless toothbrush/answering machine. Marvel at what modern tech-
nology has accomplished (and how noisy it all is), and then turn off the
unimportant stuff.

No, you need to leave the computer on for now.

2. If you’re on a PC, you may also need to start Windows. At the DOS
prompt, type WIN and press Enter.

On the other hand, Windows may start automatically on your computer. If
that’s the case or if you're using a Macintosh, skip ahead to the next step.

3. Find the triangular America Online icon cowering among all your other
software icons and double-click it to start the program.

Figure 2-1 shows the America Online icon in Windows with its little tiny
title. Figure 2-2 is the same view, Macintosh style. After the program
finishes loading, it displays the Welcome dialog box, as in Figure 2-3.

America Online

Oriine

|
Figure 2-1:
The America
Online icon
in Windows.
|
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4. Choose the screen name you want to use (if you have more than one) by
clicking the down arrow next to the Select Screen Name list box and
clicking the name of your choice.

Don't panic if the Enter Password text box disappears after you choose a
screen name. That means the password for that name is already stored in
the access software. You can find more about this feature in Chapter 3.

Even if your account has more than one screen name, you can sign on with
only one at a time. To switch from one screen name to another, sign off the
system, select the new screen name in the Select Screen Name list box,
and then sign on again. This solution’s not elegant, but it works.

5. Press Tab to move down to the Enter Password text box and type in
your password.

Your password appears as asterisks — not words. That’s a protection
feature to keep that guy looking over your shoulder from breaking into
your account. What guy? Why, that one right there. (Yipe!)

6. Click Sign On to open the connection to America Online.

The software goes through all kinds of cool visual gymnastics while it’s
connecting (as shown in Figure 2-4), but all this glitz really does serve a
purpose. If the process doesn’t work for some reason, make a note of the
last step number (in Figure 2-4, for example, the process is on step 3). If
you talk to the America Online technical support group, it needs that step
number to solve your problem. Before you call for help, though, you may
want to breeze through Chapter 37 for the top ten problems and how to
solve them.

7. After a moment, the Welcome window appears on-screen, just like
Figure 2-5.

Congratulations — you’re online and ready to get some stuff done.
Chapter 6 explores these windows (in case you're interested).

To see the Channels window, either click anywhere in the Channels
window’s title bar or click the Channels button on the Toolbar. By the way,
if you don’t see the Channels window on your screen, don’t panic yet. It
may not be configured to appear automatically. To find out, turn to the
“Preferences” section in Chapter 3.

Checking the E-Mailbox

Electronic mail (or e-mail) is one of America Cnline’s most popular services.
That's why you can find a big graphic button right in the Welcome window to
tell you whether mail is waiting in your inbox. You can’t miss the YOU HAVE
MAIL button in Figure 2-5 because it kinda takes over the bottom left side of the
window. If you don’t have any mail waiting, the graphic shows a closed mailbox
emblazoned with Mail Center.
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To read your mail, either click somewhere on the graphic button or choose
Mail=>Read New Mail from the menu. After the New Mail dialog box pops up, a8
in Figure 2-6, click Read to start through your mail.

§ v liyou're writing a mail message instead of reading one, why are you logged
in? Sign off the system and choose Mail=>Compose Mail to write your

[ message offline. After you finish, turn to Chapter 7 and read about the

"‘ myriad ways to send mail.

g If youdo alot of e-mail with America Online, and want to save both time
; and money, then I see FlashSessions in your future. Mark your place and
flip ahead to Chapter 7 for more about this incredibly useful feature.

i
||

As you may have figured out by now, Chapter 7 tells you everything you need
to know about addressing, sending, receiving, and generally dealing with e-mail.
I had to put this information somewhere and that seemed as good a place as any.

America Onling

Mall Members Window Help

) D PORMO EFERE

o T TR ~1

Lot

B

!yl P WY AN LS .00

08/ 0 1C8 Leigh Upcoming Rolunda Events June 23 July 3
08/10  netnow@cmp.com NetGuide Nowt-—June 8-1 5,1998

06110  YBizHart lunch guest

REMINDER: AOL 8tafl will never ask for your pagsword ar billing information. =)
Figure 24: Kesp o
Ready to TR E——
read the T | ICONNECTION TR ]al Congress.
message. N

SEEEEEEE. L

Reading the Moring Paper
(And a Magazine ot Two)

There’s nothing like disappearing behind the morning newspaper while waiting
for that first cup of coffee to turn you into a human being. With America Online,
you have your choice of not one, not two, but — heck — a whole slew of
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newspapers and magazines. To get there, click the Newsstand button in the
America Online Channels window or use keyword Newsstand. The Newsstand
dialog box, as in Figure 2-7, appears at your call.

If newspapers are your thing, try the Chicago Tribune, the New York Times, or
the San Jose Mercury News. Are you more into magazines? Check out the Atlantic
Monthly, Navy Times, Newsweek, Scientific American, or (my favorite magazine
in the world) Wired. To curl up with whatever publication suits your fancy,
scroll through the Publications list box in the Newsstand dialog box and
double-click your choice.

If you find a lengthy article that interests you, save it to your computer’s disk
drive by choosing FilewSave from the menu bar and read it after you sign off
America Online.

QP To find out lots more about this Newsstand stuff, check out Chapter 23.
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Eyeing the Markets

Managing your stock portfolio was never easier than this. America Online’s
Quotes & Portfolios service (keyword Quotes) tracks the stocks closest to your
heart and pocketbook.

To satisfy a brief curiosity, you can look up a single stock by its symbol.

Figure 2-8, for example, tracks America Online’s stock activity by using the
symbol AMER. If looking at the big picture is more to your liking, the Display
Portfolio feature (keyword Portfolio) follows all the stocks you choose, tracking
the current market price and how that translates into a gain or loss for your

"invested dollars.

v Don't panic, but the information in Quotes & Portfolios is delayed about 15
minutes. | guess that means you can't call it up-to-the-minute information.
Hmm — how about up-until-quite-recently information?

»* You can save the portfolio information to a text file by choosing Filec>Save
from the menu bar.

America Online charges no extra fee to use the Quotes & Portfolios service —
it’s just part of the service. Flip ahead to Chapter 26 to find out more about
America Online’s financial offerings.
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Quotes & Portfolios

« g

Sponsored
QUCTES & PORTFCLIOS PCFH!
Get Quote Add to m‘olio ! Lookup
-] AMER - AMERICA ONLINE INC DEL
{ Last Price: 49 3/4 on B/
1 Change: Up 34 (+1.53%)
) High: 50 1/8 on 6/11
"] Low. 49 on 6/11
-{ Open: 43172 on 6111
I || Pravious Close: 43 on 810
. . ] Volume: 2,245 800
Figure 2-8: || giores Oustanding: 82280000
Be a stock |} 52-week High: 71
spy with | 52-Week Low: 18
-] Yield: 0.00%
PQ‘::fters & MpeErato. o4
Ortiolios. | e rrnn Update | New Features!
R |y ————

Internet On-Ramp, Next Right

At this point in your online life, you’ve probably heard, read, or otherwise been
exposed to something about the Internet. If you haven’t heard about the Internet
yet, don’t worry; you're about to.

The Internet is the worldwide “network of networks” that’s all the rage these
days. You can't get your hair done, shop for tires, or even play cricket without
bumping into the Internet somehow. “Oh, is that a new cricket bat?” you ask.
“Aye, a player in the rec.sport.cricket Internet newsgroup recommended
it.” See what [ mean?

Several broad kinds of services are available on the Internet. Through the
America Online Internet Connection (keyword Internet), you can reach the
World Wide Web, Gopher, the Internet Newsgroups (see Figure 2-9), and much
more. You can also find an index of mailing lists available for your perusal and
subscription pleasure. Of course, you always have America Online’s e-mail
feature, which lets you send mail anywhere on the Internet.

An “average” day in the Internet Connection may include browsing through the
newsgroups you read, checking out the Mother of All Gophers at the University
of Minnesota, and just about anything in between.

There’s far too much to say about Internet to do so here, so cruise on to
Chapter 17 and get ready for the ride of your life.

Petitioner Microsoft Corporation - Ex. 1006, p. 27



28

Figure 2-9:
Welcome to
the Internet.
Drive safely!
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The Joys of (Nearly) Free Stuff

It seems like everywhere you turn in America Online, you find a software
library. You don’t have to be anywhere special; just about every service area
has something to offer.

Exactly what’s available depends entirely on where you are. In the Omni
magazine area (keyword Omni), you can browse through the Antimatter Files
and find UFO pictures, NASA photographs, and text files of selected Omni
articles. The Cooking Club (keyword Cooking) serves up recipes and a variety
of cookbook programs (both shareware and commercial demonstrations). The
Dolby Forum (keyword Dolby) offers white papers exploring the latest in audio
and video technical information for the demanding listener.

Thanks to America Online’s Internet links, you also have access to the infinite
software libraries available through File Transfer Protocol, lovingly known in
Net lingo as FTP. Troll the likes of Winsite (ftp.winsite.com— widely
acknowledged as the world’s largest Windows software library), Sumex
(sumex-aim. stanford.edu — the home of more Macintosh software than
anyone could possibly need), and the Walnut Creek Archive (ftp.cdrom.com—
a great spot to find all kinds of programs) with ease. Filling your hard drive has
never been so much fun!

Whether it's fonts and clip art, games and playing tips, or something a little
more businesslike, you can find the details of getting it, unpacking it (watch out
for the foam peanuts!), and making it work for you in Chapter 8. For FTP info,
check out Chapter 17.
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Let the Fun and Games Begin!

Because all work and no play makes me really grumpy (and probably does the
same thing to you), take a break from the Internet and indulge in some fun. The
online world offers games to suit every age, style, and taste.

If you're a shoot-"em-up kinda person, work through your aggression (and
sharpen your aim) in Air Warrior (keyword Air Warrior), the first of a new
breed of interactive online games. For enthusiasts of more sedate games,
America Online offers a dedicated crossword area (keyword Xwords), chess
(keyword Strategy), and interactive Trivial Pursuit (keyword Trivial Pursuit).

Feeling lucky? Take a spin at an online game of chance in RabbitJack’s Casino
(keyword Casino). Want to build a business empire? Put your entrepreneurial
skills to the test in Federation (keyword Federation), a multiplayer game of
intergalactic business — and a personal favorite of mine.

For pure social enjoyment, drop by LaPub, the best (and perhaps only) elec-
tronic bar and meeting place, and try out the hot tub and the Jell-O jump. Find
this site at keyword LaPub.

All this fun stuff and more is waiting in the Games channel. For more fun, flip
ahead to Chapter 13.

Shopping without the Crowds

Imagine shopping the malls on the day after Thanksgiving. After you regain
consciousness, get a drink of water and then come back and keep reading.

Now imagine the same shopping trip with no crowds, no pushy children, and no
whining adults. It’s a dream, right? No, it’s the America Online Marketplace
(keyword Marketplace), your 24-hour shop-'til-your-fingers-drop

electronic mall.

Take a stroll through the Classifieds (keyword Classifieds), America Online’s
own version of a digital flea market. Or pick up some high-tech goodies at the
Sharper Image (keyword Sharper Image). Have something a little bigger in
mind? Try the Shoppers Advantage club ( keyword ShoppersAdvantage), with
the best in just about everything you could want — and great prices as well.

If your credit card is already out, take a break and power shop through
Chapter 21 for all the details.
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Having a Little Chat

The People Connection (keyword People) is the home of America Online’s chat
areas. Here, you can interactively talk live with other America Online subscrib-
ers. All this chat happens in what the technology jockeys call real-time, which is
a fancy way to say that right after you type a message, the other people in that
chat area see the message on their screens, wherever in the country they are.

The chat areas usually hold a maximum of 23 people. America Online does have
some larger rooms, but you find out about them in Chapters 6 and 7. Online
chatting takes some getting used to, as you can tell by looking at the sample chat
session in Figure 2-10. The trick is to fcllow only one (maybe two) conversations
at a time. For example, Big T Rex asks a question near the top of Figure 2-10.
Although Jonalyn answers Big T Rex immediately, Big T Rex’s reply to Jonalyn is
a couple lines down from there. Trust me — it gets easier the more you do it.

I have a confession to make, though. At first, I thought the chat areas were, well,
kind of silly. You know — what kind of hopeless computer nerd would spend
time typing at people? Then 1 tried it. Oops — big mistake.

Don’t do the People Connection unless you want to meet interesting new
people, have a marvelously fun time doing it, and are braced for the meteoric
rise in your monthly America Online bill. Don’t say I didn’t warn you. If you're
feeling brave, go on to Chapter 25.

Breetai1ll: There. No problem. . whispers to mapkoc::
Mapkoc: Are you ok
Big T Rex: VHO IS SERVING?
Jonalyn: Tis self serve Rex
Pastorale: :::waving a hand. conjures a lemonade: ::
Big T Rex: thank you
Scott L J: ::sighs. depressed::
Seeker?079: : :shaking head like a puppy.sending water flying::
Evyl ELf: ::finishes off the bottle of Evlen White::
¥YngGlaswlk: So how are you today Jim?
Breetail3l: 1. looks at dgtl::
Mapkoc: Ok
Breetaill: Hey dgtl!
Big T Rex: ::Stomps towards bar and pour hiself a whiskey::
Drakari?2: ::walks over to OnyxRose::
Breetail3: ;. walks to morgan::
Jonalyn: . :props her legs more comfortably upon the bar::
MorganFaye: Oh, so novw I'm a charity case, Bree?
M | Sceker7079: c:removing cloak and giving it a good shake:: blasted rain
. Scott L J: Hey Chaos. ..
Flgure 2-10: | Breetail3: You don't look good.
Breetail3d: No. I didn't say that.
Asamp‘e Drakari?: Hello M'lady
conversation | Dgtl Chaos: :::looks around::::
Big T Rex: ::Thuds towards fireplace::
from the Red Seeker7079: :-makes way to the bar in hopes of a warm drink::
Dragon Inn Evyl Elf: c:shrugs:: I'll do vhat it takes. ..
' | Pastorale: ::lifting her glass to her lips:::
an online OnyxRose : :::Looks at Drakari?2::: Hello
chat area Jonalyn: ::drinks deeply. glancing at the usual chaos:::
* | Dgtl Chaos :::she's not here:::
semnsmmmes | Mopkoc: Hows it going btr?
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But Wait — There’s More!

This chapter doesn’t even begin to tell you what’s available out there in the wilds
of America Online. Come to think of it, that’s what the rest of the bock does.

+* To find out more about a specific channel, look up the area in Part IIl.
1+ To follow the biddings of your own interests, look in Part IV.

v+~ If you feel the need to follow other interests, the bathroom is down
the hall.

When It’s Time to Say Goodbye

All good things must come to an end, and so it is with America Online. Signing
off the system is quick and painless, though. Here’s how to say goodbye to
America Online:

1. When you’re ready to call it a day (or night, or whatever), choose
Go To=>Sign Off from the menu bar.

The dialog box in Figure 2-11 (or one a lot like it) appears.

If a dialog box appears and worries that you still have something to send
or receive, don’t be concerned. That’s America Online’s way of saying you
have unread mail in your mailbox or perhaps mail that you typed offline
and forgot to send. If you're not using FlashSessions, clicking OK and
blowing off the message is perfectly all right. lif you are using
FlashSessions, you may want to check your outgoing mail (choose
Mail=>Read Qutgoing Mail from the main menu) and make sure that
everything you wanted to send actually left. For all the details about this
mysterious FlashSession thing, check out Chapter 7.

: héck’;olit these great
features before you sign off...

EE— ‘Rejax.,urfiwindﬁ..,.; B
) NTN Countdown Trivia,
Figure 2-11: Ariew game isjust aboutto'begini
America i
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’ ] Confused about the lnternet" :
doesn’t Who isn1?
want to say The lnternet Answerman can help!
goodbye, ,
either. CHANNELS m EXIT
L]
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2. To sign off the system and leave the America Online software running,
click Sign Off in Windows or Yes on the Macintosh. If you change your
mind, dick Channels in Windows or No on the Macintosh to stay signed on.

At this point, you can reply to your Flashmail, write a quick offline message,
or sign onto the system with a different screen name. Figure 2-12 shows
America Online waving goodbye and offering a farewell advertisement
about an upcoming event in the AOL Live! area (keyword AOL Live). For
more about all the cool stuff happening in AOL Live!, see Chapter 25.

3. To shut down the America Online software, choose File->Quit on the
Macintosh or File=>Exit in Windows. You're done!

Goodbye from America 0nI|ne'

‘Coming Up...

§ Track & field olympian-Carl
"TTe  Lewis; Suni 613, 8:30pmET in
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Chapter 3
Making Yoursel at Home
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In This Chapter

J The whole screen name thing

p- Managing screen names

p Filling out your profile

g Setting your preferences

p Applying some parental controls
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A new America Online account is like a college dorm room on the first day
of the school year: completely bare, devoid of anything beyond the
marvelously institutional look of gray linoleum tile surrounded by lime green
concrete block walls. But when its inhabitants move in, that room becomes
unique; it becomes more like home.

Making yourself at home in America Online means setting things up just the
way you want them. That's what this chapter is all about. The chapter covers
topics such as screen names, the Member Profile, and setting your personal

preferences. It also explores the parental controls, the online version of a good,
old-fashioned grounding,

If you're completely new to America Online, start with the next section and
continue through the chapter from there. If you're looking for details about
specific preference settings, screen names, the online profile, or parental
controls, flip ahead to the detail sections later in the chapter. If you're hungry,
go get something to eat (and order me a vanilla malt, would you?).

What's in a (Screen) Name?

When you join some online services, you mechanically receive a clever, memo-
rable name from a computer that’s quite proud of itself for calling you
71303,3713. After all, the computer has no problem remembering it — why
should you?
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America Online, though, was started by humans and designed for humans. As a
direct result, you (a human) get to choose the name you use on America Online.
You can be yourself if you want to: Anne, Paul, or Susan. Of course, you could
also be a little more daring and become BlasterMan, Supermom, or LoveBug. The
choice is almost entirely up to you (but more about that later).

Every America Online account has space for five different screen names: one
primary name, plus four others. The primary name is the one you choose when
you sign on to the service for the very first time. This name is special —it’s
kind of like your permanent file in school. (The mysterious record always
spoken of in dark, terrifying phrases such as, “This will have to go in your
permanent file.) The primary name is permanent — you can’t ever change it.
The other four names, though, can come and go as you please.

Technically speaking, America Online doesn’t place too many limits on screen
names. Screen names need to be between three and ten characters long and
must start with a letter. After the required first letter, you can use letters,
numbers, and spaces to create your online identity.

+»* You can have five screen names in your account — one that’s primary and
four others.

1+ The primary name is permanent, and you can’t ever change it; the other
screen names can come and go as you wish.

1+ Choose your primary name carefully; it’s going to be with you forever.

1 Screen names are three to ten characters long, start with a letter, and
contain any combination of letters, numbers, and spaces your imagination
can dream up.
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Dealing with Screen Names

Managing the screen names in your account isn’t just a job — it’s a creative
adventure. The following sections go through everything you need to know to
MBER keep your screen names in order.

K\

These instructions don’t apply to your account’s primary name. You can never
change that. So there.

Creating a new screen nane

[ think the people who started America Online must have read Shakespeare. In
the play Romeo and Juliet, Romeo can’t decide on a screen name. Juliet tries to
calm him with the observation, “What’s in a name? That which we call a rose by
any other name would smell as sweet.” His confidence thus buoyed, he tries
making a new screen name for himself in his father's account.

Kids — don’t try this at home. Romeo and Juliet did, and look what happened
to them. (If you don’t know what happened to Romeo and Juliet, you can find
out on the Internet. Just page ahead to the section, “Famous Books (Gopher),”
in Chapter 39, to read the classics with Project Gutenberg.)

Making a new screen name isn’t hard at all. Just follow these steps:

1. Sign on to America Online under your account’s primary name.
Only the primary name can create new screen names.

2. After safely connecting to the service, choose Members~Edit Screen
Names from the menu bar (or use keyword Names).

The Create or Delete Screen Names dialog box opens, displayed for your
viewing pleasure in Figure 3-1. If you haven’t read the screen names
sidebar yet, this is an excellent time to do so.

Create or Delete Screen Names

Screen Names
2 ool
Figure 3-1: [} About Screen Names
The C [ Screen Name Policy (IMPORTANTN
e Lreate [ How To Create/Delete a Screen Name
or Delete O Create g Soreen Marms
Screen & Delete a Screen Name R
Names B3 parental Chat Controls
dialog box. Keyword: Names
|
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R
Figure 3-2:
One screen
name,
{hopefully)
coming

right up!

L]
Figure 3-3:
Drat—you
have to
choose
something
else.
R

3. Double-click the Create a Screen Name option in the dialog box.
The Create a Screen Name dialog box appears on-screen.

4. Type your new screen name in the text box and then click Create a
Screen Name.

Figure 3-2 shows our hero ready to establish himself online.

If the screen name you typed is available, America Online creates it and
tells you. Otherwise, the system suggests that you choose something else,
as shown in Figure 3-3.

Create a Screen Name

Each account may have up to five screen names at one time. A screen name may be from
3to 10 characters (letters, numbers, andfor spaces). The first character in the screen
name must be a letter, and will be capitalized automatically. The rest ofthe characters will
appear just as you enter them.

E.g. "Steve C","S Case", "Ski Racer","JohnDoe123"

Please type the screen name you want to use:

Create a Screen Name

America Online

The name you requested is already in use.
Please try another name.

5. If America Online tells you that your desired screen name is not avail-
able, click OK to make the information dialog box leave you alone, and
then go back to step 3 and try again.
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The big computers at America Online sometimes feel creative and attempt
to help you make a valid screen name. The outcome is a lot like having
your three-year-old help you make a cake from scratch. Figure 3-4 shows
the computer’s suggestion for poor Romeo. At this point, [ think Juliet’s
earnest advice is by far the wisest: “O, be some other name!”

After you and America Online agree on a screen name (which may take
several tries), the Set Password dialog box appears, as in Figure 3-5, asking
you to set a password for the new screen name.

Create an Alternate Screen Name )

Each account may have up to five screen names atone time. A screen name may be from 3t0 10

characters {ietters, numbers, andfor spaces). The first character in the screen name mustbe a

letter, and will be capitalized automatically. The rest of the characters will appear just as you enter

them.

|

E.g. "Steve C","S Case","Ski Racer', "JohnDoe123"
Figure 3-4;

Don't let the The screen name you have chosen is already in use. You may have the following alternate name,

or you may enter another name of your chaice:

computer

“help” you
make
names. :
]

i Fiease enter the password you would like twice. Remember, it must contain at
Flgure 3-5: least 4 alphanumerics.

Type the
same
password in
both boxes.
|

6. Type the password twice and then click Set Password.

You type the password first in the box on the left and then again in the box
on the right.

Whatever you type for your password doesn’t actually appear in the boxes.
(Yes, it’s supposed to happen that way.) Instead, the boxes display a little
star for each letter. It’s a security thing. Because it doesn’t show you what
you're typing, America Online makes you enter the password twice. If the
two entries don’t agree, America Online warns you, and then it lets you try
again. By the way, America Online passwords must be between four and
eight characters long.
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See the upcoming sidebar for some important thoughts and warnings
about passwords.

7. To use the new screen name, sign off America Online by choosing
Go To<Sign Off and clicking Yes in the dialog box that appears.

The sign-on screen clears and the Goodbye dialog box bids you a
fond farewell.

8. Click the down arrow next to the Screen Name list box and choose your
new screen name from the list.

9. Press Tab to move to the Password box and type the new password
you created.

10. Click Sign On.

Poof — it’s the new you!

Deleting an old screen name

Even screen names reach the end of their usefulness. And when that time
comes for the screen names in your account, delete them and go on about your
business. Just follow these steps to delete a screen name:

1. Sign on to America Online with your primary name.

2. After you've connected, choose Members->Edit Screen Names from the
menu bar (or use keyword Names).

The Create or Delete Screen Names dialog box appears. (It’s the same one
shown back in Figure 3-1.)

3. Double-click the Delete a Screen Name option in the dialog box.

QP The Delete a Screen Name dialog box pops up.
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Alas, poor
Rome097411
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knew him.
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|

Figure 3-7:
He's history.
|
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4. Type the screen name you want to delete, and then click Delete a Screen
Name (see Figure 3-6).

Be darn sure that you want to delete this screen name before clicking that
button. After you delete it, a screen name is gone for ever and ever (or at
least for the next six months). Nobody can revive it; not you, not anyone
else. It's gone, kaput, done, finished, no deposit, no return, no salesman
will call, some restrictions apply, not valid with other offers, buyer is
responsible for tax, title, and freight, dealer retains incentives. (Whoops —
I got a little carried away.)

5. After you've done the dirty deed, America Online issues the brief,
generic obituary shown in Figure 3-7.

You can’t delete the primary name.

Delete a Screen Name

The first screen name you created when you registered cannot be deleted. Any other
screen name may be deteted. Deleted screen names cannot be reactivated.

Please type the screen name you want to delete:

romeo37411

America Online

""Romeo097411" has been deleted from your
account.

Changing a screen name

What if you have a screen name and decide you want to change it a little bit?
Well, you're out of luck. To paraphrase the wisdom of Yoda, the Jedi Master
from Star Wars, no change is there, only delete.

Your only option is to delete the existing screen name entirely and create a new

one from scratch. Sorry to break the news to you like this, but that’s life in the
big online services, | guess.
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Turn a Bit and Let Me See Vour Profile

When you meet people on the street or in the office, the first thing you notice
about them is their physical appearance. Beyond that, they're a mystery until
you meet, talk, and invest some time getting to know them.

In the world of America Online, you determine “how you look” when you
choose a screen name. In the chat areas you get to meet people and talk. But
America Online has something else, too — something really neat that I person-
ally wish existed in real life: the Member Profile.

A Member Profile is a collection of tidbits and trivia about the owner of a
particular screen name. For example, my Member Profile appears in Figure 3-8.
Despite what you may think, I'm an average, all-American game player, com-
puter jockey, musician, husband, and father of two. And [ write books ( but you
already knew that). If 'm chatting with someone online and the other person
wants to know a little more about me, all he has to do is choose Membersc=>Get
a Member’s Profile from the menu bar (or press Ctrl+G in Windows or 8+G on a
Mac), type my screen name into the Get a Member’s Profile dialog box, and
click OK. Presto! My Member Profile appears on-screen.

Member Profile

Screen Name: JKaufeld
Member Name: John Kaufeld
Location: Indianapolis, IN - Computer book publishing capitol of the warld!
Birthdate: 12/4/61
Sex: Male
Marital Status: Married
—— Computers: Compaq, Macintosh, and HP Omnibook
. Hobbies: Piana, my kids, reading, and games
Figure 3-8: || | Occupation: Wrote <i>America Online for Dummies</i>
Now you Quote: if it's not fun, why do it? (Jerry Greenfield)
know
everything
about me.
——

So where does all this information come from? From you — that’s where. It’s up
to you to create a Member Profile for your screen name. If you don’t create one,
other members can’t find out about your likes, interests, and hobbies. In short,
you'll barely exist on Planet AOL.

% 1 Please, oh please, fill out your Member Profile. Leaving it blank is like

moving into a new neighborhood because you heard it had lots of fun
¢ people and then acting like a hermit.
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+* There’s another reason to fill out your Member Profile: so that people who
. share your hobbies and interests can find you. A special command for
searching all the Member Profiles is available. It’s revealed in Chapter 7.

|~ Although this falls under the heading of common sense, I want to drive

I  home a point. Do not put your phone number, address, or other truly
personal information in your profile. On a scale of good to bad, doing that
is reeecaaaaaally bad. Parents, check your kids’ profiles every now and
then just to make sure that they didn’t put anything (too) weird in there.

v If you use more than one screen name, you need to fill out a Member
: Profile for each one. Every screen name has its own Member Profile.

| 1~ Some parts of the service (such as Starfleet Online simulations, keyword
@ Starfleet) rely on information in your Member Profile as part of the game.
To find out more about these interactive online entertainments, refer to
Chapter 12.

To create (or update) your Member Profile, follow these steps:

1. Make sure that you've signed on to America Online with the
correct name.

Every screen name has its own Member Profile.

2. Choose Members->Member Directory from the menu bar, and then
double-click Create or Modify your Profile.

The Edit Your Online Profile dialog box appears. If you're creating a
Member Profile, the dialog box is blank. If you're changing the Member
Profile, your current information appears in the spaces (just like mine in
Figure 3-9).

Edit Your Online Profile

To edit your profile, modify the category you would like to change and select
*Update." To continue without making any changes to your profile, select " Cancel.”
Your Name: |John Kaufeld |
Cty, State, Country: Mianapolis‘ IN - Computer book publishing capitol of the world! ]
Birthday: 12/4/81
Sex: @ Male O Female O No Response
Marital Status: O Single @ Married O Divorced/Separated O No Response
——
. Hobbies: i i i
Flgure 3.9 obbies IPlano, my kids, reading, and games 1
Here's my Computers Used: IEﬂmpaq, Macintosh, and HP Orrnibaok |
Memb.er Occupation: tWrnte “America Online for Dummies” from 1DG Books| 1
Profile p  Quote: = :
“under con- ersonal (Juote: [If it's not fun, why do it? (Jerry Greenfield) ]
struction.” rUpiiinjli| éghﬁéifllgﬂelp']
|
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3. Fill out the Member Profile form. After you finish, click Update.

Don’t worry if you type past the end of the boxes for Hobbies, Occupation,
and Personal Quote. You have plenty of room to type — the text scrolls
through the box until you can’t enter any more text. At that point, the box
is full. Use your directional arrow, Backspace, and Delete keys to correct
any typing or editorial errors.

After you click the Update button, America Online replies with a little
dialog box that says, “Your profile is being updated.” It takes a little while
(usually ten minutes or so, but much longer if the system is busy) before
your newly entered (or updated) Member Profile is available for the world.

Making Your Preferences Known

You know, America Online is starting to look kind of cozy now. Fine-tuning a few
personal preferences should finish the job.

The preferences are your chance to tweak the America Online software so that it
behaves exactly the way you want. (No, you can’t have preference settings
installed in your kids — 1 tried, but it didn’t work.) These options cover every
aspect of the software from sign-on to sign-off, plus a whole lot of stuff in
between. The following sections explain all of the preference settings and how
to change them.

Although America Online remembers your settings from session to session, you
can change them any time you want. For instance, if I'm working late and want
to keep the noise level down, | hop into the Preferences window (explained in
the next section), click General, and then turn off the Enable Event Sounds
option. Later, when I'm ready for some noise, | turn it back on (and crank up the
speakers, too). For more about the General preferences, keep on reading.

Finding the Preferences

You can work on your preferences in two ways. If you're somewhat new to the
| preferences and want a lot of hand-holding while making your changes, use the
My AOL dialog box in Figure 3-10. To get there, either click the My AOL button
on the Toolbar or choose Members>My AOL from the main menu. If you're
really new, check out the sidebar called Hitting the highlights in one easy step
for a cool tip about setting the important stuff all at once.

When you feel more comfortable with the preferences, use the Preferences
window (seen in Figure 3-11) to make quick adjustments. To open the window,
choose Memberst>Preferences from the main menu.
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s [||_SET UPAOLNOW | ¢

Figure 3-10:

MyAOL &
packsalot |
of settings |

into ane f;

location. |

=, §

: ‘m Preferences aliow you 1o
| customize America Online to
| S | b= best serve your needs.
General Chat :
— ~———— Ciickon one ofthe Icons to
L [edd the ieft or beiow to sefect a
| =2 category.
| m s e o 3
Passwords Graphios +
Figure 3-11; r e | e
The ® €
Prgferences e STy
dialog box. Cabinet
=3 dnces ez === ]

Chat

The interesting settings in the Chat Preferences dialog box are the notification
options and the capability to alphabetize the chat group member list. (See
Figure 3-12.)

The notify options tell America Online to let you know you when new people
join the chat area or when current attendees leave. 1 haven’t decided whether 1
like these features or not. Try turning on one or both notifications and deter-
mine how the results strike you. You can turn on these settings by clicking in
the appropriate check boxes.

The Alphabetize the member list option is genuinely handy. If you turn off this
setting, the chat area member list is an absolute morass of mixed-up names.
Run, don’t walk, to turn on this setting.
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Hlttmg the hlghhghts in one easy step

When you’ re new to Amerlca Online, workmg

with the options is a bit overwhelming. You have -
~so many things to choose from — where should

you begm'? What should you change ﬁrst" -

In an effort to reduce your stress and make the

preference setting process ever so slightly sim-
pler, America Online collected the most-used -

this dla!og box leads you through the most popu-
lar settings to change, including your Member
Profile, screen names, passwords, and the Gen-
eral and Mail preferences. It also heipsyou build

'Buddy Lists {more about that in Chapter 7) and :

set the Parental Controls

To open the Set Up ABL Now window, click the

settings into the cool Setup AOL Now dialog box. -

‘ “aptly named Set Up AOL Now button in the My
With a clear menu and descriptive instructions,

-ABLwindow. It's the first buttonon the leftside of
i gure 3- 10

Chat Preferences
D?Notify me when members arrive:
nessmes | [ Notify me when members leave
Figure 3-12: | [J Double-space incoming messages
Customizing | 11 apnabetize the member list
the online -
chat Enable chat room sounds
experience.
L ]
Graphics
The new America Online 3.0 software offers a very important option in the
Graphics preference setting (shown in Figure 3-13).
Graphics Viewing Preferences
While you are online AOL will save online artto your PC's hard drive, this
saves time when you enter the area again as you already have the
necessary online art. You can control how much ant is stored on your PC
by changing the number below. f you increase the disk space AOL will
run faster but take mare space on your hard drive.
——
i -13: Maximum disk space to use for anline art: g megabyte(s)
Fl‘gure 313 u
Finally —a
way to get Display image files on download
theart | ypEG compression quality: m;‘——:
under
control.
I
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Do you remember the “Downloading art . . . please wait” dialog box? (Now don’t
scream — 1 only asked if you remembered it.) All that downloaded art is
hanging out on your hard drive, taking up valuable space. Up to now, you
couldn’t do much about it, because once the art arrived, it was there to stay.
Thanks to the new option in the Graphics preferences, those days are over.

The new (and lengthily named, I might add) preference setting called Maximum
disk space to use for online art gives you the ability to limit the size of your art
database. The default is 20MB, which is fine when you have plenty of hard drive
space available. If your disk drive feels smaller every day, try nudging the
maximum size down to 10 or 15MB.

So what happens when the art database grows bigger than the maximum size
you set? An electronic version of the old-fashioned Spring Cleaning, that’s what.
The America Online software throws out art that you haven’t used for a while to
make room for the new stuff. It happens automatically, behind the scenes —
you won't even know about it.

For an idea of how big your art database currently is, use File Manager (Win-
dows 3.x) or Explorer (Windows 95) to check the size of a file called MAIN. IDX
in the IDB subdirectory of the America Online software.

General

The first stop on the preferences tour is the General area, shown in Figure 3-14.
Although this area is nothing to jump up and down about, some settings in here
are worth mentioning.

General Preferences

[J'Display Main Menu at Sign On:

X Notify me immediately of Network News

[ nisplay Favorite Places Window on Start-Up
Where passible, display text () gmalt

@® Medium

O Large
3 Save text with line breaks
ssmenememm | X Enable event seunds

Figure 3-14: Enable chat room sounds
The General
Preferences
dialog box.
EE——

[ Automatically scroll documents as they are received
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The first useful option is right there at the top, Display Main Menu at Sign On.
If you're distressed that the Channels window pops up automatically every time
you sign on, here’s the remedy: Turn off this setting. I did — and 'm much

less distressed.

The next useful option is the text display size setting. On my computer, |
changed this setting to Small, because the default text size came out pretty
large on my screen. Conversely, if you're having trouble reading articles or chat
area text, try setting it to Large. To change the setting, click the radio button
next to the text size you want.

My other favorite settings govern event sounds. lf you have a sound card in
your computer, I suggest turning on both the Enable event sounds and Enable
chat room sounds settings. Click the check box next to each setting to do so.
Why do it? Well, it’s more fun that way — what better reason do you need?

Passwords

Clicking the Passwords button opens a dialog box for storing your screen name
passwords. If you store the password here, you won't have to type it every time
you sign on to America Online. (See Figure 3-15.)

. Edit Stored Passwords -

Screen Name  Password

Ready-made
cubbyholes
for your
passwords.
|

As far as I'm concerned, the jury is still out on this feature. This feature is nice
if you're making a screen name for someone who doesn’t really care about

passwords anyway and would probably write the password on a note taped to
the monitor. The flip side, though, is that after you store the password, anyone

with access to that computer can sign on to America Online with that screen
name. Anyone.

I don’t recommend using this feature because it’s a big-time security risk. But |
can also think of many cases where the feature is either handy or helpful. With
that in mind, here’s how to store a password:
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1. From the Preferences dialog box, click Passwords.
2. Click the Password box for the particular screen name you want.
3. Type the password.

As before, the stars appear in place of the actual password. If you mistype
something, backspace over the whole entry and start again.

4. Repeat the process for any other passwords you want to store. Click OK
after you're done.

If you change a password in the future, you must return here and change it
as well.

Download

These settings govern some trivial details about the download process. |
recommend turning off the Delete ZIP and ARC files after decompression option
but leaving everything else turned on. An option is turned on if an X appears in
the little checkbox. Click in the checkbox to toggle the setting on and off (or if
you just like watching the little X appear and disappear).

Mail

E-mail is one of the most useful features of America Online. Keeping track of
your e-mail, though, is one of the most hair-reducing features. Thankfully, help
is waiting in the Mail Preferences dialog box, shown in Figure 3-16.

Mail Preferences

JiConfirm mail after it has been sent

] Close mail after it has been sent
L]

Figure 3-16: [J Retain all mail | send in my Persanal Filing Cabinet

Here's how! | [J Retain all mail I read in my Personal Filing Cabinet

like to Se,t Use AOL style quoting in mail
the Mail
Preferences.
\\J The option that you simply must turn on is Retain all mail [ send in my Personal

Filing Cabinet. This one is a real winner, particularly if you're using America
Online with your business. Turn this puppy on, and the access software
automatically puts a copy of all outgoing e-mails into the Mail You’ve Sent
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folder (which itself is in the Mail, Archives folders). Imagine: No more worrying
about whether you replied to someone’s message or wondering what you said.
Life just doesn’t get much better than that, now does it?

The mate to this setting, Retain all mail I read in my Personal Filing Cabinet, isn’t
quite as great as its counterpart but still deserves consideration. Like its sister,
this option is great for when you need to account for all your correspondences.

One word of caution though: All this filing uses space on your computer’s hard

disk, so regularly go through the messages and delete the useless ones. For
more about the Personal Filing Cabinet, see Chapter 6.

WWW (World Wide Web )

Although most of the stuff in here borders on techno-weenie, there’s one thing
that I want to mention: the Clear Cache button.

Although not really a preference setting, Clear Cache is a button you should hit
every now and then if you enjoy surfing the Web. Every time you view a Web
page, the America Online Web browser keeps a local copy of what you see in a
cache. This isn’t a nefarious plot to use up your hard disk space — all the
popular Web browsers do it.

On the plus side, the cache makes your Web browser respond faster when
you're bouncing back and forth between a couple of Web pages. The down side,
though, is that the cache fills up after a while. Unfortunately, a full cache slows
down your Web browser a bit (which is the kind of help that the World Wide
Wait doesn’t exactly need).

Luckily, emptying the cache is easy. In the WWW Preferences dialog box, click
the Advanced button. In the new, much smaller preferences dialog box that
mystically appears, click Purge Cache (see Figure 3-17). When the America
Online software asks if you're sure, click Yes. After it’s done (emptying the
cache only takes a moment), click Cancel twice to get back to the Preferences
dialog box.

Okay — there is one thing in here that you might, just might use someday. 'm
talking about the Home Page option at the bottom of the WWW Preferences
dialog box. This setting tells America Online which World Wide Web page you
want to see when you start the Web browser. Put the address for your favorite
page here — you can even use a page that you wrote yourself! On the other
hand, if this talk of Webs and browsers makes little or no sense, flip ahead to
Chapter 17 and prepare to watch your America Online bill get bigger as you
explore the wonders of the Web.
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empty.

Figure 3-18:
These
settings
make sure
that the
Personal
Filing
Cabinet
won't fill
your hard
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Personal Filing Cabinet

The Personal Filing Cabinet, that collector of Flashmail, Favorite Places, and all
kinds of other stuff, is a really useful tool. The options in the Personal Filing
Cabinet Preferences dialog box (see Figure 3-18) make it even better.

%Block ALL But Kids Only

This parental control will allow you to BLOCK YOUR CHILD'S ACCESS TO ALL
OF AOL EXCEPT THE KIDS ONLY CHANNEL.

Screen Name Block

* EKaufeld —I J
lJenKaufeld j
|Kaufeldkid ]
——

00RO

*Master screen name

The two warning preferences instruct the America Online software to let you
know when space is dwindling in the Personal Filing Cabinet and when the
Cabinet is trying to single-handedly take over your hard drive. There’s no need
to change these options — the default settings should be fine.
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For safety’s sake, | recommend leaving both of the Confirm check boxes turned
on. However, if you get highly annoyed with all the Are you sure? messages
while cleaning out the Personal Filing Cabinet, feel free to turn them off here.

Multimedia Preferences

America Online is a massive graphical experience. That’s one of the things that
makes it fun, but it’s also very frustrating if you have an older modem with a
speed less than 9,600 bits per second.

You can address your frustration in two ways. First, consider buying a faster
modem. Your old modem isn't getting any faster, but as time goes on, your
online experience will get a lot slower. These days, you need at least a 14,400 bit
per second modem to get the most out of America Online. If you're buying a
new modem, [ recommend making the jump all the way to 28,800 bits per
second. The cost difference is negligible, but the speed difference is startling.

If a new modem isn’t in your budget this year, you're not out of luck. instead of
speeding up your access, change the Multimedia Preferences so that your
modem doesn’t need to work so hard. The Multimedia Preferences aren't in the
Preferences dialog box (that would be too obvious). Instead, they’re tucked
away in the Preferences section of the My AOL window. To get there, click the
My AOL button on the Toolbar or choose Members>My AOL from the main
menu. When the My AOL window appears, click Preferences. In the Preferences
window, click Multimedia Preferences. (Feel free to rest a moment and recover
from the grueling journey before continuing.)

By default, graphics are always turned on. If you have a slow modem or a
perpetually bad connection to America Online, click the radio button next to
Show document graphics at 9600 baud & higher. With this option turned on, you
won’t see the graphics when your connection is slow, but you will see them
when you upgrade to a faster modem.

Please, for your continued personal safety and mental health, spend the money
to upgrade your old, wheezing modem. The online world of the "30s requires a
fast modem — it’s just a fact of life.

Marketing Preferences
F'm not particularly big on junk mail. Frankly, I don'’t like it. My feelings are born

from a combination of personal privacy issues, environmentalism, and the
simple fact that [ have a small mailbox.

If you feel the same way, here’s your chance to strike back. By the same token,
if you like junk mail, here’s an opportunity to get exactly the kind you want.
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The Marketing Preferences aren’t part of the regular Preferences dialog box. To
find them, either use keyword Marketing Prefs or click My AOL on the Toolbar,
click Preferences in the My AOL window, and finally click Marketing Prefer-
ences in the Preferences dialog box. When you arrive, double-lick the entry
called Tell Us What Your Mailing Preferences Are.

Doing so opens a dialog box that lets you specify what kind of junk mail you
want. (Of course, | was most interested in the “If you'd prefer not to receive any
mailings” option.) Follow the on-screen instructions to fill out the form. Click
Send when you're done.

If you're a direct mail hermit like me, you’ll be interested in two documents in
the Marketing Preferences dialog box. These documents contain information
about the Direct Marketing Association’s Telephone and Mail services. Briefly,
the documents explain how to obliterate all traces of your earthly existence (at
least as far as the direct mail merchants are concerned). I highly recommend
reading these documents and doing what they say.

Parental Controls: Taking Away
the Online Car Keys

Like any major city or tourist destination, there’s a lot to see and do on America
Online. Unfortunately, the similarities don’t end there. Every big city has a don’t
go there side and a small population of less-than-moral people. If I said that
America Online was immune to this, I'd be a fool (and no editorial comments
from the people in the audience who know me personally).

Whether you like it or not, people and things that we need to shield our kids
from are out there in the online world. That’s what the Parental Controls
(keyword Parental Controls) are all about. They allow you to exercise some
control over what your kids can and can’t do on America Online,

‘\QTE i 1+~ Different people have different views about what kids should and
shouldn’t see. Please understand that I'm not trying to get on a moral high
horse and tell you what’s right and wrong for your kids. I'm not passing
judgments about what's availabie out there, but merely explaining the
tools available and giving some very general advice for parents whose kids
know the Internet better than they do.

= 1 To make the Parental Controls work, only you, the parent, should know
the password to the master screen name (that’s the screen name you
created when you first signed up for America Online). Create another
screen name specifically for your child to use. Remember that each
America Online account can have up to five screen names — one master
name plus four others.
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& 1 Are you curious why I'm making such a big cloak-and-dagger deal out of

2  who's using which screen name? Here's the reason: The master screen

% name is special. Only the master screen name can set the Parental Con-

% trols and create new screen names in your account. If your child uses the

%  master screen name for her online access, then she can simply turn off

% whatever parental controls you turn on. Whoops! Instead, create a screen
% name especially for her, place the controls on it, and then keep the master
% screen name for yourself.

Figure 3-19 shows the main Parental Controls screen. Apart from the parental
controls themselves, the window also contains some general tips and a discus-
sion board for swapping ideas with other parents about the trials and travails of
having online kids.

Parental Controls

& Parental Controls

*
Welcome to America Online's Parental |2}
Controls.

Since children of all ages use Amernica
Online, we have created four
easy-to-use features to help patents
make sure their children have a fun and
educational expetience online. These

L
. Parental Controls features can be
Figure 3-19: changed at any time, allowing vour
Clamp down Block All But Kids Only §
a bit with s

the Parental ! Message online Terms of M
Letter Board Safety Tips Senvi
Controls. oards afety Tips ice

Keyword: Parental Controls

The two large buttons in the lower right side of the screen are your parental
control options. Block All But Kids Only limits your online child to the Kids Only
area (keyword Kids Only). Custom Controls offers controls for interactive chat,
file downloading, and Internet Newsgroups. Each of these is explained later in
the chapter.

How do you choose the right controls for your kid? Well, it depends. Consider
the age and maturity of your child. Granted, our kids are all above average in
intelligence and everything else, but for this one moment try to be especially
objective. How responsible is your child? And how naive? How trustworthy?
Yes, they’re tough questions, but this decision is a very important one.
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% v For children 12 or younger, | recommend using the Block All But Kids Only
option. Kids Only is specifically designed for that age group, so you can
feel pretty comfortable that your little one won't run across anything
incredibly weird.

4 v The teen years are more challenging. (Stating the obvious is one of my
strengths.) If you use any controls at all, select some specific Custom options.
I would recommend blocking Member Rooms in the Chat control, FTP in
the Download control, and any Internet Newsgroup containing the magic
word sex in the Newsgroup control. That combination maximizes the widely
acceptable stuff while blocking off the Internet’s most colorful content.

4 v~ lf you feel comfortable giving your kids free run of the world, that’s cool.
i Nothing says you must use the controls — they’re just available tools.

You can change the settings at any time, so don’t worry about ruining your
child forever by making the wrong choice. Pick the settings, talk to your child,
and see how everything works. If you need to make adjustments, do so. Most of
all, work with your child and let him know that you're interested in his online
world. That makes a bigger impact than any control ever can.

Block All But Kids Only

This option keeps your child exclusively in Kids Only, America Online’s special
world for the 12 and under set. They have free run inside Kids Only, but can’t
venture outside of it. The Channels window, Favorite Places, and any keyword
that points beyond Kids Only are off-limits.

In addition, this option also blocks all Instant Messages and People Connection
chat rooms (except for the special Kids Only chat rooms). On the Internet side

of things, they're free to use sites listed within Kids Only, but can't see anything
else. They also can’t manually enter a Web site address.

To turn on the Block All But Kids Only parental control, follow these steps:
1. Sign on with the master screen name and then choose Members-
Parental Control from the main menu.
The Parental Controls window appears.
2. Click the Block All But Kids Only button.
An informative window describing this setting pops onto the screen.

If your child doesn’t have a screen name yet, click Create a Screen Name at
the bottom of this window and make an online name for her. Your child
must have a personal screen name before you can set up the Parental
Controls. For all the details about creating a screen name, flip back to the
beginning of this chapter.
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3. Click the Block All But Kids Only button at the bottom of the window.
The Parental Control — Kids Only window in Figure 3-20 appears.

Parental Control - Kids Only .

%B!ock ALL But Kids Only

This parental control will allow you to BLOCK YOUR CHILD'S ACCESS TO ALL
OF AOL EXCEPT THE KIDS ONLY CHANNEL.

Screen Name Block

* |JKaufeld ] 0

lJenKaufeld T O

T— |Kaufeldkid |

Figure 3-20: L l 0

Turning on

the Kids L ] O

Only control * Master screen name

is easy.

4. Click the box next to your child’s screen name to turn on this control.

In the figure, KaufeldKid is limited to Kids Only access, but my other two
screen names have free run of the system.

5. When you’re done, click OK.
A dialog box appears and proclaims that your changes are saved.
6. Click OK and then close all the Parental Control windows.
That’s it — the control is in place.

To remove the control, repeat the steps. Clicking next to the child’s screen name
in step 4 clears out the check box, turning off the control. To turn off the control
completely, you also have to clear some settings in the Chat Controls window.
Don’t panic — America Online walks you through the changes automatically.

Chat Controls

The People Connection chat rooms are a big attraction on America Online. On
your monthly bill, though, the word popular often translates into expensive
because losing track of time while chatting the night away is so easy.

To keep your kids (or even yourself) out of the chat rooms, follow these
instructions:
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1. Sign on with the master screen name and then choose Membersc
Parental Control from the main menu.

The Parental Controls window hops energetically onto the screen.

2. Click Custom Controls and then click Chat. Finally, click Chat Controls
at the bottom of the window.

The chat controls window in Figure 3-21 appears.

Parental Contral

é Parental Control

Ni——
To restrict a sereen name from an area, selectthe checkbox thatis acrass from the screen narne
and under the area you wish to restrict.

Block --- People Connection --- Block
Instant Block Black Conference
Screen Name Messages Al Roorms Member Rooms  Rooms

E—— LJKaufeld 1 U U U

Figure 3-21: LlenKaufeld i (I U U

Besureto |Kaufeldkid | O = O

set all the [ 1 O O O
options —

there are a l ] t O O
bunch of
them here!
]

3. Click the check boxes next to your child’s screen name for each chat
control you want to turm on.

Table 3-1 explains each of the four options.
4. When you're done, click OK.

America Online responds with a brief note that your changes are saved.
5. Click OK and then close all the Parental Control windows.

Another one’s done!

Turning off the chat options is as easy as turning them on. Just repeat the
preceding steps.

Download Controls

Of all the Parental Controls, these are probably the least important. Granted,
there are some things in the world that I don’t want my kids downloading from
America Online or the Internet, but that’s hardly my biggest concern about
online life.
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Table 3-1 Parental Control Options
Control Severity Description
Block Instant Messages 1 The screen name can’t send or

receive Instant Messages {see
Chapter 7 for more about this feature).

Block All Rooms 5 Completely blocks access to the
People Connection interactive chat
areas (see Chapter 25 for more details).

Block Member Rooms 2 Prevents access to private chat
areas, but allows the use of the
regular People Connection areas
{more in Chapter 25).

Biock Conference Rooms 10 Blocks allinteractive rooms through-
out America Qnline, including the
discussion rooms in Learning and
Reference {see Chapter 7 for more).
Use this only as a last resort!

If it’s a bigger worry in your life than in mine, follow these steps to limit your
child’s access to downloadable programs and such:

1. Sign on to America Online with your master screen name and then
choose Members<>Parental Control from the main menu.

If everything works just right, the Parental Controls window appears.

2. Click the Custom Controls button and then click Downloading. When
the Download Controls button appears at the bottom of the window,
click it.

The vaguely impressive Downloading control dialog box, shown in 3-22,
leaps into view.

3. To turn on the Download controls, click the check boxes next to your
child’s screen name. When you're done, click OK.

An energetic dialog box pops up, letting you know that your changes
are saved.

I'wouldn’t bother with Block AOL Software Downloads, but turning on the
Block FTP (File Transfer Protocol) Downloads option is a good idea. FTP
copies files through the Internet, and there’s no telling what your inquisi-
tive kiddo might find out there.

4. Click OK and then close the Parental Control windows.

Download controls are now in place!
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Parental Control- Downloading

£3. Parental Control - Downloading
To restrict or block a screen name from using a feature, select the check bax that is across
from the screen name and under the area you wish to restrict.
Btack AQL Block
Software FTP
Screen Name Downloads Downloads
* [Kaufeld ] 0 O
E— Ee niaufeld I O O
Figure 3-22: [Kaufeldiid ] 0 ®
The
: ] | O O
important :
option here l ] O O
is definitely * Master screen hame
FTP.
L]

As you may have guessed by now, to undo the Download controis you simply
repeat the steps to create them. The big difference is that this time you click the
check boxes off instead of turning them on.

Newsgroup Controls

Of all the custom Parental Controls, this one is the most valuable. The Internet
Newsgroups are an incredible resource, filled with discussions on almost every
topic imaginable. However, not all the conversations out there are designed for
eyes under 18.

To block out the most (I'm being kind here) exotic material that the
Newsgroups offer, follow these steps:

1. Sign on with the master screen name and then choose Go To=>Keyword

from the main menu. Type keyword Newsgroups in the dialog box and
press Enter.

The Newsgroups window appears on-screen.
2. Click the Parental Controls button in the lower-left corner of the window.
A window listing your screen names pops into view.

3. Click the radio button next to your child’s screen name (see Figure 3-23)
and then click Edit.

The screen name list is replaced with the Blocking Criteria window.

4. For most kids, I recommend setting the controls just like Figure 3-24.
When you're finished, click OK.
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Parental Controls
Edit barental cantrals. fo(,which;s:regh‘name? =
Ojkaufeld
@ kaufeldkid -
Figure 3-23: R ~
Choosethe ||~ ~ Qlmesrd
nameforthe | O
controlsand § = O
then click ||
Edit.
E—

[JUsefullnewsorowpshst |
Block newsgroups containing these words in the name:
I | coy erot
Figure 3-24:
These two
litle words Black the following newsgroups: S L
keep your B
kids out of
so much
trouble that
it's amazing.

The example setting blocks your child from any Internet newsgroup with,
shall we say, stimulating words in the name. This one setting quickly blocks
off most of the content that many parents are concerned about.

This setting does nothing to keep your kids out of the more explicit areas
of the World Wide Web. As I write this, some Web-based controls are
planned, but they’re not currently available. By the time you read this
book, though, those controls may be ready. Keep checking keyword
Parental Controls for the latest news about Web controls.

5. Close all the various open windows and continue with your regularly
scheduled day.

Your child is now safe from most of the newsgroups.

To undo these restrictions, work back through the steps above. In step 4, delete

the entries in the Block newsgroups text area. Remember to click OK when
you're done!
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alking” to people in America Online really means “typing” to them.
Whether you communicate in an e-mail message or in a live chat room,
the other people out there know you only by what you write.

And wouldn’t you know it — a whole bunch of rules, procedures, guidelines,
and statutes exist about how to behave in the wonderful world of electronic
communication. Unfortunately, none of them are written down anywhere. At
least they weren’t when 1 got started. You, however, are far luckier than L.

This chapter presents to you what I learned the hard way. It briefly explains
how to write e-mail messages and Internet newsgroup postings without getting
flamed (electronically yelled at). In short, this chapter is the best of the rules,
procedures, guidelines, and statutes out there just waiting to trip you up.

In E-Mail, No One Can Hear You Smile

When you talk to someone face to face, what you say is only part of the mes-
sage. Most of the message comes along with vocal tone, eye contact, and body
movement. On the phone, the only thing you have to go on is what the other
person says, but the way it's said provides clues and meanings for the words.

Alittle further down the communication food chain is e-mail. E-mail is pure
message: no voice, no gestures, no nothing. It's WYTIWYS (What You Type Is
What You Say) messaging at its best.

And this purity of message, [ submit, is a problem.
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Well, perhaps it’s not really a problem, but it certainly is a breeding ground for
problems. Whatever you type is the message. Leave all your emotion, intent,
sarcasm, and inflection at the keyboard — all that remains on-screen are

your words.

For example, one morning you're “invited” to attend a meeting at the office.
After enduring two hours of the most incredibly boring presentation of your life,
the speaker expires and everyone goes to lunch. After you get back, you drop
an e-mail message to Jane, another coworker who suffered through the
morning’s activities. “Wasn’t that the most incredibly fascinating talk you ever
heard?” you sarcastically write. Jane reads your message, thinks the meeting
snapped your mind, and has you placed in an institution for the rest of your life
{(thus freeing up your windowed office for herself).

Would this same unfortunate scenario happen in face-to-face conversation? No,
probably not. You'd roll your eyes as you described the meeting, and your
voice would carry enough sarcasm for every man, woman, and child in metro-
politan Dayton, Ohio. Even though the words are the same, the message is
completely different.

Keys to Good E-Communication

All the e-mail gurus assume that you already know a little bit about the elec-
tronic communication thing. I must have missed class that day because nobody
ever taught me anything. I had to learn it all on my own.

In a blatant attempt to save you frustration and abuse, the following sections
explain what you need to know about the gentle art of writing e-mail.

: message area orpostmg a comment toan Inter‘

]ommg really pays off.

So,how: doyou llsten to a dnscussnon board? Do"

_kidding — don’t do that.) Read other people’ s

newsgroup, listening to the conversanon before - ,(someone who s new to the mte

- jhave a clue as to what he ors

you view it and put your ear to the monitor? (Just

postings. Learn how the group talks and inter-
acts. When you add your own thoughts write
clearly, keep to the pomt -and make it short. T’nls o

up to you to learn how thmgs work before jmnmg

, thefrayor nskthe consequences (andthe conse- ,

quences. aren tfun)
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Abstain from verbosity — pursue lucid prose

This little ditty comes directly from its original appearance in How to Write
Software Manuals for Fun, Profit, and Minimal Comprehension (obviously, they
didn’t understand it either). It means, say what you have to say and use normal
language to do so. Don’t try to blow people away with your amazing command
of the language; impress them with the simplicity and clarity of your
message instead.

The next time you write an e-mail, try writing the way you talk. Describe your
message out loud and write what you say. Quite different from your usual style,
isn’t it?

Spel wurds rite

Nothing is more annoying than a misspelled word in the middle of an e-mail.
Misspellings are distracting and deeply reduce the credibility of your message.
In short, don’t let it happen to your messages.

If your e-mail package has a built-in spell checker, use it! If it doesn’t, take an
extra moment to reread your work and ferret out those spelling errors.

Come to think of it, even if you have a spell checker, reread your message
before sending it. Fine-tuning your meaning before sending the message is a
whole lot easier than cooling off a mad coworker who misunderstands what
you're trying to say. Enuf sed.

DON'T SHOUT!

Here’s one for those of you who like typing in ALL CAPITAL LETTERS. Using all
caps is incredibly bad form in both e-mail and online chat rooms.

Why? BECAUSE YOU LOOK LIKE YOU’RE SHOUTING, that’s why.

1 understand that some mainframe computers didn’t even have lowercase
letters a few years ago. Really — 1 do. But times have changed, and the prevail-
ing communication winds of the day demand messages in upper- and lowercase
text. Please, for your sake (and my hearing), don’t type messages in ALL CAPS.
(Oops, sorry — 1 didn’t mean to shout.)
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Judge Not, Lest Ve Be Flamed

This rule is the hardest one to remember about life in the Brave New Digital
World. On the surface, it’s really simple. In practice, it’s really tough.

The rule is as follows: Everyone has a right to an opinion, no matter how
uninformed, narrow-minded, or upsetting you think it is. You have the right to
ignore, disagree, and discuss anything people post in an Internet newsgroup or
an America Online bulletin board. You may not, however, question the person’s
right to hold the opinion. That last line is the tough part.

The simplest way to live by this rule is to stay out of areas that you find upset-
ting. If you read something that stirs your ire, either don’t reply right away or
don’t reply at all. Remember that someone out there thinks your opinions are
more than a little off the wall, too.

Apply bhumor carefully (ha!)

[ touched on this subject at the beginning of the chapter, but it bears repeating.
Humor is a wonderful thing (I can’t imagine a ...For Dummies book without it),
but you must treat humor with respect. The phrase “You’re a goober” can be
anything from a gentle reproof to fighting words, depending on how it’s said.

If you're trying to be funny in a message, say so. | recommend an occasional
emoticon (those little smiley faces made with typing characters) to ensure that
your humor is heard and understood. Don’t overdo it, though. Tacking a smiley
emoticon onto the phrase, “You're really stupid,” doesn’t quite turn those
words into a playful jest. When possible (and that should be most of the time),
let your words speak for themselves. For more about America Online’s most
popular emoticons, see Chapter 41.

Dnt typ [k ths

I'm not sure why, but all of a sudden using quasi-intelligible shorthand for
e-mail messages is in. It’s something about dropping the vowels out of words so
that you can type more quickly. (Yes, [ think it’s silly, too.)

If you must use an abbreviation or two, that’s fine as long as you're sure that the
person getting the message will understand what you mean. If you aren’t sure,
don’t use the abbreviation — spell out the phrase instead.

If you're introducing a new abbreviation, follow what the newspapers do: Write
out the phrase the first time you use it and put the abbreviation in parentheses
behind it. After that, just use the abbreviation by itself.
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Now take your time and see
if you can identify the person
Who attacked you on e-nail.

Petitioner Microsoft Corporation - Ex. 1006, p. 63



In this part . . .

Fe only thing standing between you and a brain-
numbing quantity of mundane details is the America
Online access software. You and this program are a team —
you’ll be amazed at what you can accomplish together.

This part explores the pretty pictures, menus, and windows
that meet and greet you while you're using America Online.
It also explains the fine art of sending e-mail and using the
Download Manager to grab programs from the system’s
online libraries. In short, it’s the boring stuff you have to wade
through to get to the interesting stuff on the other side.

But of course, I made sure that it isn’t boring at all. Really.
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u sing America Online is one thing. But before you actually can use it, you
must tangle with (insert scary organ music here) the user interface!

No, it’s not something else that you need to buy. The term user interface is just a
fancy way of saying the tools you use to interact with the soffware. 1t’s like an
automobile engineer looking at the layout of a dashboard and thinking, “Golly,
that’s a clever user interface.” ( Yes, despite their various specialties, most
engineers respond to the simplest stimulus in predictably unintelligible ways —
they’re just that way.)

This chapter covers the three main tools in your user interface for working with
America Online: the Toolbar, the menu bar, and the shortcut keys. It doesn’t
matter whether you use these tools together or separately, but | do recommend
using them,; collectively, they make your life a little easier. ( That’s more than
you can say for most software on the market.)
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Revealing the Toolbar

It’s always there right below the menu bar — watching you, daring you, enticing
you with color buttons. But the Toolbar remains a mystery. What do those little
pictures mean? Why are there so many of them? Is it time for lunch yet?

Table 5-1 strips away the Toolbar’s shroud of mystery, showing, naming, and
explaining each button. So much for the mystical Toolbar, eh?

B+~ Take a little time to learn what the Toolbar buttons do; they give you quick
| access to some of the main areas of America Online and make wandering
around the system a little less confusing.

v~ After years of Toolbar envy, Macintosh users finally get a Toolbar of their -
own in version 3.0 of America Online for Macintosh. It's about time, isn’t it?

Table 5-1 Everything on the Toolbar
Button  Button Name What It Does

Read New Mail Opens the New Mail window; same as clicking
the You Have Mail button onthe Welcome
window or choosing Mail=>Read New Mail.

Compose Mail Opens the Compose Mail window; same as
choosing Mail<>Compose Mail.

Channels Displays the Channels window; same as choosing
Go Toc>Channels.

What's Hot Opens up the What's Hot window; same as
keyword Hot.

People Connection Puts you in a randomly selected room of the

People Connection; same as clicking the People
Connection button on the Channels window.

File Search Displays the Software Search dialog box; same
as keyword File Search.

Stocks & Portfolios Opens the Quotes & Portfolios window; same as
keyword Quotes.

Today's News Displays the Today's News window; same as
clicking the Today's News button on the Channels
window.

World Wide Web Starts the buiit-in Web browser and displays the
America Online Web home page; same as
keyword Webh.
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Button  Button Name What It Does

Marketplace Allows you to go shopping in the Marketplace
window; same as clicking the Marketplace button
on the Channels window.

My AOL Displays the My AOL settings window; same as
Members=>My AOL.
Online Clock Displays the current time in Vienna, Virginia,

along with a timer showing how long ago you
signed on; same as Go To=>0nline Clock.

Print Prints text and graphics in the current article
window (if an article window is open); same as
choosing Filec>Print from the main menu.

Filing Cabinet Opens the Personal Filing Cabinet for the current
screen name; same as choosing Filec>Personal
Filing Cabinet from the main menu.

Favarite Places Opens the Favorite Places window; same as
choosing Go To=>Favorite Places from the
main menu.

Member Services Sends you into the free Member Services
window; same as keyword Help.

Find Opens the Find It on AOL dialog box; same as
pressing 38+F on the Mac or Ctrl+K in Windows.

Keyword Displays the Keyword dialog box; same as

pressing 86+K on the Mac or Ctrl+K in Windows.

Running through the Menus

Beauty, as the cyberbard says, is only button deep — and there’s more to the
America Online interface than mere pretty buttons. How about that menu bar
up there? What's it do? Actually, quite a lot. I can’t imagine trying to figure out
America Online without the menu bar.

Because the menus are so darned important, this section looks at them one by
one. The section doesn’t go through every item, because there’s more to life
than menus (a collective whine issues from the nerds of the world). Instead, the
section points out the menu choices that make life in America Online Land a
little bit easier.
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File

The File menu governs everything dealing with documents (such as magazine
articles, bulletin board postings, and forum announcements), files, and other
trivialities such as exiting the America Online access program (but who’d ever
want to do that?). The most interesting File menu commands are
\\J v~ File>New: Starts the built-in text editor and gets ready to create a new
plain-text document. I often keep a blank document window open when I'm
browsing through the system and use it like a notepad for keywords,
screen names, and anything else I want to remember. It works really well!

1/ File>Open: Opens a document (a plain-text file — not a WordPerfect or
Microsoft Word .DOC file), graphic, or sound file that you downloaded or
saved to your computer’s disk drive.

v~ Filew>Save: Saves the current document (article, discussion board posting,
and so on) as a plain-text file on your computer’s disk drive. If a graphic is
on the window {(a photo accompanying the news story, for example), the
America Online software automatically offers to save a copy of it, too.

R R R

v~ Filew>Save As: Saves the current document under a new filename. If the
current document is an article, discussion board posting, or something
else in an online area, then this command behaves just like Filer>Save.

v File>Print: Prints the current document. If you choose this option and
don’t have a printer connected to the computer, your computer may seem
to lock up for a minute or two. Be patient — the machine should come
back to life, probably complaining that your nonexistent printer is either
turned off or out of paper. (Silly computer.)

]
gé
%

2

v~ File=>Print Setup: Opens the Printer Setup dialog box, where you can
change the options for the default printer or temporarily select a
different printer.

+~ Fle<>Personal Filing Cabinet: Displays the Personal Filing Cabinet so
you can root through your stored stuff. Chapter 7 reveals the cabinet’s
mysteries.

v~ FilewDownload Manager: Starts the Download Manager, the Master of All
That You Choose to Download Later (and a piece of software that has not a
shred of ego, I might add). Chapter 8 has all the details on this feature.

v~ File>Log Manager: Controls the online logs. Logs are like very fast
electronic scribes, scribbling notes about everything that’s said in a Chat
area (discussion areas and theaters, too) or during other parts of an
America Online session {capturing articles and stories, for example). For
more information about Chat logs, see Chapter 25. Session logs are
covered in Chapter 8.
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v Filer>Stop Incoming Text: Tells America Online to stop sending the
©  current text document to your system. Works in articles, discussion board
postings, Internet newsgroup postings, and other text windows like those.

" 1~ FilewExit: Closes the America Online access software.

Edit
Just about every Macintosh and Windows program has an Edit menu. This

menu contains your basic text-editing tools; apart from that, the Edit menu is
nothing to write home about. Your main choices in this menu are

v EditoUndo: Undoes the last change you made. I use this command a lot
- when I'm writing e-mail messages. My fingers enjoy playing tricks on my
brain, so they take charge of the mouse and randomly delete text. After
my brain goes spastic for a moment, it brings the hand digits back under
control and uses Undo to recover the nearly lost text.

v EditeoCut: Removes highlighted text from the screen and puts it on
©  the Clipboard.

1 Edit>Copy: Copies the highlighted text from the screen to the Clipboard,
-~ leaving the original text in place.

1 Edit-oPaste: Inserts text from the Clipboard into the current document.
1~ Edit>Select All: Highlights all the text in the current document.

1 Edit~>Find in Top Window: Searches the current window for a given piece
of text. Open a Web page, an article in the News section, or a discussion
board posting and give this menu choice a try.

If none of these menu items sounds familiar to you, get a copy of Windows 3.11
For Dummies, 4th Edition, Windows 95 For Dummies, or Macs For Dummies, 4th
Edition, all available from IDG Books Worldwide, Inc. You can thank me later.

The final items on the Edit menu are graphic editing tools. The America Online
programmers threw in a miniature art studio with several tools that modify the
overall look of a graphic file. You have tools for cropping the image, adjusting
the brightness and contrast, and flipping the picture vertically or horizontally.
There’s even a tool that sucks all the color out, leaving you with a stark black-
and-white illustration. (It appeals to the minimalist in me.)

The graphic editing tools are available only when you view a graphic file that’s
stored on your computer. To do that, choose File=>Open from the main menu
and double-lick the graphic file you want to work with. The America Online
software displays the graphic in a new window. Now you're ready to have
some fun!

Petitioner Microsoft Corporation - Ex. 1006, p. 69



70 Part II: Surviving the Software

Here'’s a rundown of the image editing menu items:

4 1+~ Edit=>Crop Image: If the graphic is too big, use this tool to trim out the

parts you don’t need. Click and drag across the image to draw a box
around the part you want, and then choose this menu item. The America
Online software discards the rest of your graphic, leaving only the part you
highlighted.

% 1~ EditoFit Image to View: Resizes the image to fit into the current window.
After you choose this menu item, the Show Image in Original Size menu
choice takes its place on the menu.

1~ Edit>Show Image in Original Size: Turns off Fit Image to View, returning
the image to its full size. After you choose this menu item, the Fit Image to
View reappears on the menu.

L Edit<>Show Image Tools: Displays the image editing tool palette shown in
‘ Figure 5-1. After you choose this menu item, Hide Image Tools replaces it
on the menu.

1~ Edit->Hide Image Tools: Puts away the image editing tool palette. After
% you choose this item, Show Image Tools takes its place on the menu.

|
Figure 5-1: Rotate image Revert to saved
Unleashthe g side to side - Flip top to bottom
artist inside )
you with Brighten Darken
.the IMage |ncrease contrast Decrease contrast
editing tools.
Remove colors Reverse colors
|
1E
&0

3 These tools don’t work on graphics that America Online displays during your
online session (things like Channels window pictures and such) unless you

choose Filec>Save and make your own copy of the image.

Go To

This menu is one that you can'’t live without. Go To gets you darned near
everywhere you need to go in America Online; it's navigational one-stop
shopping at its best. Following are several of your choices in the Go To menu:

= 1 Go To=Set Up & Sign On: Displays the screen name and password
window before you sign on to America Online.
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¥ Go To>Sign Off: When you're ready to leave America Online and come
screaming back to the real world, select this menu choice. Remember to
sigh wistfully as well — doing so enhances the dramatic mood of the
moment.

+* Go ToExit Free Area: Leaves the no-charge areas of America Online and
returns to your regularly scheduled bill. | wondered for the longest time
why this item didn’t exist, only to find out that I was looking for it in the
wrong place. (1 hate it when that happens.) Use this command to get back
to online civilization from Member Services, TechLive Help, or any other
free America Online area.

+* Go ToroChannels: Brings up the Channels window (which used to be
known as the Main Menu window).

v Go To>Welcome Menu: Displays the Welcome window, which used to be
called the Spotlight menu.

+* Go Tor>Keyword: Opens the Keyword dialog box for quick access to
f§§ everything that’s not in the Go To menu. Same as clicking the Keyword

button on the Toolbar.

1 Go TooFind: Opens the Find window and searches for people, places,
things, and events. (It may even be able to find your car keys.) Same as
clicking the Find button on the Toolbar.

+* Go To<vOnline Clock: Displays the current time and tells you how long
you’ve been signed on.

+* Go To>Favorite Places: Opens the Favorite Places window. See “Organiz-
ing the Places of Your Heart” later in this chapter for more about tracking

your best-loved Web sites, America Online areas, and Internet goodies with
this incredibly cool tool.

+* Go TocoEdit Go To Menu: Changes the items at the bottom of the Go To

menu. The next section of this chapter has all the information about this
feature — you’re gonna love it!

Mail

I'd be lost without e-mail — it’s that important to my work and play. Because my
dependence on it isn’t unique, America Online dedicates an entire menu to this
function. The menu contains lots of options, but the following list covers the
ones that you really care about:

.+ Mail=>Mail Center: Goes to the America Online post office. If you want to
know more about doing e-mail the America Online way, this place is a good
area to explore. (Of course, Chapter 7 isn’t bad either.)
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= 1 Mail<>Compose Mail: Opens the Compose Mail window, which is ready to
take down your new digital missive. Same as 8+M on the Macintosh or
Ctrl+M in Windows.

v Mail-<oRead New Mail: Opens the New Mail window. Choosing this com-
mand is the same as clicking the big You Have Mail button in the Wel-
come window.

v Mail=>Check Mail You've Read: Displays the Old Mail window, where you
can reread messages from your friends, acquaintances, and whomever else
sends you mail. Old mail usually stays in this window for seven days; once
in a while, it lives a couple of days longer.

:

SN

v Mail<>Check Mail You've Sent: Displays the Outgoing Mail window, which
is the half-brother of the Old Mail window. The concept is the same, except
that this window shows messages that you actually wrote to other people.
Messages stay in this window for at least seven days and no more than 30.
After a message is past the seven-day mark, it may vanish at any time
without warning.

1+ Mail>>Check Is in the Mail: This really isn’t a menu item, but I think that it
should be, what with electronic payment options and all that kind of stuff.

v Mail=>Fax/Paper Mail: Opens a Help window containing all the gory
details of America Online’s fax and paper mail gateways. This is the place
to find answers about America Online’s special mailing services.

v Mail<>Edit Address Book: Opens the Address Book window.

.+ Mail'>Set Up FlashSessions: Opens the FlashSessions setup window.
FlashSessions jump into America Online, send messages that you wrote
offline, quickly pull new mail into your computer, and download any files
left in the care of the Download Manager. They're great time and money
savers. Chapter 7 has the details.

- Mail<>Activate FlashSession Now: Starts a FlashSession (but you probably
' figured that out on your own).

1 Mail<oRead Incoming FlashMail: Reads mail retrieved with a FlashSession.

 Mail<>Read Qutgoing Mail: Double-checks messages waiting to be
. FlashSessioned (is that a word?) to America Online.

Members

Interacting with other America Online members is a blast. The most interesting
people (you and me, for example) are out there just waiting to be met. This
menu offers several options that help you meet and greet people online. Here
are the best of these options:

- v Members>Member Services: Goes to the free online Help area.
Chapter 31 has everything that you need to know about this area.
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£ 1+ Members<>My AOL: Opens the My AOL information and setup window.
Chapter 3 explains all about this helpful option.

1 Members=>Preferences: Customize your online environment with the
Preferences dialog box. The options in this dialog box include Preferences,
Stored Passwords, Parental Controls, Screen Names, and your profile. See
Chapter 3 for everything you never — er, ever — wanted to know about
Preference settings.

+* Members=>Parental Control: Controls the kinds of services that each
screen name in your account can use. See Chapter 3 for more information.

+ Members>Member Directory: Displays the Member Directory menu.
Your options in that menu include searching the Member Directory and
messing with your profile (what other people see about you when they
search the Member Directory).

R R A T S R T R R R SR

+* Members=>Send an Instant Message: Use the Instant Message function to
drop a quick “Hi!” on someone’s head. Same as pressing 38+ on the
Macintosh or Ctrl+l in Windows.

+* Members~>Get a Member’s Profile: Learn more about the person you just
bonked on the head with an Instant Message. Same as pressing 3+G on the
Macintosh or Ctrl+G in Windows.

+* MemberscoLocate a Member Online: Finds out whether a particular
screen name is signed on to America Online right now. If so, the system
tells you whether that person is in a chat room, a private chat room, or
just wandering around the service somewhere. Same as pressing 3#+L on
the Macintosh or Ctrl+L. in Windows. (In earlier versions of the program,
this keystroke used Ffor Find instead of L for Locate.)

+* Members=>Buddy Lists: Opens the Buddy List dialog box, to use, change,
and generally manage your Buddy Lists. To find out more about Buddy
Lists, check out Chapter 7.

Window

This menu is a whoa-l-have-too-many-windows-open navigational lifesaver. If
you misplace an Instant Message window or lose track of your Web browser,
head to the Window menu and find it right away. Best of all, tracking the errant
window is merely a two-step process:

1. Choose Window from the main menu.

The Window menu drops down, displaying some marvelously technical
options near the top and a numbered list of your open windows at the
bottom. On the Macintosh, the windows aren’t numbered, but they’re still
listed at the bottom of the menu.

2. Click the name of the window you want to display (see Figure 5-2).
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The until-so-recently-lost window immediately pops to the top of the heap.
Is this a great country or what?

If you're completely fed up with all those open windows (or if it unexpectedly
starts raining), close them all with a quick visit to the Window=>Close All menu
choice. Like it says, selecting this option makes all the open service windows go
away and minimizes the Welcome window.

As for the other items in the Window menu, don’t worry about them. They’re
for people who actually care about the difference between tiling and cascading
windows — definitely folks with too much time on their hands.

Help

If you have trouble getting onto America Online, check the Help menu for
assistance. This menu isn’t particularly good at helping you with problems after
you've signed on to the system, but it does have some specific ideas about
getting there. Help menu options include

= 1 Help=>Contents: Displays the Help system’s Contents page.

4 1 Help->Search for Help On: Searches the list of keywords in the Help file.
#  This is my favorite way to get help fast.

America Online
Window [T
Cascade Shift+F5
Tile Shift+F4
Arrange Icons
Close All

R i
Star Wars Sim

- Satety Tips for AOL ~
B Aboutthe Star Wars Sim Forum
[y OGF Posting Guidelines
{3 How To Join A Sim
£3 SWSF Announcements
il [€3 Sim Forum Schedule
& Star Wars Messaging

Add te Favorite Places
Remember Window Size and Position
Remember Window Size Only

1 Welcome, JKaufeld!
2 Channels
3 What's Hot

+ 4 Star Wars Sim Forum

— ; 5 >Instant Message From: e
i [T The Alliance essage | '-"Vllann
Figure 5-2 4l %0 The Empire
The Instant B SWSF Libraries
€ Instan -5 SWSF Hosted Sim Information
Message
from Vilanne =
is lostin EEE
the window
pile — but Star Wars Room SWSF Web Site NEW in the SWSF! The Sit Forum
not for long!
|
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For help after you sign on to the system, check out these two Help menu
goodies:

§ 1~ Help<>Online Support: Sends you directly to the free Member Services
¥ window. Same as using keyword Help.

1~ Help=~>New Member Info: Opens the Discover America Online new
member orientation window. Same as using keyword Discover.

By the way, you won't find a Help option on the Macintosh Arr}erica Online
menu bar. Instead, it’s filed in the ® menu. To find it, choose ®<>Help.

A Menu to Call Your Own

Once again, someone in the access software programming department of
America Online was thinking. If this particular person hadn’t been thinking, the
bottom section of the Go To menu wouldn’t exist today.

The Go To menu’s bottom section is your very own customizable menu space.
Load it with up to ten of your favorite online destinations. This menu comes
preloaded with entries for seven popular parts of America Online (or at least
parts America Online wants to be popular, like Sign on a Friend), but you can
easily change those entries to things you're interested in.

£ 1” You just need to keep one rule in mind: Only services and forums with a
keyword can be in the special Go To menu. If you can't get there with a
keyword, you can’t get there with the Go To menu, either.

§ 1~ Some my picks for a starter Go To menu include Business Week magazine

' (keyword BW), the New York Public Library Online Reference Books
(keyword Desk Reference), the Star Wars simulation area ( keyword Star
Wars), and the multiplayer space game Federation (keyword Federation).
If you're a fellow fan of Pinky and the Brain, save a spot on your menu for
the Warner Brothers kids area (keyword KidsWB). Dave Barry fans should

include the Mercury Center (keyword Mercury) for quick online access to
his weekly columns.

Here’s how to customize the Go To menu with your Favorite Places:

1. Find something that you want to add to the menn, and get its keyword
and name.

Make sure that the keyword is correct; otherwise, the menu option won'’t
work (and the programmers of the world don’t need any help in develop-
ing software that doesn't work).
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2. Choose Go To<Edit Go To Menu.
This command displays the Favorite Places dialog box.

3. Decide which key you want to use for the new item, and click the Menu
Entry box for that key.

If the box already has an entry, press your Backspace or Delete key to
remove it (see Figure 5-3).

4. Type the name of the item in the Menu Entry box.

Whatever you type appears in the Favorite Places menu, so keep it kinda
short — one to four words at most.

5. Press Tab to move to the Keyword box.
If you're replacing an existing entry, press Backspace or Delete to remove it.

6. Type the keyword for your new menu item in the Keyword box (see
Figure 5-4).

Double-check your typing to make sure that the keyword is correct.

N Favorite Places
Key Menu Entry Keyward

1 IDiscover America Online ndiscover i
2 [What's Hot thut ]
3 ]Top News “tup news l
4 t “events ]
5 {Stuck Quotes ”stocks ]
& 'Sign on a Friend “friend ]
[ ] 7 E\OL Store “aolstore I
Figure5-3: | 8 | j| ]
Maki
roomaf_lf)lrg ?0 |L jl} {
new item
inslot4. | [ ]
E——

7. Click the Save Changes button to make the new entry part of your
Go To menu.

If you have a sudden desire to forget that you ever considered changing
the menu, click Cancel in Windows or close the window on a Macintosh.

8. Open the Go To menu and choose your new item from the Favorite
Places section (see Figure 5-5).
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Favorite Places

I
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Menu Entry Keyword

ﬁ)iscover America Online ”ﬁscover J
[What's Hot Jﬂwt I
ﬁ'op News ”wp news J
]Carmons {Dilbert & Others) ]Icanoons J
IStock Quotes H;tocks J
|Sign on a Friend |Ifiend ]
P\OL Store Haoistore }

l

|

I

)

If something that looks like the dialog box shown in Figure 5-6 pops up
after you try your new menu item, go back to step 6 and check the Key-
word entry; it's probably a little spelling-challenged.
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|
Figure 5-6:
Rats — it
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Organizing the Places of Your Heart

There’s a new button in town — and it’s appearing on a Toolbar near you. Say
hello to Favorite Places and its sidekick, the Favorite Places window — both of
them riding hard to organize the online areas you know and love.

The new Favorite Places system won’t bring any law into your digital life

( hopefullty Congress won'’t either), but it promises a lot of order. Instead of
having just ten favorite places, you can have as many as you want! Is that just
too cool or what?

Figure 5-7 shows a hard-working Favorite Places window in action. The heart
entries link to services within America Online or World Wide Web pages and
Gophers on the Internet. The item highlighted in Figure 5-7 is in the Mercury
Center on America Online. The entry right above it, Intertext, is a Web page.
Manila folders (such as Support Areas, Gaming, and Fun Spots) apply some
order to the impending chaos.

# ¥ To use the new Favorite Places system, you must have Version 2.5 or later
4 of the America Online access software for Windows. The older software
just isn’t this cool.

+# You're not limited to the folders shown in Figure 5-7. I created those myself
to meet my exceedingly peculiar needs. You have the freedom — yes, even
the right — to create €qually peculiar folders for yourself.

Using folders and favorite places

This thing is so obvious that I almost forgot to mention it. Luckily, two of my
brain cells, spurred into action by the caloric heat of a half-digested Oreo,
reminded me that double-clicking is the key to using the Favorite Places
window:

g +# To open a folder, double-click it.

g 1 To close the folder when you're done with it, double-click the folder again.
%;

1 To take off for a favorite place, double-click it.
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Favorite Places

3 Favorite Places

— 4 HotWwired

— @ Intertext
Mercury Center -
— &8 Supportareas
- B8 Gaming

|- & Fun Spots

E 4 Trojan Raom Coffee Machine

- Bay Area Living

¥ Kites
4 The Sprawl - Chiba City Limits
- B3 Business Spots

Adding a favorite place

Including a new favorite place is a cinch. You can do so in two ways: the Easy
Way and the Other Way. This section tells you how to handle them both.

The Easy Way is for areas inside America Online or Internet-based Web pages
and Gophers that you've browsed your way into. Here are the steps:

1. Display an area that you're fond of, either inside America Online or on
the Internet.

2. Click the little heart document icon in the window’s upper-right corner

(see Figure 5-8).

Homeschooling

_Homeschooling Forum
A
& About This Forum -

%1 Homeschooi Connection
@ Homeschooling Library
£3 Lesson Plan Lihraries
<3~ The Teacher Pager Practical
£3 Homework Help Homeszchooling Mag.
E3a The Reference Desk

¥ Farenting Conference Center

Horne Education
Magazine
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L]
Figure 5-9:
My new
entry lands
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A dialog box appears, demanding to know if you're serious about adding
this window to your Favorite Places list.

Not every window in America Online has one of those cute littie heart
document icons. It’s unfortunate, but true. If the window you’re looking at
doesn’t have one, you can’t add it to the Favorite Places list.

3. Click OK in the Add this window to Favorite Places dialog box.

Your new entry takes up residence at the bottom of the Favorite Places
window, just like Figure 5-9.

Favorite Places

23 Favorite Places

— 4 Hotwired

— 4 Intertext

— « Mercury Center -- Bay Area Living

¥ Trojan Room Coffee Machine
¥ Kites

¥ The Sprawl - Chiba City Limits
&8 Business Spots

Use the Other Way when someone dashes up and says, “I just found the neatest
Web page — you've gotta check it out!” The Other Way assumes that you have
the address of a Web page or an Internet Gopher and want to manually incltude
it in your Favorite Places. Here’s how it’s done:
1. Click the Favorite Places button on the Toolbar.

The Favorite Places window appears.

2. Click the folder in which you want to store the new item.

If you don't know where to put the item, click on the Favorite Places folder
at the top of the window. That’s as good a place as any — and you can
always move the entry somewhere else later.

3. Click Add Favorite Place.

The Add Favorite Place dialog box (designed by the Use No Articles
Programming Team) appears.
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4. Type a name for this entry in the Enter the Place’s Description box,
press Tab, and then type the entry’s address in the Enter the Internet

Address box.

Figure 5-10 displays a finished entry, ready to be saved for posterity.

5. Click OK to add the entry to your Favorite Places window.

Add Favaorite Place

Enter the Place's Description:

lThe Amazing FishCam

Enter the Internet Address:

lﬂttp://wwwz netscape.com/fishcamfishcam. html,

Adding a folder

Adding all kinds of favorite places to your system is great, but you need some
organization to keep everything in order. That’s why those clever America

Online programmers included folders.

Folders can live in the Favorite Places area or inside other folders (see Figure
5-11). Either way, creating a folder is easy. Here’s how (assuming that you
already have the Favorite Places window open):

Favaorite Places

28 Favorite Places

Can
L Be

L 2= Inside

L P Other
L = Folders
L & Butthis is ridiculous

— & Hotwired
— 4 Intertext
- & Mercury Center -- Bay Area Living
— Support areas
¥ 1BM
¥ Hewlett Packard
& Microsoft
¥ Microsoft Knowledge Base {on AQL)
¥ Novell
- Gaming

.

aa  Cavon tvr (S nmnins WAarid
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Figure 5-12;
Now there’s
a safe place
for my stuff.
|

Figure 5-13;
The new
folder
proudly
takes its
place in the
window.
L |

Folder Name: lﬁafe Place ]

. Click the Favorite Places button on the Toolbar.
The Favorite Places window pops to attention.
. Click the Favorite Places folder at the top of the window.
The Favorite Places folder is highlighted (this is a good sign).
. Click Add Folder.

Along, thin New Folder dialog box appears on your screen ( yet another
good sign).

. Type the name of your new folder and then click OK (see Figure 5-12).

Your new folder appears at the bottom of the Favorite Places list, just like
Figure 5-13.

. Move the folder wherever you want it in the list.

If you're not sure how to move the folder, look in the next section.

New Folder

Favorite Places

worite Places |
& Hotyvired
@ Intertext
@ Mercury Center -- Bay Area Living
£% Support areas
¥ IBM
@ Hewlett Packard
¥ Microsoft
¥ Micrasoft Knowledge Base (on AGL)
¥ Novell
— €5 Gaming
& Computer Gaming World
& Game Information Exchange
¥ Microprose
- B8 Business Spots
- & PRACTICAL HOMESCHOOLING
- & The Amazing FishCam
— @ Safe Place

T 1T T4
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The Safe
Piace folder
on the move.
]
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Moving folders and favorite places

Creating folders and favorite places is one thing, but organizing them is another.
The little buggers tend to land wherever the America Online software feels like
putting them. Moving them around is easy, though, once you get the hang of it.

The technique is the same for both folders and favorite places. After you open
the Favorite Places window, here’s what to do:
1. Decide which item you want to move and where it’s headed.

2. Put the mouse pointer on the chosen item, and then press and hold the
mouse button.

The technical term for this maneuver is click and drag, but there’s no
reason to mention it, so I won’t.

3. While holding the mouse button down, move the item to its destination
(see Figure 5-14) and then release the mouse button.

The item settles down, safe and sound in its new home (see Figure 5-15).

To move something to the very bottom of the list, drop it onto the Favorite
Places folder (the first item in the list). To put an item into a folder, either
drop it onto the folder or put it directly into the list, as shown in Figure 5-16.

Favorite Places

BR Favorite Places

[ o Hotwired |

@ Kntertext

— 4 Mercury Center-- Bay Area Living

— B2 Suppon areas

I % IBM

- & Hewlett Packard

— % Microsoft

¥ Microsoft Knowledge Base (on ACL)
¥ Novell

I~ B2 Gaming

— 4 Camputer Gaming Warld

I~ % Game Infarmation Exchange

— 4 Microprose

I— &8 Business Spots

— 4 PRACTICAL HOMESCHOOLING

(— 4 The Amazing FishCam

2z Safe Place
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Favarite Places

B Favorite Places

— ¢ tevired
— @ ltertext
— & Mercury Center -- Bay Area Living
- # Support areas
& IBM
& Hewlett Packard
@ Microsoft
¥ Microsoft Knowledge Base {on AOL)
¥ Novell
- B Gaming
& Computer Gaming World
& Game Information Exchange
& Microprose
— @3 Business Spots
P — @ PRACTICAL HOMESCHQOLING
& The Amazing FishCam

Figure 5-15:
Coming in
for a perfect
landing.
N
Favorite Places
Favorite Places
- Safe Place
— 4 Hotwired
& Interext
I~ @ Wercury Center-- Bay Area Living
~ £3 Supportareas
— 3 Gaming
- 8@ Business Spots
— = Fun Spots
4 _Trojan Roam Coffeq Yachine
¥ Kites
& The Sprawl - Chiba City Limits
— 4 PRACTICAL HOMESCHOOLING
Ee—— i The Amazing FishCarn N
Figure 5-16:
Moving the
FishCam
into an
appropriate
place.
[ ]

Moadifying folders and favorite places

There comes a point in every life when it’s time to make some changes. When
that time in the life of your Favorite Places window arrives, have no fear.
Although change is never fun, at least it’s easy in the Favorite Places window.
Open the Favorite Places window and then follow these steps:
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1. Click the folder or favorite place and then click Modify.

For a folder, the Rename dialog box appears. For a favorite place, the
description and Internet address dialog box appears.

2. Make your changes (usually to the name of the item) and then click OK.

If you change your mind and don’t want to make any changes, double-
click in the upper-eft corner of the box.

Deleting folders and favorite places

Favorite places entries, like other impetuous flashes in the dark sky of fading
youth, have a limited life span. When it’s time to delete one, just do the deed
and go on as best you can. Solemnly open the Favorite Places window and then
morosely proceed through the following:

1. Click the item you want to delete.
2. Click Delete and then OK in the pop-up dialog box.

The entry is no more. Remember, ask not for whom the Delete button
clicks — it clicks for thy once-Favorite Place.

Taking a Shortcut (Key)

I'll keep this section short; after all, that’s the point. Shortcut keys get you there
fast.  mean now. I'm talking speed. Press the shortcut key, and you're there.
Think zoom! Think whoosh! You get the picture. Table 5-2 has all the details.

Table5-2  Macintosh and Windows Shortcut Keys

Group Function Macintosh Windows
Editing Cut . #+X Ctri+X
Copy 38+C Ctri+C
Paste 8+V Ctrl+V
Undo ¥+Z Ctri+Z
Mail Compose New Mail ¥*+M Ctrl+M
Read New Messages 3+R Ctri+R
People-related  Locate someone 8+l Ctri+L
Get Infa {user profile) 3#8+G Ctrl+G
Send an Instant Message 38+ Ctri+l
(continued)
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Table 5-2 (continued)
Group Function Macintosh Windows
Navigation Go to a Keyword #+K Ctrl+K

Custom Go To menu items 38+1t0 38+0 Ctri+1 to Ctrl+0
Documents Stop incoming text 38+. {period) Esc

Save a document 8+S Ctrl+S

Print a document 38+P Ctrl+P
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Your Windows on the World
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In This Chapter

p They don'’t call it the Welcome window for nothing
# Driving up to the service windows

B Joining the discussion

B Browsing titles in the File Library

¥ Dealing with documents

B Chatting away the hours in lecture halls and other places

2 @0 Q0D e R BB Y GD ET SO GO0 60O T BB L ETETERE DO LT BDYE YYD

E verywhere you go in America Online, you're faced with windows. Windows
for news, windows for mail, windows for chatting, windows for menus.
Spring cleaning around here must be a total nightmare.

Although the windows are a little confusing at first, they make America Online
the special place that it is. Unlike other online services, America Online was
designed with the Macintosh and Microsoft Windows graphical way of life in
mind. And it shows.

This chapter introduces and explains all the basic America Online windows. It’s
designed to make you comfortable with the service’s look and feel. The details
of the services come later, in Part lll. For now, sit back, grab a bottle of spray
cleaner, and head for the windows.

The Welcome Window

Every time you sign on to America Online, the Welcome window hops right up
and offers a great big Hiya — welcome to the system. This window is like an
electronic version of the Wal-Mart door greeter, only better. The greeter doesn’t
just wish you well; it even knows the news and keeps tabs on your e-mail box.
Not even Californians have it this good.
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E———
Figure 6-1: (-
How's this |2
for awarm |
welcome?

]

A\

),

Figure 6-1 shows the Welcome window on an average day. It's a pretty straight-
forward affair with three different areas: Highlighted services, Latest news, and
the Navigation buttons.

Welcome, JKanfeld!

Tashirs;, : E: -
'rhfgg;;%érsiﬁh g +— Highlighted
Jjackets —ang. e _ services

- ; ALTR | ! »
o . -PEOPLE | K . CostarTam
iCONNECTION INTERNET KIS

Latest news

[
Navigation buttons

Along the top and right sides of the window are brief descriptions of the
highlighted services, along with graphical buttons that take you to each service.
These entries change all the time, so don’t worry if your screen doesn’t show
exactly the same items as Figure 6-1.

Hanging out in the lower-right corner of the window is the latest news button.
Click the newspaper button to hop directly into the Today’s News window,
America Online's link to the world’s newswires. See Chapter 24 for the news
about, well, News.

Clustered in the lower-left side of the window are the navigation buttons, your
shortcuts to the rest of America Online. Channels displays the Channels
window (discussed in the next section). What's Hot takes you to a listing of the
newest stuff on the system. People Connection and Internet take you to those
respective areas, the same as clicking their buttons in the Channels window.
Finally, the mailbox button way down in the corner tells you whether You have
mail or not. Clicking this button either opens your mailbox or sends youona
jaunt to the Mail Center (depending on whether you have unopened e-mail).

In Windows, you can 't make the Welcome window go away -— €Ver. The best
you can do is minimize it, so instead of being an annoying window in the middle
of the screen, it’s only an annoying icon cowering in the corner. To do this in
Windows, click the down arrow button on the right side of the window's title
bar (where it says Welcome and your screen name). The window pops down to

the lower-left corner of the screen, never to bother you again.
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The Channels Window

If you're looking for the right place to start your online expedition, it just
doesn't get better than the Channels window in Figure 6-2. From here, any of
America Online’s 21 channels is a quick jump away. And Find, Member Services,
and several other useful spots are only a hop and a skip away as well.

Channel
buttons

Figure 6-2:
A
smorgasbord |
of options.
]

IHIEMBERSERVICES il LACELVED I AVELCOME

Miscellaneous services New service button

Occupying most of the window are the channel buttons, offering singleclick
connections to the 21 content channels in America Online, plus the Find
window, that all-seeing, ali-knowing Oracle of the Online World. Each button
(with the exception of the People Connection button) leads you to a menu of
services available in the area. The People Connection button, which just has to
be a little different, ushers you into a randomly assigned chat room.

In the lower-right corner of the window is the new service button, which leads to
the Presenting window. This window highlights various America Online service
areas in a blatant effort to interest you in visiting them. This button is a great
one to click when you're a little bored and want to try something different.

Finally, cowering along the bottom of the window from shame at their somber
appearance, you find the miscellaneous services buttons. When you're looking
for help, click Member Services and take a quick trip to the online help area
(and flip ahead to Chapter 37, too). A quick mouse attack on AQL Live! sends
you to the live events area for some online fun with your favorite celebrities
(and even me). Finally, the Welcome button returns you to the relative comfort
of the ever-present Welcome window.
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+* Getting back to the Channels window is never hard. Just click the Channels
button on the Toolbar and (pooff) you're there.

+* You can also get to the Channels window from the Welcome window,
thanks to the cleverly named Channels window button (but you probably
knew that already).

v~ If your Channels window only has 14 items or fewer and is called the Main
Menu instead, you're not using the newest software. Refer to Chapter 1 for
more about the whole software thing.

The Service Window's

All America Online services have a main window of some kind. It's how things
work around here. This section looks at the two basic kinds of service
windows lurking out there for your viewing pleasure: channel services and
individual services.

Channel services

Every button on the Channels window (except for the People Connection
button, but more about that later) takes you to a big, bold, option-covered
window. Thankfully, the America Online programmers took pity on us, the
vaguely confused of the world, and made all these powerful windows look
basically the same. Figure 6-3 shows the Life, Styles & Interests window, a
sterling example of Channels windowdom.

On the right of the window is an alphabetical list of services available in this
particular area. Next to each service name is an icon telling you what kind of
thing this service is. Table 6-1 shows the icons and what they mean. To use a
service, just double-click its entry in the list.

In the lower-right corner of the window is the keyword for this particular area.
See the sidebar “Psst — what’s the keyword?” later in this chapter for more
about these useful little thingies.

Along the bottom of the window are three utility buttons. Every channel service
window has the same three buttons as shown here: AOL Channels, Member
Services, and Find. AOL Channels takes you back to the Channels window (no
surprises there). Member Services sends you into the free Member Services
window. The Find button brings up America Online’s Find-it-all-here window.
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Alphabetical service listing —

Life, Styles & Interests

AARP Online
. 3 Alumni Hall
L B3 American Woodworker
" . ; ‘ ASTRONET
Figure §-3. A Astronomy Ciub
The Life, o £3 Aviation Forum
Styles &
Interests
window, a
sample of
life in the "
- icbh 14182
Main bhy (entig
Services 27 teniting e
lane. TR
]

[
Utility buttons Keyword

Finally, large, colorful icon buttons designate individual services or service
groups (depending on exactly which channel you're in). These buttons point you
toward the biggest and best individual services (particularly in the Newsstand)
or groups of related services (in Entertainment or Life, Styles & Interests).

Table 6-1 Service Icons

Icon Name Meaning

&3 Fite Folder This item leads to an individual service window.

0 Document This is a document explaining something about the service.
Open Book This is a searchable database {mostly in the Reference

section).
EP Disks This is a software library.
S5~ Special This can be just about anything — it defies description.

Every now and then when you call up a particular channel, America Online
tosses in a free bonus: a Spotlight window. Figure 6-4 shows a Spotlight window
caught in the midst of accosting an innocent America Online member. These
windows announce special events, new services, and other fascinating things.
Whenever one pops up on your screen, gather your wits about you and see
what the window is crowing about.
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Rews § Scores

L]
Figure 6-4:
Cool stuffis
happening
tonight in
the Sports

area. G5 Sparis Bomn
L]

Individual services

The digital foot soldiers of America Online are the individual services. Hun-
dreds of them are out there and each one has its very own interface window.
Some of the windows have lots of artwork and feature buttons ( like Figure 6-5).
Others are plain to the point of being utilitarian (see Figure 6-6 for a to-the-point
example). Both do basically the same things, except the fancy ones do it with
more panache.
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 Service areas Feature and function buttons

Eﬁ% Helping You Take Komand of Your Komputer =———1

B The Hew Komputer Elinict :
About The Komputer Klinic Staff
L3 Interesting Bits

£3 Top Answers to Common Question
£ Komputer Tips, Tricks & Nare

Got a Computer question?
Answers are just keystrokes
awey from help and the end of

your computer traumasz!

Talk radio pereonality
Barry Young snd "The Amazing

—Keyword: Komsndo ) “ o
[ T Weekly Chat & Confevence: Hr. Scxenct;(tm), u‘m'e'vel lite's
Thursdays, 9:00 P EST everydoy mysteries.
Figure 6-5;
A truly fancy \7 i%i
service M : :
. Contests & Kim's Komputer Yhat's the Search the Software
WmeW. Conferences Products Deal? Klinic Libraries
| E
Keyword
Service areas
Radius, Inc.
B Welcome - impoartant Infa
£3 Product Information
£a Press Releases
£ Cinepak Developer Support
£3 "Top Ten" Q &A
E— 1 Message Boards
& Software Library
Figure 6-6:
The
essence of Fy
service
simplicity.
R

A fancy service window always contains some feature and function buttons.
These graphic buttons lead you to special parts of the service, help you search
the service's archives, or otherwise do something truly fun for you. Read the
button descriptions carefully — don'’t rely too much on the picture to tell you
what the button does.

Somewhere on the window (sorry [ can’t be more specific — it migrates all over

the place) is the service's keyword. If you're not familiar with keywords, you
should be. Look in the preceding sidebar for more information.
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Last on the tour is the list of service areas, the only item that both kinds of
service windows contain. The list is in whatever order the service feels like
using (in other words, it's probably not alphabetical). To get into an area,
double-click the entry in this list.

3 E » In addition to the icons in Table 6-1, individual services add two more: the

5l bulletin board icon, which looks like a piece of paper tacked to the wall
with a push pin, and the meeting room icon, which looks like two people
talking. (Ingenious, aren’t they?)

1 Don’t expect every service to look just like every other service. Some are
very plain; others are quite fancy. Just relax and go with the flow — you're
doing fine.

Windows on a Discussion

You can't turn around on America Online without running into a discussion.
Whether you want to write about music, mayhem, or something in between
(like the Grateful Dead and their traveling entourage), America Online has a
place for you somewhere.

After you find your place, the next step is joining the fray. Discussions are
organized into folders. Each topic has its own folder. All the messages on one
topic are entered (or posted) in the appropriate folder. Along the way, you deal
with two kinds of windows: folder windows (which help keep the whole sordid
thing organized) and message windows (the meat of the matter).

Discussion folders

Before you can join a discussion, you have to find one. Cruise around in your
favorite services and look for an item with a bulletin board icon (in the service
list) or button (on a fancy service window) — those are strong clues that yo:i've
found a discussion area. ’

After you find a place for your talk to call home, the first window you see gives
you an overview of everything in the discussion area (see Figure 6-7). Not every
discussion area has a window like this, so don’t panic if instead you end up with
something that looks more like Figure 6-8. If that’s the case, skip ahead to the
discussion about that window.

At the top of the window is general information about the discussion. It gives
you some statistics about this corner of the world — the number of folders
(topics) in the area, the total number of messages, and when the last message
was posted. This stuff’s nice to know but doesn’t really do much except show
how active the discussion is.
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s Foiders: Messages: LastMessage:

50 8935 6124196 — General information

Recall the early days of teievision and motion pictures. Relate with _|

others who grew up watching the same shows you did. — Description
EE—

Figure 6-7:
The first
stopina : !

discussion Browse Folders Find New Find Since... Help & nfo

Feature buttons

area. § Date of Last Visit: This area is new to you Last visit
E——

A brief description of what people talk about here is in the middle of the window.
Think of it like those little signs out on the highway that say “Welcome to Gnaw
Bone, population 117" — they don’t give you a lot of information, but at least
you know if you're going in the right direction.

Below the description are the feature buttons. You usually see four of them:
Browse Folders, Find New, Find Since. . . , and Help Info. Browse Folders takes
you to the folder list so you can find a topic and begin exercising your right to
an online opinion (more about that a little later). Find New lists all the folders
with messages posted since your last visit. Find Since. . . lets you see messages
that were created in the last few days (you specify the exact number of days).
Help & Info, of course, gives you general help and information. No surprises
there.

The Date of Last Visit area tells when you last came by and browsed around the
area. (If it says This area is new to you, this is your first time here.) This
area is handy when you’re monitoring discussions all over America Online and
then start to lose track of trivial details like when you were here last (and where
here is, for that matter).

Your next stop is a window like Figure 6-8. These are the topic folders them-
selves — you're almost in the discussion!

Like the other window, this one begins with a description of what kind of
discussion goes on here. If the description isn’t quite what you expected, you
may be in the wrong place. In that case, close the window and look elsewhere.

The center of the window contains the discussion folder list. If more topics are
covered than can fit in the window (a common occurrence in America Online),
a scroll bar appears on the right side of the list to help you see everything. When
you find an interesting topic, double-click its entry to open the folder and show
the first discussion message window (covered in the next section), or single-
click and use one of the feature buttons to get more information about the folder.
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Discussion folder list

Collectible Card Games N -Z

) Discuss Collectible Card Garnes Hints and Tips here.
=

Topics: 30

Total Posts: 7018 Created

Latest

£a Netrunner Discussion
Starwars ©CG Discussian

£ Star Wars CCG: StratfTips

150 4/28/36  6/24/96 |
360 10/5195  Bi24/958
3112136  6/24/96

{2 StarWars CCG: Q8A Falder 148 3i12/96 b/24/96
£3 X-Files Discussian 34 1/23/96 5/31/96
£ Top of the Order 25 1/23/96 524/96

Date of Last Visit: 96-06-24 18:46:42 EDT

% i =

Create Topic

Find Since... Help & info

Read 1st Find New

Message

List
Messages

Feature buttons

The feature buttons along the bottom of the window let you do all sorts of
fascinating things. List Messages does the same thing as double-clicking the
folder name: It puts you in the discussion message window (which is covered at
length in the next section). Read Ist Message displays the very first message in
the folder, which usually explains the folder’s existence. Find New and Find
Since. . . work just like they do in the other window, except here they display
only matching messages from whichever folder you highlighted (so click the
folder you're interested in before clicking Find New or Find Since. . .). Create
Topic is your ticket to making a new folder dedicated to whatever you jolly well
want (is that ultimate power or what?). Finally, the ever-present Help & Info
button offers its two cents’ worth.

g 1 Don’t fret if you click Read 1st Message and America Online replies with a
I terse message saying This message is no longer available.That
just means that the message was posted so long ago that it was erased to
make room for new ones. Remember: Old messages never die — they just
scroll off the system.

1~ After your first visit to a folder, save time by using the Find New and Find
. Since. . . buttons. That way, you don’t have to wade through everything
you've already read while the online clock keeps ticking your dollars away.
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Discussion messages

Now that you have an online home for your thoughts, you're ready to see what
everyone else has to say. One way or another (usually by double-clicking an
entry in the discussion folders window), you're looking at the messages in a
particular folder (see Figure 6-9). America Online always shows you the oldest
messages first, probably in an effort to keep you online longer. (Did I say that?)

Description Last visit Message list

Star Wars CCG: Discussion

\» Decipher, Inc.
*
Messages: 360 Author Responses Latest
White Borders JKeily 80 1 529196
Millenium Falcon Lo0is1846893 1 5431196
Surprise Character AWHunley 0 6/2/96 —
~*Player Needed™ YOUNGT71 3 6/12i96
Decipher Web Site DivChamp93 0 6/5/96
IEEE— Unlimited Editton SRodg15586 2 624796
. Needed Kenner figs for CCG AckbarJMD 8] 615196
Figure 6-9: Date of Last Visit 96-06-13 11:56:58 EDT
Browsing
through the
messages Read List ~Post Find New. Find Since
H Message Responses Message
in the Star L i
Wars folder.
N

Feature buttons

Like every other window dealing with the discussion areas, this window starts
with a brief (often very briet) description of the topic at hand. So much for that.

In the middle of the screen is the message list, displaying the first 40 or so
messages. It displays (starting from the left) the message subject, the author’s
screen name, the number of responses, and when the last response was posted.
To see a message, double-click its entry in this list, or click it once and then
click Read Message.

Below the message list are the time and date of your last visit here. Use this
feature to remind yourself when you were where and what on Earth you've
been doing since then.
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Depending on the number of messages in the folder, either two or three feature
buttons are at the bottom of the window. Read Message does just what it says:
displays the highlighted message so you can read it. List Responses shows you a
list of the replies and lets you choose which ones you see. Post Message is your
digital paper and pencil, available for sharing your comments with the world.
The Find New and Find Since buttons work the same way they do in the previ-
ous windows. The More button gets the award for “button that disappears most
often,” because it only appears if more messages are available than you have in
your list. If you get to the bottom of the message list and the More button is
available, click it to see what'’s out there.

When you double-click a message (or highlight one and click the Read Message

button), the message appears in a window like Figure 6-10. After all that effort,
this window is surprisingly easy to use.

Message text

_Ebllectible Card Games N-Z

IE—
Figure 6-10;
Finally —a

message!

L]

Subj: Unlimited Edition
Date: 96-06-05 16:31:15 EDT
From: SRodg10596

Posted on: America Online

Does any one know when unlimited is coming out or if it is out??? Also does any one know
when A NEW HOPE is coming out??? Please post it or e-mail me. I'd rather you email me.

-Shawn

e

s A58
Previous

Read 1st

Add Post Nesxt
Message Response Responses Message Response Message

L |

Feature buttons

The message text dominates the windows (as it should — after all, that’s why
you came). Every America Online message begins with a brief header giving the
message’s vital statistics: subject, posting date, author, and a reminder that
you're reading this message in America Online. The message itself follows.

Along the bottom are a whole raft of feature buttons that do just about anything
your heart desires. Previous Message and Next Message move you through
everything in the topic folder. Read Ist Response brings up a screen for brows-
ing all the replies to this particular message. List Responses does just what it
does in the previous window. Use Post Response to add your thoughts to this
group (or thread) of messages. Add Message starts a new message thread
(instead of adding a reply to someone else’s message).
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§ 1+~ lf you click Read 1st Response, a new window appears. At that point, you're
i reading only responses to the original message, not the main messages in
the folder. To get back to the items in the message folder, you have to close
the reply window (on a Macintosh, click the box in the upper-left corner of
the window; for Windows 3.1, doubleclick in the upper-left corner of the
window; and for Windows 95, click the X box in the upper-right corner of
the window).

v Some discussion area windows can’t handle the reply thing and have only
[ three feature buttons at the bottom: Previous Message, Add Message, and
Next Message. No, | don’t know why — that’s just how it is.

Fiddling with Files

In addition to everything else that America Online is, it’s also an amazing
electronic library of programs, pictures, fonts, sounds, and just about anything
else that can survive on a computer disk ( probably including some forms of
alien life). All this stuff is waiting patiently in software libraries all over America
Online, anxious for you to discover it and take home a copy for yourself.

Almost every service in America Online has a software library of some kind.
Every library offers something a little different, depending on the needs and
such of the service that sponsors it. Explore your favorite services and see what
amazing files you can find therein.

When you find alibrary and go in, you're usually faced with something like
Figure 6-11. This is the main catalog window of an online library. This particular
screen is from the Windows Software Libraries area (keyword Windows).

Taking the bulk of the window’s space is the file listing. The listing shows a brief
description of the file, the date it was uploaded, the number of times it has been
downloaded, and the date of the last download — all in all, a pretty informative
display. You can find information about downloading files later in this chapter.

Along the bottom are the ever-popular feature buttons. Get Description coughs
up all the details on the highlighted file. Download Now tells America Online
that you want the file sent to your computer right now (and that it’s not open
for discussion). Download Later inserts information about this file into the
Download Manager, your handy-dandy file assistant. The Upload File button
tells America Online to listen carefully because you're sending in a file of your
own. Finally, More is available if too many titles are available to list on your
screen (a perpetual problem).
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File listing
m—— = — MacintoshTop20! =———— —®@
Upld Subject Cnt Dnid
B 06/06 Folder lcon Maoker 1.2. . Utilities 216 06/12
B 06/06 SoundMaster 1.8.1......Utilities 234 06/12
8 05/15 ***  April 1995 Top Files *** 545 D6/11
B 05/14 Phonebook 101........... Business 915 06/12
B 05/14 2ipCodes.......ccovvuun Business 911 £6/12
B 05/14 Beautiful lnk (TT)....... Desktop 2844 06/12
[R— B8 05/14 Freebats Regular (TT)....Desktop 971 06/12
) B 05/14 Cool MacsBug Tricks...Developers 991 06/12
Figure 6-11: | {8 05/14 PowerLisp 1.2......... Developers 170 06/11
All this and 8 05/14 Eng/Spanish Stories....Education 397 06/12
more can I Get Description |J { Download Now | (Bownload Later]
be yours. | ]
E——— i [
Feature buttons
Seeing a file's name rarely provides you with enough information to decide
whether you want it, so I recommend looking at the file details. To get the
details of a file, double-click the file’s name in the list, or single-click the file
entry to highlight its name and then click Get Description. Regardless of which
one you do, a new window pops up (see Figure 6-12 for an example).
This simple window contains the file description, including the exact filename,
file size, approximate time it would take to download to your computer, and
what you need to use the file. After you wade through all that stuff, you find a
nice description of the file itself.
=C] Beautiful Ink (TT)......Desktop E==————u
Subj: Beautiful Ink (TT).....Desktop  May 14, 1995
Fram: AFL JohnT
File: Beautiful Ink (TT).sit (42633 bytes}
DL time (14400 baud): < 1 minute
Download count: 2836
Uploaded on: America Oniine
AUTHOR:  HMichelle Dixon
EQUIPMENT: Any Mac/System 7 or System 6.005+ & TT Extension
NEEDS:  Stuffit/A0L 2.X
A
Figure 6-12:
Looking ata
o, . Downioad Now Download Later Comment To Staff
file's details. L J { i
L f [ﬁ'
T
Download buttons Question button

File description
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lf you decide that you like the file, you have two download buttons anxious to
help. Download Now pulls the file down right away. Download Later makes a
note in the Download Manager about this particular file.

If you need more information about the file or have a question about it for the
service’s library stalff, click the Comment/To Staff question button. Explain your
question or concern in the message dialog box that pops up, and then click
Send. The staff replies to you as soon as possible, but allow at least 24 hours
before you get worried.

E v~ Pay close attention to the Needs section of the file description. This section
tells you what kind of hardware and software you need to use the file (very
important information, particularly for programs and graphics files).

» Some libraries (like the Windows library in this example) are so incredibly
large that an extra window (or two) lists the different library areas you can
choose from. If you bump into something like that, just double-click

interesting library names until you bring up a window like that shown in
Figure 6-11.

+* You can’t upload files everywhere in America Online. If the Upload File
. button is dimmed (as it appears in Figure 6-11), you must contribute your
file elsewhere — this library isn’t accepting donations.

+~ For more information about uploading and (more important) downloading
files, see Chapter 8.

Document Window's

Whenever you need to read something, America Online puts it into a simple
document window. And I do mean simple. Figure 6-13 gives you an idea of what
I'm talking about. Look at that window — no special buttons, no funky icons,
nothing but plain text.

That’s okay, though. After all, it’s just a document.

These windows do have a secret power: You can save whatever you see as

a text file on your computer. When you’re looking at the window, choose
Filec>Save and then type a filename. All the text is saved for your offline viewing
(and reviewing) pleasure.
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.|
Figure 6-13:
A simple
window
with a
simple
message.
|

" WELCOME TO THE WRITER'S CLUB!

WELCOME TO THE WRITER'S CLUB!

Welcome to the ‘Writer's Club! Fm your Club host, THopeB. ) am a faunder of the |
Fiction workshop, enjoy reading mysteries, writing and editing.

Phylwriter is the Writer's Club Assistant and will take care of the Writer's Club
libraries as well as answering any technical questions. Please e-mail him with
any file, library or technical Writer's Club questions.

You'll find information, conversation and motivation in the Whriter's Club for any
type of writing. There are message boards in the Writer's Club Message Center
for fiction, nonfiction, romance, screenwriting/playwriting, poetry,
editingfindexingfranslating, writing and illustrating for children, technical wnting,
and the National Writers Union as well as a "Club News" message board.

Chats, Meeting Rooms, and
Online Auditoriums

Meeting people live and digitally in person is one of America Online’s truly
amazing features. In addition to the chat rooms (where freewheeling discussion
is the rule of the day), you find special club meeting rooms and big, huge, really
large online auditoriums for formal lectures and special presentations.

All the rooms work basically the same way. Figure 6-14 shows a normal Win-
dows chat room screen (if any chat room can be called normal). The screens
for meeting places and the large theaters use almost the same layout.

Because a chat room wouldn’t be the same without all the people infest . . . er,
um, attending it, a scrolling window in the upper-right corner contains the
screen name list. This list has the screen names of everyone currently in the
room. If a person isn’t listed, she’s not here.

The middle of the window is the ever-scrolling chat text, the lines of conversa-
tion in this zany, electronic room. You have to watch carefully because the
conversation doesn’t ever stop.

Along the bottom of the screen is an open box. This is the outgoing message
area. You type a message here, and then press Enter or click Send to share it
with the chat group. After a moment, your message appears on the whole chat
group’s screens. (Yes, it’s a little intimidating the first few times.)
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Screen name list

Special interests - Artists Cafe

T ListRooms

; “ha silver eople Hefe: 8

GISKARD27: | do graphics, llustration & photography for a
: living ,
PatricaP: tove to listen to you all...l am in banking - boring |
GISKARD27: { work in oils for my creative fulfillment

Tlrrera
EifBot
KidNegativ

4 Combray: spread sheets do not have to be boring Pat Combray
Creina: Hmm....sounds nice...as | wark graphics, phot - S
and illustration as my creative fulfillment | GISKARD27
sy | PatricaP: mine are not a thrill....my thrill is a graph or two 3] LPatricaP 2+
) . B Creina: we seem to be miror images : RO B
Flgure6-14. | Combray: I write, | draw, & | do spread sheets Pat D Sivate Poom
weird, it's a { — ' — ' ' l
chat room.
L]
Outgoing message area Chat text

Across the top are the chat room control buttons. List Rooms is your ticket to
move from room to room. Member Directory opens up the Member Directory
window, where you can find out interesting things about the other people in the
chat room (provided that they filled out an online profile — more about that
back in Chapter 3). AOL Live! sends you to the information kiosk for America
Online’s big interactive presentation halls. The Plaza offers links to other
interactive areas of the system and also throws in some help and feedback
buttons for you as well.

In the bottom-right corner of the window are several other control buttons.
Private Room lets you jump directly into a private chat room within the People
Connection, provided that you know the room’s name. Notify AOL is your panic
button to report problems in a chat room (which, unfortunately, happen from
time to time). Prefs sets the Chat room preferences, just like clicking the Chat
preferences button in the Preferences window (choose Members=Preferences
from the main menu for that). And finally, the big question mark in the corner
brings up the People Connection help window, a great place to look for answers
to your most esoteric chatting questions.

+~ To get into a chat room, click the Chat Room button on the Toolbar.

+ Club meeting rooms are sprinkled everywhere in America Online. Browse
through your favorite channel and see what you can find.
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v If the large theaters are more your thing, go there directly with keyword
AOL Live.

1 For more about the whole People Connection thing (trust me — there’s a
lot more), see Chapter 25.
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Chapter 7

Communicating with Everyone
(One Way or Another)
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In This Chapter

& Keeping your address book

¥ E-mailing in 33 flavors

# Reading and replying to incoming mail

g Saving time and money with FlashSessions
® Sending quick notes with Instant Messages
g Chatting over digital coffee

B 3 688D DELOEE BB 0RO LEETEREECRTEEREEGDREREDSET R

n the world of America Online, the word communicating means lots of things.

Some are kinda obvious, like sending an e-mail message or dropping an Instant
Message on a person’s head. But how about sending a fax? Or sending an e-mail
by real mail to your cousin in Arkansas who still thinks computers are “a fad™?

Surprise, surprise — America Online can do that and a few other tricks besides.
This chapter tells you all about electronic communication from America
Online’s point of view. | think you’ll like what it says.

Catching People with Your Address Book

You start meeting people right away in America Online. Join a discussion, drop
in for a chat, or attend a live presentation, and suddenly you have online
friends. You also have a problem: How do you keep track of your newfound
social club’s screen names?

Time to invoke the familiar refrain, “Luckily, the America Online programmers

thought of that.” Yup, those clever folks from Virginia have done it again. Step
right this way and meet the America Online Address Book (see Figure 7-1).
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|
Figure 7-1:
The built-in
Address
Book.

Address Book

BX3- RDI
Wrynnet - RDI
Bill & Dawn
Rabin and Eric

John - gamer, 1830

Ayla-- accountant, chat
Nikki - Toastmasters F

As address books go, this one’s pretty simple. It can handle entries for single
screen names or big, honking mailing lists (assuming that you're into large,
noisy name collections). Each entry consists of two things: a brief description
and one or more screen names. It’s easy to use, too, but that’s what you find
out in the next section (and I don’t want to spoil the surprise).

Adding Address Book entries

Before you can use the Address Book, though, you have to put something in it.
With that thought in mind, here’s how to add new Address Book items:

1. Open the Address Book by choosing Mail=>Edit Address Book or click-
ing the Address Book button on a new mail message.

The Address Book window pops up, all bright and cheery.
2. Click Create.

Ablank Address Group dialog box appears. Even though the instructions in
the dialog box are geared toward mailing lists, you can still use it for single-
person addresses (goodness knows that’s what most of my entries are).

3. Type a description for this entry in the Group Name box.

The description can be anything you want — anything at all. Letters,
numbers, and just about everything else on the keyboard are legal in the
description, so have fun with it.

Be creative with your descriptions. If it’s an entry for a new acquaintance,
put something in the description to remind yourself of how or where you
met. For instance, [ include the word chat for everyone I meet in a chat
room. Because the Address Book doesn’t have a long description area, you
have to make the best of what you're given.
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4. Press Tab to move the blinking cursor into the Screen Names box.
Carefully type the screen name — watch your spelling!

Capitalization doesn’t count here, so you can enter my screen name any
way you want (JKaufeld, Jkaufeld, jkaufeld, or jKaUfEID all count), and
America Online figures out that you mean me. At this point, your screen
should look something like Figure 7-2.

5. If you're creating a group entry (for a mailing list), press Enter and
type another screen name. Repeat the process for the rest of the
screen names.

You can put a lot of people in a group — and send a mail message to all of
them at once. Pretty cool, eh?

6. Click OK to save the new entry. Click Cancel if you were just kidding
and wouldn’t send mail to this person if your life depended on it.

The Address Group window vanishes, and you're back at the Address
Book window.

Address Group

Group Name (e.g. "Associates™)

Jenny - writer's group chat j
Screen Names (e.g. "Jenny C")

jenny0511

Deleting Address Book entries

So now you have an Address Book full of stuff and it's getting unwieldy — plus
you can’t remember who half these people are. No problem — that’s what the
Delete button is for. Deleting is a quick and painless process. Here'’s how to do it:

1. Start the Address Book (if you haven’t done that already) by choosing
Mail=>Edit Address Book.

Of course, you can also click the Address Book button in the e-mail
message window if that's where you happen to be when the inspiration hits.
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2. Scroll through the Address Book list until you find the entry that you
want to dispose of.

3. Click the description once to highlight it and then click Delete.

4. When the software wrings its little hands and asks if you're serious
about this deletion business, click Yes.

If you just wanted to see what the Delete button did and how the program
would react when you used it, click No. Apologize to your software for
even thinking of tricking it like that. Shame on you.

Changing Address Book entries

Since things change at a ridiculous pace, particularly in the online world,
keeping your Address Book up-to-date is important. That’s why your Address
Book has a Modify button.

Here’s the scoop on changing an existing Address Book entry:

1. Open the Address Book (if it’s still closed) by choosing Mail<>Edit
Address Book from the menu bar or by clicking the Address Book
button in a brand new mail message.

2. Click once on the entry you need to change.
This highlights the entry.
3. Click Modify.

The Address Group window comes back. It’s the same window you used to
create the entry originally.

4. Make your changes to the Description and Screen Name List.

Everything is open for change, so make whatever modifications you must.
If you're working with a list, you can freely add and delete screen names as
you desire.

All the standard Macintosh and Windows text editing tricks work here:
highlight, delete, insert, click and drag, and the rest. Edit (and play) as
much as you want.

5. After you're done with the changes and are pleased as punch with them,
click OK to save your work. Click Cancel to abandon your carefully
wrought editing and keep the record the way it was before.

Whichever button you click, the Address Group dialog box vanishes, and
you're back to the Address Book screen.
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":"Flﬂdln ‘;people llke Vou

/ ectory «
Search the Member Dtrectory op‘non andtypein
somethmg that you\hke in people: a hobby you,

E-Mailing the World, One
Mailbox at a Time

In my humble opinion, e-mail is the communications medium of the '90s. It
seems like everybody has an e-mail account at the office, at home, or both.
Messages travel quickly, arrive safely, and are rarely delayed by any of the
obscure national holidays that shut down the post office every time you're
waiting for an important letter.

Through America Online, you can send e-mail to virtually anyone on the planet.
(No, I'm not kidding — I'm not even exaggerating.) One way or another, one
medium or another, your e-mail message flies on the wings of technology from
your online mailbox to its destination. And that destination can be another
America Online e-mail box, an Internet mail address, any fax machine in the
world, or even a letter in the postal mail!
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This section tells you how it’s done. But enough talk — time to hit the keyboard
and start e-mailing!

v Don’t sign on to America Online and then begin writing a long e-mail
message. Instead, write the message offline (when you’re not paying the
computers in Virginia to watch you type) and use a FlashSession to send it.
All the details about FlashSessions are later in this chapter in the section
“Doing E-Mail the Cheap Way.”

v Please don’t type your messages in one huge paragraph. That makes them
l  really hard to read. Press Return a couple of times every now and then to
break the behemoth into smaller, more digestible chunks.

Q*'* SAV50
()
=

§ 1”7 Writing e-mail messages is a little different than any other kind of commu-
L nication. Good e-mail takes a bit of care, the right words, and a willingness
to type until the message is clear. If you're new to e-mail, don’t panic —1
was new once, too. That’s why Chapter 4 in this book exists. If you haven’t
read that chapter yet, take a minute to go through it. Future e-mail recipi-
ents will thank you.

f 1”7 America Online automatically keeps copies of all your outgoing mail for
¢ about 30 days. To review these old messages, choose Mail>Check Mail
You've Sent from the menu bar.

Sending e-mail to an America Online subscriber

Because you're surrounded by these people every time you sign on, odds are
that you'll send at least a few messages to other America Online subscribers.
Because that’s what the mail system was designed for in the first place, doing
so is pretty easy. The mail system also has some special features (like unsend)
that are only available when you're writing to another America Online person.
(If that sounds interesting, check out the “Stupid mail tricks” sidebar for more
information.)

Before you can send e-mail to someone, you must know the person’s screen
name. Upper and lowercase doesn’t matter, but spelling does. For example, you
could enter my screen name as JKaufeld or jkaufeld and the mail would still go
through. But if you try JKaufield, don’t expect a reply — at least not from me.

To send a mail message, follow these steps:

1. If you're signed on to America Online, sign off now.

Unless you're a really good typist, need to send a very short message, or
just don’t care how high your America Online bill is this month, don’t
compose messages online. Doing so is a serious money-waster.

2. Create a new mail message by clicking the Compose Mail button on the
Toolbar or by pressing 38+M on the Macintosh or Ctrl+M in Windows.

A blank e-mail window mystically appears on-screen.
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3. Type the recipient’s screen name.

To send the same message to more than one screen name, keep typing
screen names into the To box and separate them with commas (see
Figure 7-3).

:Composé Mailm

Figure 7-3:
The
message
begins.
L]

If the screen name is in your Address Book, click the Address Book button
and then double-click the entry for that person or group. When you're
done choosing addresses, click OK to make the Address Book go away.

4. Press Tab to move the blinking cursor into the CC: box. Enter the screen
names of people who should get a copy of the message but should not
be listed as a main recipient.

Odds are, you won’t ever use the CC feature, but [ had to mention it
anyway. lt's just the kind of guy I am.

Don't bother putting your own screen name in the CC area. You automati-
cally get a copy of every message you send. Choose Mail<>Check Mail
You've Sent to see them. Copies are only kept for about 30 days, so if the
message is really important, print it out and keep the paper.

5. Press Tab again to put the cursor in the Subject box. Type a brief (32
characters or less) description of the message.

Write your message subjects so the other person can tell what it's about
right away. If the message is really important, write IMPORTANT! as the
subject to get the reader’s attention. Your reader may have 35 other
messages to look at, so make the subject descriptive to help her figure out
which one to check first.
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6. Press Tab once more to get into the message area in the bottom of the
screen. Type your message text in here.

Enter the text as if you're using a word processor (for example, don't hit
the Return key at the end of every line). Press Return a couple times every
now and then to break the message into easy-to-read paragraphs (see
Figure 7-4).

Compose Mail

* {JoPoozie, Nikki1950 .
Send’ ‘
Subject: {Evem announcement J

File:

Send

Later

T — o & Nikki -
Figure 7-4:
Press
Return a
couple

of times
to keep
the body
readable.

=i lJohn
Attach

Book

Here's the sample text for my event announcement. Let me know what you think.

answers your questions in AQL Live !
Monthly event solves problems and has a good time doing 1.

Are you new to America Online? Are yau an expert looking for a few new tricks? Are

AOL for Dummies author

To really jazz up your messages, add some cool formatting or live links to
your favorite Web sites. For all the details, flip ahead to “E-Mailing with
Panache” later in this chapter.

7. If you're sending a file, click Attach. In the Attach File dialog box, find
the file you want to send and double-click it (or highlight it and click
OK, as shown in Figure 7-5).

The Attach File dialog box vanishes. The name of the attached file appears
above the message text in the Compose Mail window.

If you change your mind about attaching the file, click the Detach button
(it’s where the Attach button used to be — what a strange coincidence).

8. If you're signed on to America Online, click Send to mail the message.
If you aren’t signed on right now (good for you!), minimize the mail
window (click the down arrow in the window’s upper-right corner) and
then sign on. When you’re in, doublelick the mail message icon (it’s
probably in the lower-left cormer of the screen) and then click Send.

“Doing E-Mail the Cheap Way,” later in this chapter, explains the Send
Later button and why it’s the coolest thing since, um, well, they started

tracking cool stuff.
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Attach File

File Name: Directones:
l;e.ipg (VAN

command.com [ s A

m“‘ig-‘”‘ £ aodfigs
: £ aol25i
pgp -info.txt ] aol30a

setup.log 3 bat
stocks. txt

£ cardsoft
waste. txt 3 cardview

List Files of Type: Drives:

[All Fites ~.7) c

SE—— AUL Tor ! ,umm|es—fﬁ-__—?u or .
Figure 7-5: answers your questions in AQL Live !
. ’ Address d 3 T
Attaching a oy Monthly event solves problems and has a good time doing #
file to the Are you new to America Online? Are you an expert looking for a few new tricks? Are
message. ut nating riabt fion Yo bowus waie soathos wosic .

mers threw i
. make;your mi

and the time and date it was read. If it's still in too late — Unsend won twork how
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Sending Internet e-mail

Using America Online as your e-mail link to the Internet is really easy. In fact,
you can pretend you're just sending mail to another America Online user,
except the person has a very weird screen name.

To send mail through the Internet, you go through the same steps you did to
send a message to another America Online user. There are only two differences:
how to address the message and how to attach files.

The key to sending Internet e-mail is getting the address right. Most

Internet mail addresses look a little bizarre to uninitiated human eyes, but
that’s not an issue — in a moment, you’ll be initiated. Instead of being simple,
straightforward things like JKaufeld, Internet mail addresses look like
71303.3713@compuserve.com. The part on the left of the @ is the person’s ID
(the Internet term for screen name). The other half is the address of the
computer they use for e-mail (in this case, its one of those other online ser-
vices). Put the whole thing together, and you get an Internet mail address.

These addresses get really complicated sometimes (the one for a friend of mine
in France contains about 50 letters, numbers, and various punctuation sym-
bols). One way to get the address just right is to have your friend send a mes-
sage to you first. When it arrives, carefully copy the address into your Address
Book. Now you don’t have to worry about the gory, technical address stuff any-
more — just pick the entry from your Address Book and you're done.

Because you’re on America Online, you have an Internet e-mail address too; it’s
your screen name with @ao1 . com glued onto the end. If your screen name is
Have Fun, your Internet e-mail address is havefun@aol . com. The Internet

address doesn'’t use the space or the capital letters in the screen name — it just
ignores them.

Here’s a brief recap of the steps to send an Internet e-mail message:
1. To start a new mail message, click the Compose Mail button on the
Toolbar or press 38+M on the Macintosh or Ctrl+M in Windows.
A new e-mail window pops onto the screen.

If you're signed on to America Online, sign off before writing your message.
2. Type the highly technical Internet mail address.

If you type the address by hand, go slowly and be very careful. Double-
check the address when you're done. As before, if you want to send the
message to more than one person, keep adding addresses (either Internet
addresses or America Online screen names — you can freely mix and
match the two), separating them with commas.
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Whenever possible, use your Address Book. Click the Address Book
button and then double-click the entry for that person or group. After you
finish, click OK to continue working on the message.

3. Press Tab to get into the CC: box. Enter the mail addresses of anyone
who needs a copy of this message.

4. Press Tab to move the blinking cursor into the Subject area. Type a
descriptive subject for the message.

You have only 32 characters to use for the subject, so use them well.

5. Press Tab again to move the cursor into the message area itself. Type
your message.

Feel free to spruce up your message with the new e-mail formatting tools
or drop in some links to your favorite Web sites. Don’t send links to areas
inside America Online because your friends can’t access them. For more
about these new tools, see “E-Mailing with Panache” later in this chapter.

6. To send a document, program, graphic, or other binary file with your
message, click Attach. When the Attach File dialog box pops up, find the
file you want to send and double-click the name,

If this step looks familiar, that’s because it is. Thanks to the ever-vigilant
programmers at America Online, sending a file through the Internet (which
used to be on par with pushing a hardback copy of Gone with the Wind
through the eye of a needle) is just like sending a file to another America
Online member. In short, it’s easy. America Online performs all the
complex book-through-the-needle’s-eye gyrations behind the scenes — you
don’t need to worry about them at all.

On the other end, the person receiving the file needs a mail program that
understands MIME (Multimedia Internet Mail Extensions) file attachments.
That shouldn’t be a problem, though, because MIME is quite popular on
the Internet. (You always suspected that the computer knew what those
hand gestures meant — now you know for sure.)

7. Minimize the message window (click the down arrow in the window’s
upper-right corner), and then sign on to America Online. After the
Welcome window appears, double-click the mail message’s icon (now
hanging around the lower-left side of the screen) and click Send.

The money-saving FlashSessions work with Internet e-mail, too, so look

ahead to “Doing E-Mail the Cheap Way” for more info about keeping your
mail bills low.

Faxing your e-mail

When is e-mail not e-mail? When it's a fax! Yes, you can fax your message
directly from America Online to whomever you want. Isn’t technology grand?
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To turn your mail into a fax, you need the recipient’s name and fax number. The
only limitation is that the name must be 20 characters or fewer. (Don’t pro-
grammers choose the silliest things to annoy you with?)

To create your communication masterpiece, go through the steps for an
Internet e-mail message. To address this as a fax message instead of Internet
mail, type the recipient’s name and fax number into the To area as follows:
name@fax-number. To send a fax to Paul Politano at 800-555-1212, for example,
you'd type Paul Politano@800-555-1212.

+~ Did | mention that this service isn’t free? No, unlike regular and Internet
e-mail, faxed e-mail costs money. As of this writing, faxing your mail
messages costs $2 per address. For instance, to send a fax message to one
person costs $2. To send the same message to five people costs $10. Given
those examples, how much wood would a woodchuck chuck if a wood-
chuck could chuck wood?

£ .~ Sorry about that last bit with the woodchuck. It’s very late and I'm a little loopy.
v+ Each fax page is 60 lines long, so keep an eye on the length of your message.

»* Remember, you're dealing with a fax machine here, so attached files are
. utterly out of the question. A fax machine won’t be able to make any sense
of your Microsoft Word document. Period.

¢ +~ Fax mail also doesn’t understand any of the e-mail formatting features.
Your fax messages come through in a plain, boring, fixed-pitch, left
justified, monospaced font. Yuck.

1+ To force a new page in your fax (instead of letting America Online decide on its
own), type >>> PAGE BREAK <<< wherever you want the break to be.

¥ You can send a single e-mail to fax addresses, Internet addresses, and
America Online screen names at the same time by putting all the ad-
dresses in the To: and CC: areas of your message. And you can store fax
addresses right alongside real e-mail addresses in your Address Book.

Strapping your note to a snail

Sit down — I have something ugly to share with you. Thanks to another unfortu-
nate case of technology run amok, it's possible to turn an e-mail message —
that fleet-of-foot electronic messenger you know and love — into (gasp!) a
regular piece of post office—delivered mail. It's an ugly thought, isn’t it?

To send your schizophrenic e-mail/postal mail message, follow the instructions
for sending Internet mail. In the To section, type the person’s name (maximum
of 33 characters) and then @usmail. To address a postal mail message to
Angelica Irwin, for example, you'd type Angelica Irwin@usmail. After you click
Send, America Online prompts you for the postal address details.
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€ + You can send the same message to more than one postal address at a

: time, but you can’t put a postal address and any kind of electronic address
(screen name, Internet ID, or fax number) together. To send the same
message both ways, you have to send it twice: once to all the electronic
people and then again to all the postal-mail folks.

B .~ Aswith faxing (and perhaps a little more so), neither text formatting or file
attachments work in a postal mail message. No surprises there.

v Sending paper mail costs money. You're charged $2.50 per address (at
£ least that was the cost when I wrote this).

E-Mailing with Panache

With the new America Online 3.0 software, e-mail and Instant Messages are
more powerful and flexible than ever. In addition to text, now your messages
can include live links to America Online areas and Web pages. And speaking of
text, the e-mail and Instant Messages systems now offer formatting controls
that make an everyday e-mail message look like a wonder of modern word
processing.

The following sections explain and explore these cool features. Check them out
and then bid boring messages a fond farewell!

Formatting for beauty

The new formatting buttons put you in charge of the text size, style, alignment,
and even color while creating Instant Messages. Figure 7-6 samples the possi-
bilities (but I hope your design skills are better than mine).

The buttons just above the message area control the formatting magic. They're
grouped into four sets by what they do. Here’s a quick rundown of the sets,
from left to right:

E 1 The first set handles text color. Change the color of the text itself with the
first button. Use the second to change the background color of the entire

message (not just a small portion of it). And remember that blue text on a
blue background doesn’t show up very well!

| 1~ The second set is in charge of text size. The three buttons, in order, choose
a smaller font, the normal font, and a larger font (but you probably figured
that out by the arrows).
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Figure 7-6:
g News Flash!
The
possibilities Thanks to America Online’s new e-mail system, mail messages neednt suffer from &
are endless formatting envy any more! With the new system, it's easy to change font size, type |
{as are the style, and even apply your choice of alignments:
prospects ; ] |Left aligned...
fora yT— ...Centered...
truly ugly Book ...and Right aligned
message). Life just doesnt get much better than this.
S——

# 1~ The third set does text formatting. These are the bold, italic, and underline
| buttons, as their labels demonstrate.

i 1~ The fourth set covers text alignment. Like any good word processor, the

¢ America Online e-mail system understands left, center, and right justifica-
tion, plus so-called newspaper justification, which is even on both sides.
This final option isn’t available in Instant Messages. (I guess they aren’t
smart enough to handle it.)

To format new text, click the buttons for your choices and start typing. The
software applies the formatting you chose to the text. To format text that’s
already in the message, click and drag the mouse across the text you want to
change, and then click the formatting buttons. Presto — the old text looks new!
Likewise, to remove some formatting, highlight the text in question and click off
the format options you don’t want.

Linking with ease

Almost every time | wander America Online or surf the Web for a while, I run
across something that’s really neat and worth sharing with my friends. In the
past, I laboriously copied the Internet address or America Online keyword into
a mail message — and sometimes messed it up in process. Today, though, |
never miss an address because I let the America Online software include the
link for me.

Before trying this, you need to understand how the Favorite Places area works
and what it does for you. If you're not familiar with Favorite Places, flip back to
Chapter 5 and find out more about them before attempting this link thing.
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When you want to include a keyword or Internet address link in an e-mail
message or Instant Message, follow these steps:

1. Add an entry for the America Online area cr Web page to your Favorite
Places list.

Doing so is easy — just look at the window and click the heart-in-a-page
icon in the window’s upper-right corner. When America Online asks
whether you want to add the window to your Favorite Places, click Yes.

2. Create a new mail message by choosing Mail->Compose Mail or pressing
Ctrl+M. Type the address and subject just like always, and then press
Tab to move the cursor into the message area.

So far, so good — you definitely have a mail message under construction.
Now the fun begins.

3. In the message area, type some kind of brief introduction to the link
you're sending, and then put the cursor exactly where you want to
insert the link. When you're ready, click the Favorite Places button on
the Toolbar.

The Favorite Places window appears, partially covering the e-mail window.

4. Aim the mouse pointer at the item'’s entry in Favorite Places, and then
click and drag the mouse pointer into the mail window (see Figure 7-7).

As you move the mouse, the arrow changes into an arrow holding a page.

5. When the pointer is hovering somewhere in the mail window, let up on
the mouse button.

Believe it or not, that makes the link. Pretty cool when technology works
with you, isn't it?

Feel free to add as many links as you want. You're also free to include both
Web addresses and America Online keyword areas in the same message.

6. Close the Favorite Places window, and then finish and send the mail
message.

The link shows as colored, underlined text. Although Figure 7-8 is in black
and white, you can probably pick out the link in the middle of the message.

By the way, if you want to try out the Evil Little Brother Excuse Generator for
yourself, it’'sat http://www.dtd.com/excuse. (Pity l can’t put links in my
book!)
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Figure 7-7:
The fink is
on its way.
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America Online
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nikki1950, hmteacher

Subject: [lnteresting new areal

| just found this really neat Web site - ] {hik nu'H love it. With the way | hit
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guaranteed
to be right.
T

Pass it along to your friends!
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Incoming Missive, Sir!
Sending mail is only half the fun. After you send something, you get a reply! If
you think a mailbox full of junk mail is a lift, just wait until you sign on to America

Online and find a message or two in your e-mail box. Someone out there cares!

] You have two ways to see your new mail. One is pretty obvious, as shown in

1 Figure 7-9, but the other isn't. The obvious one is the big picture button of a
jam-packed mailbox, emblazoned with the subtle notation You Have Mail.
(I have seen obuvious before, and it looked a lot like this.) The other clue is the
first button on the left of the Toolbar: an icon of a mailbox with some letters
hanging out. A single click on either the big picture or the Toolbar button
whisks you away to the New Mail window (see Figure 7-10).

Welcome, JKaufeld!

-Good thing you're
| using AOL 3.0 ar you
wouldn't find our new
search enyginel

He's Dead. He's

JKaufeld, Dangetous. He's
losing your Zombie Detective!
heir? Be

< your own
millionaire. atOnce Software:
What ifyou Experience the
DID win? convenience of our

T—— Download Store!

Figure 7-9: E : g TOP NEWS STORY:
| have mail ; R b N, Ireland Hotel
— yes! 1 & -~ PEOPLE E Bombed asViclence
’ . ONNECTION - 3¢ Spirals
e S ——
07514 JPKD Event announcement
EE—
Figure 7-10:
The
electronic REMINDER: AOL Staffwill never rif or billing information.
inbox. ‘ ] 1 ‘
—
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To read a message, either double-click the message in the New Mail window or
click it once and then click Read. Your message hops up into its own window.
To reply only to the person who sent the message, click Reply. To share your
comments with the sender and everyone else who received the message, click
Reply to All. To send a copy of the message to someone else (even out to the
Internet, but not to a fax or postal mail address), click Forward. After you're
done with the message, close the window by double-clicking in its upper-

left corner.

i 1~ To keep a message in your inbox after you read it, click the message in the
}  New Mail window once and then click Keep As New. Unread messages live
in your America Online inbox for 30 days after arriving. After that, they
turn into very small pumpkins and are shipped to your local grocery store,
never to be seen or heard from again.

I 1~ To save an important message, either print it out or save it as a text file in your
computer. To print, click the Print button (it looks like a page coming out
of a printer) on the Toolbar. To save it as a text file, choose File>Save As
from the main menu, type a filename for the information, and then click
OK. The text is now safe and sound on your disk drive.

»* Mail you've read hangs out in the Old Mail area for about seven days after
@ youfirstread it. To reread an old message, choose Mail>Check Mail
You've Read from the menu bar. Doing so brings up the Old Mail dialog
box. Double-click the message you want to read.

Doing E-Mail the Cheap Way

“Do you want to save money? Do you want to save time? Well, then, step right
up, folks, step right up and see the working man’s miracle, a technological time-
saver: the America Online FlashSession. This little beauty lets you type your
e-mails offline, that’s right, offline, folks, not signed on at all — step back, son,
you bother me. Save yourself some money right then and there. But it doesn’t
stop with that, no siree. It doesn’t want to save you a little money, folks; it wants
to save you a [ot. That's why it au-to-matically gets your new mail when it’s
sending the old stuif off. Read your messages, write your replies, and then tell
the little fellow to go do it all again. Every time you use it, you can’t help but
save money. Like money in the bank, folks, that’s a FlashSession for you.”

Okay, so America Online probably didn’t use old-time carnival barkers to
announce FlashSessions, but they sure could have. This technology is incred-
ibly useful, and it’s built right into your America Online access software.
There’s nothing else to buy; no salesperson will call.
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To work with FlashSessions, choose Maile>Set up FlashSessions from the menu
bar. The FlashSessions dialog box pops up in the middle of your screen, just
like Figure 7-11. For all its power and usefulness, the FlashSession thing is
pretty easy to set up and use.

X Retrieve unread mail

b [ ...and attached files
Schedule Activate
FlashSession  Session Now

Xisend outgoing mail:

[J Download selected files

[ Retrieve unread newsgroup messages

Select Walk Me D Send uutgoing newsgroup messages
Names Thraugh

(N sessions scheduled)

You don’t have to be signed on to do this — in fact, it’s probably a good idea if
you aren’t.

Here’s what FlashSessions do for you:
B 1~ Sign on in one, a few, or all of your screen names and gather new mail for
' offline review.

+* Send outgoing mail that you wrote offline and saved with the Send
Later button.

v+ Automatically download files attached to mail messages (or not, depend-
ing on your preference).

¢+~ Post your comments to those same newsgroups.
1 Download files marked in the Download Manager.
1~ Perform all these actions at regular intervals (every half hour, hour, two

hours, and so on) or whenever you tell the program to do so.

FlashSessions are pretty flexible, so you can do whatever you want. For in-
stance, your FlashSession can retrieve new mail, leave attached files online,
send outgoing mail, and not mess with the Download Manager at all. And you
can change the settings at your whim whenever you want.
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You can choose from two ways te set up a FlashSession: either click the Walk
Me Through button (which asks you questions and does the settings based on
your answers) or follow the steps below. Do whichever is more comfortable for
you. Heck — do them both if you want to.

Here’s how to set up a FlashSession by yourself:

1. If you haven’t already done so, sign off America Online.
2. Choose Mail<>SetupFlashSessions from the menu bar.

Doing so accesses the FlashSessions dialog box that you saw in Figure 7-8.
3. Click Select Names.

The Select Screen Names dialog box appears.

4. Click the check box next to each screen name you want to use with the
FlashSession. Enter the password for each screen name you choose.
Click OK after you're done (see Figure 7-12).

Type the passwords carefully. If a password is misspelled, the FlashSession
won't work correctly (and you don’t want that to happen, do you?).

5. Tell the software what actions this FlashSession should do.

Table 7-1 has a brief breakdown of the settings, what they do, and how |
suggest you set them.

6. After all your settings are completed, close the window by double-
clicking in the upper-left corner (Macintosh users click once in the
same place).

Congratulations — your FlashSession is ready to go.

You may have noticed that 1ignored the Schedule FlashSession button.
Although I think that this feature is interesting, I don’t want my computer
deciding on its own that it’s time to call America Online and check for mail. If
automating the process sounds like a hot fudge sundae to you (it sounded like
asparagus to me), look in the America Online access software help menu for
help setting the scheduling options.

Ileft out two other settings as well, namely the ones relating to Internet
newsgroups. Using FlashSessions with newsgroups is a slightly complex
process (much like assembling a child’s tricycle on Christmas Eve — if you're
a parent, | know you can relate). For details about using FlashSessions and
newsgroups, see the newsgroups section of Chapter 17.
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Table 7-1 FlashSession Activities

Setting Recommendation Description

Retrieve unread mail Turniton Copies new mail messages from
America Online to your computer
so you can read them offline.
Definitely use this option —it's a
money-saver.

...and attached files Turniton Automatically downloads files
attached to mail messages. If you get
a lot of files by e-mail, this feature
is useful. Go ahead and turnit on.

Send outgoing mail Turniton Sends any mail messages you wrote
offline and saved with the Send
Later button. Another must-have
feature of FlashSessions. Use it.

Download selected files Leave it off Invokes the Download Manager
and gets any files you have
marked. FlashSessions really shine
for immediate things like e-mail
messages. Use the Download
Manager when you're around to
supervise it.

Retrieve unread Learn more Retrieves new messages from your

newsgroup “read offline” list of Internet

messages newsgroups. Refer to Chapter 17
for details.

Send outgoing Learn more Posts replies to your “read offline”

newsgroup messages

list of Internet newsgroups. See
Chapter 17 for more information.

Petitioner Microsoft Corporation - Ex. 1006, p. 125



’ 2 6 Part II: Surviving the Software

Using a FlashSession is even easier than setting it up. To start your
FlashSession, choose Mail<>Activate FlashSession Now from the menu. The
Activate FlashSession Now dialog box appears (see Figure 7-13). If you're happy
with your settings, click Begin. If you want to briefly review things, click Set
Session instead. An information window pops up to give you the blow-by-blow
commentary of the FlashSession in progress. When it’s done, close the
FlashSession Status dialog box.

Activate FlashSession Now .

Select"Beqin" helow to immediately perform
Figure 7-13: | FlashSessions for the screen names you have

One more designated. The actions thatyou have specified wi” occur.,
. Y Ifyou would like to review or change your instructions,
clickand it's | select"set gession instead.

FlashSession
time!
|

To read incoming mail, choose the appropriate screen name from the main America
Online window and then choose Mail=>Read Incoming Mail from the menu bar.
You can read, reply, and do whatever else you wish with the messages. After all
your replies are done, set off another FlashSession to send them on their way.

If your teenagers have their own screen names, they probably won’t want to be
part of your money-saving FlashSession. That’s because you don’t need to type
in a password to read mail that came in through a FlashSession — you select
the screen name, hit the Mail menu, and you're knee-deep in potentially private
e-mail (at least from your kids’ point of view — and I probably agree with them).

Organizing Your E-Mail Mess(ages)

If you're using the Windows version of America Online, it’s your turn to look
smugly at the Macintosh folks. Versions 2.5 and later of the Windows software
has a really cool feature that’s not available in stores, can’t be purchased with
American Express, and isn’t included on the Macintosh. It’s the Personal Filing
Cabinet, your one-stop tool for tracking e-mail, Flashmail, file downloads, and
favorite places.

Figure 7-14 shows the Personal Filing Cabinet in one of its quieter moments. The
file folders along the left side of the window represent different storage areas.
Some of them you already use, like the Favorite Places window and the Down-
load Manager. Others are new, such as the Mail Archives.
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Personal Filing C;t.s?ﬁet

: Q Download‘Manager
A Files to Download
@A Files Youve Downloaded
Ba Favorite Places
@8 Incoming FlashMail
& Outgoing Flashiail
% Archives
€2 Maii Youve Read
[E——. 88 Mail Youve Sent
/| B Newsgroups
Figure 7-14: .1 & @8 Outgoing Messages
The
Personal
Cabinet. "" “Delete P Recame | ‘Search |-~ iFlashSessions} - Help}~

There’s a lot to work with here, but this area is easiest to understand when you

play with it. Before I turn you loose, here are some basic ideas about how the
Filing Cabinet works:

& 1~ Folders can be inside other folders, just like in the real world.

1~ Although you can work with the entries in your Favorite Places area from here, I
recommend making changes directly to the Favorite Places window itself.

+* To open a folder, double-click it. To close it, double-click again. When you
open a folder, the software displays all the items the folder contains
(which can be a lengthy list sometimes). Don’t be surprised if you have to
scroll up and down to see everything in a folder.

- v~ To view something inside a folder (be it a document or a Favorite Place
©  entry), double-click it. Doing so displays documents and sends you

careening off toward Favorite Places (provided that you're signed on to
America Online at the time).

1 To create a new folder, click the top folder of the area (like Mail, for
&  instance) and then click Add Folder. Type a name for the new folder and

then click OK. The new folder appears underneath the top folder. Isn’t
automated organization amazing?

. 1 Moving things from one folder to another is easy. Just point at the item
you want to move, hold down the mouse button, and drag the item to its
new home. When the mouse arrow is pointing to the item’s destination,
release the mouse button. The Personal Filing Cabinet gently puts the item
in place.

2 »~ If you misplace an e-mail message, click Search to have the Personal Filing
. Cabinet ferret it out. You can search on the item titles or the full text of
messages. Pretty spiffy, eh?
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E .~ In the Mail option of the Preferences (Members<>Set Preferences and then
¢ click the Mail button), you can tell America Online to automatically make
copies of all the mail you send and receive. These messages are stored in
the Mail Archive folder of the Personal Filing Cabinet. Personally, 1 think
this idea is really cool, but it can take a lot of disk space. Try turning this
feature on and see if you like it.

Online Telepathy with Instant Messages

Figure 7-15:
{poof} An
Instant
Message
appears.
L]

Sometimes, you just want to drop a quick “Hi!” to someone you happen to
bump into online. That’s what the America Online Instant Message feature is
for. It’s an easy way to have a quick conversation with someone regardless of
whatever else either of you are doing at the time (see Figure 7-15). Instant
Messages are completely private, too — only you and your correspondent
know what’s passing between you.

ftmTeachier: Hithere! Havent heard fram you in
awhile. How's the book coming? Are you up to
your gars in manuscript yet?

Reminder: AOL Staff will never ask for your password
or billing information. :-)

Using these little text bombs is easy — here’s how:

1. To see if someone is currently online, either check your Buddy List or
use the Locate command.

The Buddy List system is a great tool for tracking your friends online. To
find out more, see “Who’s Your Buddy?” later in this chapter.

To find someone with Locate, either press Ctrl+L or choose
Members=Locate a Member Online. When the Locate dialog box hops
onto the screen, type your friend’s screen name and press Enter. After a
moment, America Online tells you whether the person is online and
whether or not he’s in a chat room. (If he’s yakking away in a public chat
room, the Locate dialog box also offers you a Go button that whisks you
away to join your buddy.)
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You can send Instant Messages only to someone who's signed on and has
Instant Messaging turned on in the America Online Parental Control
(keyword Parental Control).

2. Having found your target — er, friend — press Ctrl+I.
The Send Instant Message dialog pops up.

3. Type the person’s screen name in the To box and then press Tab to
move the blinking cursor into the text area. Type your message.

Keep Instant Messages short. If you have something long to say, use e-mail.

If you're really in an Instant Message mode, skip step 1 entirely and use the
Available? button in the Instant Message dialog box. Type the person’s
screen name and then click Available? to see if he’s out there. That action
gets the same results as step 1's Locate Member Online command.

4. After you finish typing the message, click Send.

If the person is signed on and accepting Instant Messages, America Online
replies that your Instant Message was sent. Otherwise, it moans to you
about whatever went wrong.

When your friend gets the message, she can reply by clicking the Reply
button. Her message then appears on your screen, and you can start a
running dialogue.

If someone you don’t know sends you an Instant Message asking for your
password, credit card number, or anything else like this, report the person
immediately with keyword Guidepager. This is a scam — period. Whether the
person claims to be from the America Online billing department, a credit card
company, or Mars (which is where he should be), he lies. You can find out more
about this in Chapter 25, along with detailed instructions for nailing — er,
reporting — these scammers.

Who's Your Buddy?

Collecting a whole group of friends and acquaintances around America Online
doesn’t take long. In fact, you may find yourself awash in people in no time at
all. To keep track of your burgeoning social register, put America Online’s
Buddy List to work.

The Buddy List tells you at a glance which of your friends are online and where
they are. It even organizes your buddies into groups, making the task of discern-
ing the office crowd from the gang at last week’s online Jell-O diving competi-
tion an easy one. (After all, the difference may be important.)
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Building a Buddy List is a snap. Here’s how to do it:
1. Choose Go To>Keyword from the main menu or press Ctrl+K. In the
Keyword dialog box, type Buddy and press Enter.
The Buddy List window appears on-screen.
2. Click Create to make a new buddy list.

The Create a Buddy List window hops onto the screen, looking bright and
chipper as ever.

3. In the Buddy List Name box, type a short name (16 letters or fewer) for
the new list, and then press Tab.

The cursor jumps down to the Enter a Screen Name area.
4. Type the screen name of your buddy, and then press Enter.

Your buddy’s screen name takes its place in the Buddies on List area, just
like Figure 7-16.

|Friends TEP 3: When finished click Save’
—— Entera Sereen Name. ',‘\,‘,Bauﬁdiés;pn List. '
. 16 1:io i 1. rachelnsun
Flgure7.16. ﬂ kF°F”z'ke g% laufcidkid
Adding { o '
buddiesto ...

yogrll(lstl[sj L i L ree—
quickand | ; SR RN A
oasy- m e | : R Cancel B Save

5. Repeat step 4 until all your buddies are in there. When you're done with
the list, click Save.

To prove that it was listening this whole time, America Online replies thaf
your list is saved. The Buddy Lists dialog box then returns in triumph,
proudly displaying an entry for your new list (see Figure 7-17).

6. To create another list, go back to step 2. To put your Buddy List into
action, click View. When you're done, close the Buddy List window by
double-clicking in the window’s upper-left corner.

That’s it — your Buddy List is done.

Petitioner Microsoft Corporation - Ex. 1006, p. 130



Chapter 7: Communicating with Everyone (One Way or Another) I 3 I

L |
Figure 7-17:
Cool —
there's my
new list.

L ]

Figure 7-18:
Your
buddies
can't
escape

you now.
EEEsEsama—

JKaufeld's Buddy Lls\s
Buddy List Name Buddtes e

Friends

- Member -
Dinec‘gor‘y i

-T2
Preferences
m Keyword Buddy

Every time you sign on to America Online, your Buddy List jumps into action,
hanging out on the side of your screen much like Figure 7-18. As your buddies
sign on and off the system, the list updates itself automatically.

If for some reason you don’t want people to track your screen name with a
Buddy List, that’s easy to set up. In the Buddy List window, click Preferences.
To completely block yourself from Buddy Lists all over America Online, click
Block all members from adding me to their lists. To either allow or prevent a
few people from tracking you on their Buddy Lists, click either Allow only the
members below or Block only the members below, and then put the specific
screen names in the box at the bottom of the dialog box. When you're done,
click Save.

»{y\ Budd L4 e
‘Bljddieé‘f()l’lliné

“1 ‘Good thing you're
using AQL 3.0 Now
Foyou canfingd what
you're lonking for |

“AOL Reference: It's
JKaufetd! -niotjust for hamework

~Amition | amymore. @ @ 003
“, bucks! Going <« "} ;

- once, goin , Locate "l Setup - Help
. Mice,;ﬁghurr?;, Overcome those ?word' Buddy\ﬁew

only 8 days hurdies! Free Olympic |

left: ) Woman tshirtwitha AM)g
$35 order rom Avonl 4,
B 0P NEWS STORY: |
| Navy to Aid TWA
o PEQP Crash Search with !
0 0 R ' Robot -
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Typing the Night Away in a Chat Room

Finally, if interactive communication is your thing, check out America Online’s
famous chat rooms. This is the height of interactivity. You're typing away in a
group of up to 23 people. And it’s a blast.

Rather than have me retell all the details here, check out Chapter 25. It covers

chat rooms, meeting rooms (big chat areas), and the online auditoriums (for
really big functions).
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In This Chapter

g Finding things to download

¥ Downloading a file

g Using the Download Manager

¥ Zipped, stuffed, and other ways that files arrive
& Uploading your donations

¥ Logging everything you see
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magine a Wal-Mart where everything is free and you pay a flat rate for the

time you spend shopping and carrying your purchases out to the car. Some
items also require a small payment directly to the manufacturer, but most don't.
Sounds like heaven, right? ( Well, heaven probably would be a computer
superstore set up this way, but I digress.)

The scenario that 1 just described already exists, except that it’s not a

Wal-Mart except for the — hundreds of file libraries in America Online work this
way. Find something that interests you; pay for the time it takes to download
the file to your computer; and then, if it’s a shareware program, pay a small fee
to the author because you love the program so much.

Sounds too simple, right? There must be a catch. Well, it is pretty simple,

and there really isn’t a catch. This chapter is your guide to getting a share of
this digital bonanza. Read on and find out about finding stuff to download, how
the download process works, sharing stuff you love by uploading it, and

much more.

Welcome to Software Heaven. Come right on in.
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Locating Likely Candidates

You're ready to storm the digital gates, eager to get your share of the software
fortunes within. But where do you start? Geez — hundreds, maybe thousands, of
places exist for you to look through. Nothing like having too many options to
keep your mind spinning in circles, eh?

Start with one or two forums that you particularly like. If you're looking for a
certain kind of file (such as fonts or clip art), use the Software Library Search
feature to see what'’s out there. The following sections explain both of
these options.

Forum and service libraries

Almost every forum has a file library. Libraries usually are marked with the disk
icon that you see in Figure 8-1 or, in fancier service areas such as the one shown
in Figure 8-2, with a disk button. Both elements ultimately lead to a file-list
window (see Figure 8-3).

[ About this Farum
[ How to Subscribe to HEM
HEM Articles

3 Hameschaooling Resources
£ HEM Message Center

| -
< HEM Library
Figure 8-1: 5= Wite o the Editor
. . Ea Parenting Conference Center
A simple file
library. § keyword: HEM
L]

+* To learn more about a file, double-click its entry in the forum library
window (or single-click the entry and then click the Read Description
button). A page of information about the file appears, including its name,
size, author, and a complete description (or as complete a description as the
person contributing it provides). Incidentally, if you're using a session log,
all the file descriptions that you view are saved there automatically. For
more information about session logs, see the last section of this chapter.
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Figure 8-3:
All roads
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file-list
window.
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The #1 Magazine for Windows Information

¢ |[JJINDOWS
\ MAGAZINE

WinMag
Chat
Augqust 1996 Issue:
B WEW!Wintag's Chatraorn B
Cover Story
£a News, New Products, Letters
‘ £3 Analysis & Opinion Columns
Ea Features
55:;:;" WinLab Reviews

£3 How-to Columns
Ea WinOnline, R&R, Recycle Bin

Tips, Tricks WinMag Message Subseriptions
XFAQ Exchange Department
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[v[*]

WinMagWweb
Site!

<

Back issues
on the Web

Yendor Demos
and Freebies

07z
03/22 WmWord Macro - 3195 "F‘ower
02116 NT Batchfile Article

01/09 John Ruley's Windows NT FAG v2.0
01/08 Windows 95 Telephony Products
12/03  WinMag's DOS2vin Utility

09128 WinMag October 1995 Text

09120 WinMag September 1995 Text
09520 WinMag August 1995 Text

09/20 WinMag July 1995 Text

i,

REBBRRBRRER

09/20  WinMag June 1995 Text

Count  Download

47520

Hed Description Download Now Download Later

Upload List More Files

buttons (covered in the next section).

§ 1~ Downloading is a breeze with the Download Now and Download Later

+~ Most libraries have lots of files, but only the first 20 are displayed. That’s
why a List More Files button usually appears in the lower-right corner of
the forum-library window. Click this button to display more files in the

window.

dows, see Chapter 6.

N 1~ If you want general information about the file list and other forum win-
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For leads on good downloads, read the forum'’s discussion areas to see what
people are talking about, or post a message that describes your interests and
asks for recommendations. Also look for files that are popular. The Count
column in the filelist window is a good popularity gauge; this column tracks the
number of times that a file is downloaded.

File Library Search

1f you're Yooking for something more general, or if you just like knowing all your
options before you start, try the Software Library Search feature. This feature
browses through all the libraries in America Online, looking intently for what-
ever you tell it to look for.

You must be signed on to America Online to use the Software Library Search
system. Sorry, but that’s just how life goes.

Here’s how to do a search:

1. Click the File Search button in the Toolbar.
The File Search dialog box pops up.

2. If you want to limit your search to a particular period (the past week,
past month, or since time began), click the appropriate radio button.

Unless you have a burning need, leave the time frame set to All dates.
When the file list appears, it’s sorted by category and date anyway, with
the newest files listed at the beginning of each category.

3. Unless you're looking for something very specific, click the All Catego-
ries check box to tell America Online that you’re open for just
about anything.

When you feel comfortable with the search function and the kinds of files
that are out there waiting for you, try experimenting with these settings to
see what you can find.

4. Type a few descriptive words about what you’re looking for (see
Figure 8-4).

5. Click the List Matching Files button (see Figure 8-4).
After a moment or two, the File Search Results dialog box appears, looking
somewhat akin to Figure 8-5.

The File Search Results dialog box is a whole lot like the forum’s file-list
window, right down to the buttons along the bottom. At this point, you're
ready to do some downloading!
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1 Development T Graphics & Animation ] Telecommunications

137

@ All dates O Past month O Past week
Listfiles in the following categotries: (Click one or more) !
& A Categories
[ Applications ] [ osy2

] pos 1 Hardware ] Windows
] Education [ Music & Sound
Listfiles pertaining to the following keywords: (Optional)
[simula\ions }
]
Figure 8-4:
The search =
. List Match Get Hel GoToM
begins. e andint Software Search
T

File Search Results

Category Subject

File Name

Simulations
Sinulations
Simulations

MYP: K.O.R.T.

Simulations

OPT: V1.0 Typhoon Wargame
Perfect Save Gane
SIEGE: V1.2 Castle Construction

Simulations CZSVGA: V1.0a Combat Zone CZ ZIP
Sinulations CORNCOB: V3 .42 Air Combat Game CC3D342.ZIP
Simulations MYP: King Arthur's K.OR.T. KORT.ZIP
Simulations BLINDWAR: V1.1 Strategy Wargame BLINDWAR ZIP
Simulations CAHPAIGN: V4.1 War Game CAMP41.Z1IP

STELLAR: Stellar Defense I1
Other Special Intere TRAINGIM: V1.0 Train Simulator

OTP.ZIP
KORT4 . SAV
SIEGE.ZIP

SOLARDEF . EXE
TRNSIM10.ZIP

SEE— Items 1 - 100 of 250 out of 3587
Figure 8-5: y
The results = : =1
arein! Read Description Download Now Download Later Hel & Information List More Files
|

Downloading a File Right Now

You finally found a promising file, checked its description, and decided that
you simply must have a copy. Cool with me. You're ready to do the dirty deed,

then — time to download a file.
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Here’s the procedure:

1. Click the name of the file that you want to download and then click the
Download Now button (see Figure 8-6).

If you're in the file-list window, Download Now is a square button with a
cool graphic of a disk “beaming down” as in Star Trek. In the file-descrip-
tion window, the button is simply labeled ( you guessed it) Download Now.

I File Search Resui-ts

Cateqory Subject File Name
Simulations OPT: V1i.0 Typhoon Wargame OTP.ZIP
Simulations MVP. K.O.R.T. Perfect Save Gane KORT4 . SAV
Sinulations SIEGE: Wi.2 Castle Construction SIEGE.ZIF
Simulations CZSVGA: V1.0a Combat Zone CZ ZIP
Simulations CORNCOB: V3.42 Air Combat Game CC3D342 ZIP
Simulations MVP: King Arthur's K.O.R.T. KORT.ZIP
Simulations BLINDWAR: V1.1 Strategy Wargame BLINDWAR.ZIP
Simulations CAMPAIGH: V4.1 War Game CAMP41 ZIP
Simulations STELLAR: Stellar Defense II SOLARDEF .EXE

SE— Other Special Intere TRAINSIM: V1.0 Train Simulator TRNSIM10.ZIP
Figure 8-6: lterns 1 - 100 of 250 out of 3587
Ready to <
download,
Ca pta in. Read Description Download Now Downtoad Lates Help & Information List More Files
]

Clicking this button accesses the Download Manager’s filename dialog box
( but not the whole Download Manager itself — that’s covered in the next
section of this chapter).

The file’s name is displayed in the File Name box (see Figure 8-7).

2. If you want to change the file’s name or the directory where it’s going to
land, go right ahead; after you finish, choose OK.

Clicking OK starts the download. To keep you updated on its progress,
America Online displays a bar chart.

The dialog box also has two control buttons: Finish Later and Cancel. If
you suddenly need your computer for something more urgent than
downloading this file, click Finish Later. America Online remembers that
you already received part of the file, so when you're ready to pull down the
rest, the download picks up wherever you stopped the first time. Cancel,
on the other hand, is the abort button. Click it if you come to the conclu-
sion that downloading this file is a terrible mistake.

After the download is complete, a little dialog box pops up to gleefully
announce the news.

3. Click OK to make the dialog box go away.
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If something goes horribly wrong (for example, the download gets stuck for
some reason) and you burned up a bunch of online time for nothing, go to
keyword Credit and ask for a refund. Fill out the form, complete with the time,
date, and minutes lost and then click Send Request. The America Online Credit
Elves should reply to you within a few days.

Download Manager

Fite Name: Directories:
c:\aol30a\download
: =N
[ aol30a
#= download
€1 tyig
|
Figure 8-7:
Name the
fite, and it's List Files of Yype: Drives:
onthe way! | [l Files ) EE
|

After you get the hang of the America Online file libraries, check out the
Internet Connection’s FTP (File Transfer Protocol) feature. FTP is your link to
millions of files available on the Internet. If instant access to file libraries all over
the world already has you salivating, flip to Chapter 17 for details.

How Do You Manage This
Many Downloads?

What if you find not one, not two, but about 47 fascinating files? Well, you can
spend a lot of your copious free time watching the computer draw download-
progress bar charts ( how exciting!). Or you can use the Download Manager to
automate the whole sordid process.

The Download Manager’s main goal in life is to help you download tons of stuff
from America Online. Really — that’s it. Using the Download Manager is a two-
stage process: You mark the files that you want to download and then you tell
the Download Manager to get all of them. The best thing is that you don’t need
to be there for the second step of the process; your computer gleefully sits and
catches all the files you want while you're off doing something reafly fun.
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Here’s how the process works:

1. Click the name of a file that you want to download and then click the

Download Later button (see Figure 8-8).

The file hops into the Download Manager’s queue.

2. Repeat step 1 for all the files that you want to download.

3. Open the Download Manager by choosing File>"Download Manager.

Category Subject File Name
Sinulations BACKLASH: V1.20 Turret Gunner BL120SW ZIP
Sinulaticonz WER. VE.3 Wall Stréet Raider WER52 EXE
Sinulations ONTARGET: ¢1.7 Artillery Game ONTARGET . ZTP
Game Demos BORISBJ: 3.21 Blackjack Sim DEMO BORIS321.ZIP
Sinulations GLOBAL: V3.0 Global War GLOBEWAR.ZIP
E— Sinmulations HONGKONG: 2.0 Trading Game HONGKNG2 . ZIP
Sinulations CONQUEST: Strategy Wargame conquest . zZ1ip
Figure 8-8: Simulations TBS: V1.1 Starship Battle Sim TBS11.ZIP
g . Sinulations GAMMA : GAMMA Wing vl.4 GAMMA . ZIP
Just leave {Sinulations BABYLON: Rule The Kingdom BABYLO.ZIP
itin the ltems 1 - 20 of 250 out of 3092 matches.
queue; |'ll i
pICkIt up A SRR Limads g o
|ate r. Read Description Download Now Download Later Help & Information List More Files
|

The Download Manager window appears, looking vaguely like the one

shown in Figure 89.

Download Manager

‘ B Simulations WSR: V5.3 Wall Street Raider 567K
B Simulations TYCOON: V3.0 Qil Tycoon 48K
B Simulations SPEC: V1.0B Real Estate Game 140K

Figure 8-9:
| found a

Files will he downloaded to:

CAMAOLI0ADOWNLOAD
Selected file size: 918K About 11 minutes to download.

few things
that |
couldn't live
without.
]

View
Desctiption

Select
Destination

Download
Preferences

Start
Download

Help
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To see the file description one more time, double-click the filename in the
Download Manager window. The description appears, just as it did in the
file-list window.

If you have sudden second thoughts about a file and decide that you don’t
want to download it, click its name in the Download Manager list and then
click Delete Item. Repeat the process as many times as you want.

4. Click the Start Download button to put the Download Manager to work.

Two windows appear on-screen. One window shows the overall status of
your massive download. The other window displays a progress bar chart
for the file that’s downloading right now (see Figure 8-10).

File Transfer :

] Now Downloading HONGKNG2.ZIP (2 of 3)

A down,oa.d About 2 minutes remaining.
caughtin 4 4
the midst of [liSign Off After Transfer!
the process. Finist I N
|

U SAVg,  Ifyou have a lot of files to get, click the Sign Off After Transfer check box. That
$ option tells the Download Manager to go ahead and sign you off Americz Online
after the last file arrives. This feature is really handy (and makes sure that you
don’t waste a lot of online time if the download finishes before you expect it to).

Remember that FlashSessions work with the Download Manager. You can mark
a bunch of files and download them in the middle of the night, when America
Online is the least busy. Chapter 7 explains FlashSessions, but you need to
check the Help menu for details about scheduling them.

The Joys of Stuffing and Zipping

Many files in America Online’s various and sundry file libraries end in ZIP or
ARC. These letters don’t mean that they’re fast or that they date from the time
of Noah; rather, they indicate that the files were compressed so they’d take less
time to download (and less space inside America Online’s computers). Before
you can use a compressed file, you have to decompress it.

gsTUFF

For you Macintosh folks in the studio audience, the most common kind of
Macintosh compression is a SIT file, created by Stufflt.
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g’p.\. STy

Luckily, the America Online access software automatically unpacks compressed
files when you sign off of the system. (1 tell you, those programmers amaze
even me sometimes.) To make sure that this setting is on, choose Members<>Set
Preferences. Click the Download button to open the Download Preferences
dialog box. Make sure that Xs appear in the two check boxes next to Automati-
cally decompress files at sign-off and Delete ZIP and ARC files after decompres-
sion. Then leave the decompressing to America Online.

Of course, the Macintosh access software offers the same automatic unpacking
feature. To turn on the setting, choose Membersc>Set Preferences from the
menu bar (or press 38+=). Click the Download Preferences entry and then make
sure that the Auto-Expand files option is turned on.

Installing programs on your computer involves a lot of little niggling details —
too many, unfortunately, for me to go into here. I won’t leave you high and dry,
though (I'd never do that to you!). Take a look at these resources for more
about both downloading and installing programs:

Petitioner Microsoft Corporation - Ex. 1006, p. 142



Chapter 8: Loading Up, Loading Down, and Zipping All Around , 43

g v For a distinctly America Online view of the whole download and install

g thing, try keyword Download 101. This step-by-step tutorial guides you

. through the whole process in good detail. Pay particular attention to How do
I use downloaded files (step 4) and Troubleshooting, Tips, and Tricks (step 5),
because they cover the toughest parts of the download experience.

| »~ If the mere thought of folders, directories, and software installation makes
you pass out on the floor, put some soft blankets down there to cushion
your impending arrival. When they're safely in place, pick up a copy of
Windows 95 For Dummies, Windows 3.11 For Durmmies, 3rd Edition, or
Macs For Dummies, 4th Edition (all from IDG Books Worldwide, Inc.), hit
the blankets, and catch up on your reading.

Donating Your Own Efforts

Most file libraries not only offer files for your downloading pleasure but also
accept uploads — files donated by other America Online members. After all, the
library files had to come from somewhere, so why not let members chip in
things that they like?

To upload a file, you need to know the file’s name and location on your com-
puter. You also have to find a potential home for it in America Online. Look for a
place that accepts uploaded files (this step’s a must) and that has other files
like the one you're sending. If you're sending a game, utility, or other program,
use your anti-virus software to be extra sure that you’re not donating a com-
puter virus, too.

B 1+ Not every file library accepts uploads. If you're looking at a file list and the
§ Upload button is dimmed, that’s a pretty good sign that you're reviewing a
L read-only library.

1 Only public domain, freeware, shareware, or items of your own creation
can be uploaded to America Online. If you aren’t sure about the appropri-
ateness of something that you want to upload, post a message to one of
the forum hosts ( you can usually find their screen names in a “welcome to
this forum” type of document in the forum’s main screen). Describe your
file and get the host’s opinion about your uploading it. Check out the
sidebar earlier in this chapter for a little more information about the whole
freeware, shareware, and commercial software issue.

T

AR

» Don’t upload something on your first day in America Online. Wait a little
while. Get involved in a forum or two, meet some people, post some
messages, and generally get a feel for what goes on before you upload
anything to a library.

&
&
&
o
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At this point, you're ready to upload the file. Here’s what to do:
1. Display the file-list window of the file library to which you want
to upload.

Get there through whatever combination of keywords, menus, and mouse
clicks works best for you.

2. Click the Upload button at the bottom of the file-list window.
The Upload File dialog box appears.

If the Upload button is dimmed, this file library doesn’t accept uploaded
files. Sorry.

3. Carefully fill out all the information boxes in the Upload File dialog box.

Be as specific as you can. The more that people know about this file, the
more likely they’ll be to download it.

4. Click Select File to display the Attach File dialog box; double-click the
name of the file that you want to upload; then choose OK to close the
dialog box.

3. Double-check all the text you typed; after you’re happy with it,
click Send.

Don’t be surprised if your uploaded file doesn’t immediately appear in the file
library. Most, if not all, America Online forums check uploaded files for viruses
before setting those files free in the library.

Logging Isn’t Really Downloading,
but It’s Close Enough

Sometimes, you want a record of where you were and what you saw. If you
didn’t, most of the photo film and developing market (as well as a large chunk
of camcorder sales) wouldn't exist.

In America Online terminology, what you're looking for is a session log: a file that
stores the contents of every document that you touched during a particular
online period. The session log grabs every e-mail, news story, and bulletin board
posting and stuffs them into one long text file.
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To start a log file, follow these steps:

1. Sign on to America Online.
2. Choose Filec>Log Manager.
The Logging dialog box appears.

3. In the Session Log section, click Open to start a new log file or Append
to add to an existing file, and then enter the name for the log file in the
Open Log window. Click OK after you finish.

Two kinds of log files exist: Chat Logs, which capture the text of a chat
roomt; and Session Logs, which catch everything that comes close, possi-
bly including family pets that stray too near the modem.

4. Go on about your online work, comfortable in the knowledge that your
log file is recording every document that you see.

Only documents that you actually look at on-screen are saved. Just looking
at a list of articles doesn’t put the text of all the articles into the log file; you
still have to double-click each one individually. However, when the article
appears in a window and the cursor changes from an hourglass to an
arrow, the article text is captured in the log file, and you can close the
document window.

5. When you finish reading, choose FilecoLog Manager and then click the
Close Log button in the Session Log part of the window.

This step explains to your computer that you're done adding text to the
file and want to let your newest addition rest for a while.

6. Sign off America Online.

After a moment or two, you're part of offline America (and, best of all, the
billing clock comes to a grinding halt).

7. To read your log file, choose File>Open from the main menu and then
double<click on the log file’s name.

The file appears on-screen in its own window. Kick back for a relaxing
‘(and free-of-connect-time-charges) browse through the articles.

If a text window doesn’t appear after the FileoOpen command, your file is
too big for America Online to open. (It can't just come right out and admit
failure — nooooo. Instead, it ignores the command and pretends you
didn’t say anything. Isn’t that just like a computer?) To view the file, start
your favorite word processor and use it to open your log file. If you aren’t
sure how that’s done, check the word processor’s help file for information
about opening text files.
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In this part . . .

able TV is a fixture of modern life. These days, people

expect to sink into their favorite couch, chair, or yoga
position (ouch!) and flip aimlessly among 763 different
channels of mindless programming. Thank goodness society
hasn’t set its sights too high.

The 21 channels are America Online’s version of cable TV
(and a mighty nice substitute it is, too). The channels are
the main structure of the whole systern — they sit at the
heart of America Online.

In keeping with their central position, this part devotes an
entire chapter to each channel. It explains how to get there,
what you see when you arrive, a little about all the forums
and services the channel contains, and my picks for don’t
miss this stuff in each area. It’s truly the informational
surfing experience. Now, where’s my remote control?
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Find
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In This Chapter

» Looking for Find

# Seeking (and finding) that particular something
w Traipsing through the tabs

$ Browsing the channel guide
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f I could have a nickel for every time someone asked how to find things on

America Online, I'd ask for a dollar instead. (A nickel doesn’t buy anything
these days.) Whatever the payment, 1 would be up to my eyeballs in money.
That's because tracking stuff down on America Online is (ahem) challenging —
or at least it was challenging before those clever programmer types invented
the super-cool Find system.

Whether you want something specific or feel like browsing aimlessly for a while,
start your hunt at AOL Find. This chapter reveals the online oracle’s mystic
secrets. From the Search area, to the topic tabs, to the Channel browser, AOL
Find is the searchable index you always wanted.

Ouest 101: Looking for Find

Start your quest for knowledge by opening the AOL Find window. The program-
mers made it an easy destination to reach — Table 9-1 offers up the details.
When you arrive, the compact window in Figure 9-1 hops up to meet you.

Table 9-1 Finding Find (An Alliterative Task)
To Get There with Use This

Channels window

Toalbar buttan

Keystroke Ctrl+F

Keyword Find
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Search box

n AOL!

sord to search fof and click "search.”

R
Fi 9.1 | e« AQL Access Numbers
lgur,e -1 e AOL Classifieds

it's the e AQLHomepage

o

Other searches

frequently e Internet Newsgroups
knowin -5~ Search for Software
. g <o Search the internet
often-seeing
AOL Find |
window.
L
- Topic tabs

For all it does, the Find window isn’t very big or complicated. The search box
occupies the top third of the window. Below it, the topic tabs serve up links to
other America Online and Internet-based directories. The three buttons on the
right represent other searches, plus some Find system help and tips. The

QP following sections cover this stuff in detail.
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Figure 9-2:
Pursuing a
hobby with
the AOL Find
system.
L]

Chapter 9: Find 7 5 7

Do you ever sit in front of your computer, staring at the America Online screen,
knowing that what you want to know just has to be in there somewhere? If only
you knew where to look . . . (insert wistful sigh here).

The next time that feeling strikes, fire up AOL Find and try a Search. The Search
option takes any word you type (like homework, finances, or photography)
and looks for that subject among America Online’s forums and services. The
system lists everything that relates to your subject. From there, you can double-
click whatever it found, see more information about the area, and then click the
Go button and zip directly there.

To search the subject list, sign on to the system and follow these steps:

1. Using one of the techniques in Table 9-1, open the AOL Find window.

The AOL Find window pops up, ready for some aerobic activity.

2. In the box at the top of the window, type the word you're leoking for

and then click Search (see Figure 9-2).

After a moment, the results window pops onto the screen. If AOL finds
more than 20 matches, the window shows only the first 20. To see the rest,
click the More button at the bottom of the window.

If the only entry in your Search Results window says something like Search
the Internet, America Online failed to find anything about your topic and
suggests that the Internet, in its worldwide glory, may contain something of

interest.

Find It On AOL!

Type a word to search for and click "search.”

[photography]

]

Places &
: AOL Directary

o AOL Access Numbers
e AQL Classifieds
e ACL Homepage
e Internet Newsgroups
<5 Search for Software
<& Search the Internet

OR, click o a tab below for suggested areas

The
Essentials

Browse
Channels
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3. Browse through the Search Results window to see what America Online
found for you. To find out more about something on the list, double-
click its entry.

When you double-click an item in the Search Results list, a new window
appears with all the details about that particular area, just like Figure 9-3.
In addition to general information, the window also offers to show you a
related area (read: the channel window where this area lives), add this area
to your Favorite Places list, or even take you directly there. Pretty cool, eh?

Popular Photography

Popular Photography

Focus on photography.

Papular Photography

HOT LIST:

Current Features

Poputar Photography's Resource Center
Popular Photography's Daily Trivia

S
Figure 9-3: This online version of the world's most popular imaging magazine combines in-depth
. otography, buying guid
Hey — this 2L Q8 256 board.
one looks KEYWORD:
9ood. || * Photos
I

4. When you’re done with the window, close it and go back to the Search
Results to look for other items of interest.

If you get lost on the way back to the results window, use the Window
menu to jump directly there.

5. To start another search, go back to the AOL Find window and start over
at step 2.

1f you don't feel like looking for anything else right now, feel free to close all
the search-related windows. ( There’s no penalty for tidiness.)

New information areas come online all the time, so search for your favorite
subjects regularly. Doing so is a great way to keep up with the latest stuif.
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Trying the Tabs

The tabs aren’t really search systems themselves — instead, they point to
various searchable places all over America Online. Most of the areas in here
have their own keywords (such as AOL Live, Classifieds, and Buddy List) or
menu selections (like Members>Member Directory), but having everything
together makes life a little easier.

Although the tabs are somewhat self-explanatory, Table 9-2 gives a quick run-
down of what you can find under each one. When the AOL Find window comes
up, the stuif behind the Places & Things tab automatically appears. To choose a
different tab, just click it. (And you thought computers were hard!)

Table 9-2 What's behind Tab #1?
Tab Sample Contents
Places & Things System directory, access numbers, classifieds,
newsgroups, software search, Internet search
People Personals, Buddy Lists, member directory, national white
pages
Events AQL Live!, contests, auditorium events, daily chat list

Surfing through the Channels

The 21 channels sit at the very heart of America Online. Everything in the
system lives in a carefully selected channel. Forums, online areas, Web links,
chat rooms, and all the other stuff all hang out inside one or more channels.
That organization makes the channels an easy way to find online information,
particularly when you have the Channel Find window available.

Channel Find lives behind the Browse Channels button on the main AOL Find
window. A quick click on that button rouses the window into action. To see a
channel list, select the channel of interest from the drop-down list at the top of
the window (see Figure 9-4). After a tense moment of waiting, the window fills
with entries for every area in the channel. Unlike the list from the main Search
function (flip back a few pages for the details about that), when you double-
click something in here, America Online sends you straight to the area — no
questions asked.
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]
Figure 9-4:
ifitsina
channel, it's
in these

lists.
R

To see the list in straight alphabetical order, click the A-Z tab. For a list by topic,
click the By Topic tab. To change channels, see the instructions that came with
your cable tuner. Whoops — sorry about that. | meant to say that you click the
arrow in the drop-down list and pick a different channel from there.

. _AOL Find |
~Channel Find
[ Click Here to Select a Channel

Click Here to Select a Channel
~{ Computers & Software
Digital Cit
Entertainment

Health & Fitness
Hobby Central
The HUB

1 Intermational
Intermnet Connection

S PCFINANCIAL Click 1o your left to

ETWORK wisit PCEN
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In This Chapter

% The computing basics

p Checking out the buttons
p Consistency is a virtue

B A tour of the groups
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w hen computers made their first appearance in the 1940s, they were an
incomprehensible morass of wires, tubes, huge boxes, and cooling fans.
Thanks to the wonders of modern technology, the computer of the *90s bears
little resemblance to its long-antiquated counterpart. Today, computers are an
incomprehensible morass of boards, chips, little boxes, and cooling fans. Fills
you with hope for the future, doesn'’t it?

Whether or not you comprehend the morass , you still need a place to go with
your questions, concerns, and general complaints. In America Online, look no
further than the Computers & Software channel. It covers all your computer
woes from hardware to software, from laptops to palmtops. Gather up all those
computer questions you have lying around, wade into the Computers &
Software area, and demand answers.

The Basics

Like all the channels, Computers & Software is nearby no matter where you
happen to be in America Online. Table 10-1 shows you how to get there. When
you arrive, the friendly, colorful window in Figure 10-1 pops up to meet you.

Table 10-1 Getting to the Computers & Software Area
To Get There with Use This

o omputers & solbwore

Channels window

Keyword Computers & Software

Petitioner Microsoft Corporation - Ex. 1006, p. 155



fome — e

' 5 6 Part lll: Flipping through the Channels

—Featured areas Service buttons —1

...1

- ]
Figure 10-1:
Computing
central here
at America
Online.

8
Utility buttons Topic buttons

Stacked through the middle of the window (and darn hard to miss) are the
Computers & Software topic buttons. Like literary genres, each button leads to a
discussion focusing on a particular aspect of computing. On the left of the topic
buttons sit the featured areas. These areas may change from time to time, depend-
ing on the season, amount of rainfall, and vacation schedule of the person in
charge of the area. Arrayed up the right side of the window are the service
buttons, offering quick links to shopping, the Web, and computer industry news.
Finally, the utility buttons line the base of the window, ready to sweep you into
the Channels window, Member Services area, or the Find dialog box.

Pushing the Topic Buttons

The big, friendly buttons on the Computers & Software channel’s main window
are great places to start your quest for truth, beauty, and the reason your
Macintosh crashes every time you hold the mouse near the floor and say,
“Here, kitty kitty.” Each button leads to a screen full of special interest forums,
discussions, and Internet sites. Either click them one by one or use the key-
words to get there fast.

i 1 When you want answers to those sticky hardware and software problems,
try the Company Connection button ( keyword Company Connection). If
you aren’t sure where to start, check one of the more focused support
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areas like Kim Komando's Komputer Klinic ( keyword Komando) and Craig
Crossman’s Computer America (keyword Crossman). They may not be
completely alliterative, but how much art should you expect from a nerd?

= 1~ For tips and ideas about involving the whole family in computing, check
Family Computing ( keyword FC). For that matter, try keyword Family
Computing, which offers up not one, not two, but five (count 'em — five!)
different resources for the online household.

Following are some other cool places to check out:

Consumer Electronics
Forums (Support Forums)

Magazine Rack

Consistency Is a Virtue

Most of the Computers & Software channel is somewhat unique in America
Online. Of course, if any one area simply had to be different than the others, it
would probably be the one about computers, now wouldn't it?

R
Figure 10-2:
The PC
Applications
Forum looks
just like all
its brethren.

Multimedia Zone
Software Center

ZD Net

So what makes it different? Most of the main forums share a common window
format — they look and work in basically the same way. Figure 10-2 shows one
of these cookie-cutter windows (in this case, the PC Applications Forum).

4 £3 Meet Your Forum Staff

3 Apps Forum Chat Schedule!
£3 Reference Guide: info To Gof

-1€3 Our Magazine Rack & Reading Room
| &3 CompuKids - Kids on Computers

fa Database Resource Center

[ Desktop & Web Publishing

| & Applications FREE Uploading

5 NEW: Download AOL 3.0 Here!

% Cruise to the Mac Business Forum

Conference Center - Open Weéknigh{s! :

Troubleshooting

Keyword: APPS o
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The list area offers general information, forum announcements, and whatever
else the forum operators get around to putting there. The Help & Information
butten explains where to post your questions so they get answered.

The bottom four buttons on the right side of the window (Software Libraries,
Message Boards, Resource Centers, and Reference Guides) are the same
throughout the Computers & Software forums. The other two buttons (in this
case, Forum News and Apps on da Web) change function depending on which

forum you're in.

2 1~ All the choices in the Computers & Software window use the common
window layout, except for Check for Live Discussions and the Apple

Computing Forums. These two options bring up simple list windows.

1+ The other minor exception to the common window layout rule is the User
- Groups window, which decided to put its buttons a little out of order.

v Check out the Resource Centers buttons in all the computing forums that
4 youuse. The Resource Centers gets you to the various manufacturers’
support forums, where you can ask really specific questions.

v+ The software libraries in here are definitely worth checking out. Find
¢ utilities, examples, shareware, and more, all yours for the downloading.

§ 1 Every Computer Software forum has a conference area for regularly

% scheduled interactive discussions. Check Start Here: Forum Intro & Tour

information for times and topics.

turn in America Online, and the Computers &
Software channel certamly upholds thatfine tra-
dition. Here are some of the hrghhghts k

ZD Net (keyword D Net): What can 0 say about
-an area that offers tips, tweaks, and trouble-
shooting, plus one of the best software libraries
in town? Go there now — that’s what! If you
haven't seen ZD Net, you haven't, um, well —
done it. What are you waiting for? -

Rotunda (keyword Rotunda): It's not every night

oftheweekthatBill Gates, Andy Grove,and ahost

of other industry big shots drops by your house
for a quick chat (And if it is, they oughta pay for
some of the drinks.) The Rotunda is your number

Specral stuﬁ you don twantto mrss

You can fmd good stuff ;ust about anywhere you‘ ‘

one stop for computer—related presentatlons and

~ discussions, Check the Box Office (click Box Of-

fice on the Rotunda main wmdow) for upcoming

. events, andthen mark them on the calendar. Also

watch the Archives {click Archives -on the -

Rotundamain wmdow)fortranscnpts of prevtous
shows.

-Software Center (keyword Software Center) If

your hard drive is long on space and short on fun,

- take a fewminutes to rummage through the Soft-

ware Center. There's no surerwaytobnnga smile
to a morose storage device. You can't go wrong

_ with the huge selection of both Macintosh and

Windows programs. Grab a few rtems ‘and give
thematry.
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In This Chapter

& The basics of the electronic cityscape

B Finding your way around
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A ccording to the wise old sage (who probably moonlights at the auto-
mobile club), “Getting there is half the fun.” Thanks to the cool stuff in

America Online’s Digital City channel, though, you may think that not getting
there is almost all the fun.

Digital City chaperones you through a slew of cities all over the United States.
Big cities, small towns, and quaint burgs await your virtual visit. Each town offers
the best in tourist information, city maps, travel tips, and hot sightseeing spots,
all available without leaving the comfort of your home. Who could want more?

Ease on your shades, adjust the mirrors, and rev up your easy chair for a cruise
down the virtual highway. Your favorite Digital City awaits!

Taking a Basic Tour

Traveling to the Digital City channel isn’t much of a sightseeing trip. All it takes
is a keyword or quick mouse click ( both of which are detailed in Table 11-1),
and you’re there. No time for a snack along the way! As you top the crest of that
last online hill, the Digital City in Figure 11-1 spreads out before you.

Table 11-1 Traveling the Digital Cities
To Get There with Use This

DYRETAL LITY
Keyword Digital City

Channels window

Petitioner Microsoft Corporation - Ex. 1006, p. 159



' 6 0 Part lll: Flipping through the Channels

Hot Map

search

IR ? city ——Service buttons
Figure 11-1: ' N E
Take an A *@#
onl!ne ﬂ i B ! '[ H L E l T ’Y' absoad

vacation Celebrate America's 1st orlando h t th A

. .. eiebrate America's 1s , rlando has go e
with Digital public beach with Digital (F'f, Ohmipics covered! Click

City. v City Boston! here!

IS . [ cremnes. [ remeeneerwices o [ Fmp  [TFEEDBAGK - Weyword: Digital City

Featured areas Utility buttons

Occupying most of the window is the HotMap, my own highly technical term for
the clickable U.S. map image. To the right of that are the Digital City service
buttons, with their links to the search area, International channel, and still more.

Below the map are the ever-changing featured areas, which may or may not actually
relate to travel. Supporting the featured areas (and getting slightly stepped on
in the process) are the utility buttons, which link you to the Channels window,
the Member Services area, and the America Online Find system. This window
also sports a Feedback button to capture your questions and suggestions.

Wandering the Urbs

In keeping with the map motif, everything in the Digital City channel is organized
by region. To see what’s available in a particular part of the country, click the
region’s big red button in the HotMap. After a moment, the regional window
appears, just like in Figure 11-2. To jump here directly, use one of the following
regional keywords:

DC MidAtlantic DC Northwest DC West
DC Midwest DC South
DC Northeast DC Southwest
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Keyword: BC MIDWEST

search

acity
Figure ‘"-2. what's hot!
Even though :
Indianapolis JEEE . 1) 4
iS missing, e : ' feedback
there's still

O < W EST REGION -

Se? in the AQL Het has 28.8k bps lines in . Do you have what it takes to be
Midwest. your city. Upgrade your 3 a Digital City Heckier ? Find out
connectivity now! here!

Cities marked with buttons (like Chicago, Minneapolis-St. Paul, and the others
in the figure) have their own special online areas. To take a quick digital road
trip, click the city’s button, and then get ready to ride. After only a few moments
of travel (or travail, depending on your voyaging companions), the locality’s
special Digital City window pops up (see Figure 11-3). It’s the hub of online
urban activity, featuring local news and weather, discussion boards, and chat
areas. If you're really visiting the city, check out the mini-tour, an online stroll
through the shopping, sites, and entertainment awaiting you. When | wrote this
chapter, each of the following keywords led to full-fledged Digital City areas.

IR
Figure 11-3:
Nothing like

a quick trip
to the Twin
Cities.
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otk

You may notice that Alaska is one of the cifies on the keyword list. / know that
Alaska is a state, but apparently the folks at Digital City haven’t heard that yet.
(Maybe they decide by population or something.) Anyway, | just wanted to
clarify that point of geographic trivia. Thanks.

Alaska Honolulu Phoenix
Atlanta Houston San Diego
Boston Los Angeles San Francisco
Chicago Miami Seattle
Cleveland Minneapolis Tampa

Dallas New York Toronto
Denver Orlando Washington
Detroit Philadelphia

If your city isn’t on the map, don't give up hope! To look for other cities, follow
these steps:

1. Click the Search a City button.
The Find Your City dialog box hops into action.

The Search a City button shows up on just about every window in Digital
City. Look for a kinda goofy picture of a blue-faced guy holding a magnify-
ing glass. (It’s hard to miss.) If you can't find it, use keyword Digital City to
bring up the main window and click the Search a City button on the right
side of the screen.

2. Type the name of your favorite city, and then press Enter.

If your city has its own little corner of the online world, a Search Results
dialog box appears. If nothing remotely like the name you entered exists
on the system, America Online sadly reports that no articles were found. In
that case, check your spelling or try a difierent city. Sorry, but such is life
sometimes.

3. To look at the city’s online area, double-click the city name in the Search
Results dialog box.

Without further ado, the city’s window pops into view.

To simply browse through a list of all available cities, click the List of Cities
button on any regional window (keywords West, South, Northeast, and so on).
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In This Chapter
p The entertainment basics
p A quick tour of the channel
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f you take America’s top three entertainment capitals (New York City,

Hollywood, and Branson, Missouri) and digitally roll them into one place,
toss in a computer game or two, season the concoction with a touch of Las
Vegas in the summer, and then hang Christmas tree lights on it, you'd be close
to the flavor of the America Online Entertainment channel. Close, mind you, but
still not quite there.

This area simply is entertainment. It doesn’t matter what you're into, because
it'’s all here (within the bounds of good taste, of course — no accordion players
need apply). Movies, theatre, music, sports, trivia, entertainment news, online
games, and even places to mix and mingle with new people — the Entertain-
ment channel is all that and more.

Geez, why bother to go out on Friday? Go in to America Online instead and head
for the Entertainment zone.

The Entertainment Basics

After you're into America Online, the Entertainment channel is only a step or
two away. Table 12-1 outlines the two easiest ways to get there. As you pull up
to the Entertainment area in your chauffeured access software, the window in
Figure 12-1 greets you.
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Table 12-1  Getting to the Entertainment Window
To Get There with Use This

Channels window

Keyword Entertainment

On the right, you have an alphabetical service list covering all the forums, groups,
and services in the Entertainment area. On the left of the window and above
and below the service list (just behind the photographers and a little to the
side of the TV cameras) are the featured groups and forums items, leading you,
with a single click, to some fascinating places. And at the bottom of the window,
nipping at your heels like autograph hounds, are utility buttons for quick access
to the Channels window, the Member Services help--think-I’'m-going-to-faint window,
and the Find button.

1~ Some entertaining things can be found in the Newsstand as well, such as
the Chicago Tribune, the Orlando Sentinel Online, and Stereo Review
magazine. If things ever get a little quiet here in Entertainment, try the
Newsstand for a change of scenery.

v~ 1 say it in other chapters, and I'll say it again here: The Find function is a
nice idea, but it’s not always up to date. Go ahead and try it, but don't get
all bent out of shape if something you're interested in is missing.

 Featured groups and forums Service list

aol.entertainment

o = . Astronet
Television f§ £3 Babylon 5
! i 22 Cartoon Network
Comedy { i Chat B 03 Cartoons Forum
Movies { | Online Originals i &2 Casting Central
T o ! [ &3 CBS - WEB
R ! Fictional Realm i News Sensations L
Figure 12-1: Music Space | | webentertainment
Let me P AOL Live The Industry
entertain { - . | ! The Store
you... ’ L —
R A0L CHA) H PAEMBER SERYVICES § FiMU ] q= d: Entedairanent

Utitity buttons
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Howmes of the Stars — Get Your Maps Here

It’s time to take a swing through the whole Entertainment area, from A (ABC
Online) to Z (Zombie Detective). This section is your self-guided tour through
the main groups and forums that Entertainment has to offer.

Everything in this section is grouped under larger topic headings. If you're
interested in music, check out forums under the Music and TV topic. Likewise,
for those of you who think the universe revolves around the movie industry,
have a look at the Media and movies entries. | admit to making up the groupings
myself in a valiant effort to make the forums and groups list a little more useful.
Alphabetical lists only do so much for comprehension, you know.

g 1~ Remember that some of these options take you directly to service areas,
. while others (like Movies and the Online Gaming Forum) throw you into
another menu. Don’t panic if the options behave a little differently some-
times — it’s just how they are.
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Games and gaming

Want to have some online fun? Do you like interacting with other people,
experiencing boundless adventure, or winning big (albeit play) bucks? If so, try
out the following forums and groups. For interactive play with other America
Online members, try out Neverwinter Nights (keyword AD&D), RabbitJack’s
Casino (keyword Casino), and the Games Parlor (keyword Parlor). Look in the
Online Gaming Forums for board gaming, game design, interactive role playing,
and much more,

1~ Use keyword Download games and then select AD&D Online. Choose the
Neverwinter Nights Information option for all the details. Although this
software used to cost, it’s now free to download. And I do mean free — you
don’t even pay for the time to download it.

+ You need special software for RabbitJack’s Casino, but it's also free for the
downloading. To get the software, use keyword Casino and then click the
AOL Games Download Center button. Follow the instructions and enjoy

yourself!
AD&D Horoscopes
Casino Trivia
Games Star Wars
Gaming Starfleet

Magazines and newspapers

They don’t call it the entertainment industry for nothing. It’s a big business, with
a lot going on at any given moment. To keep up with the latest entertainment
news — and to just read for fun — browse through these online publications.
Several of these, like the Atlantic Monthly and the New York Times, carry a
variety of articles in addition to entertainment-oriented features.

Atlantic Omni

Columnists SOD (Soap Opera Digest)
Disney Magazine Spin

Entertainment Weekly Times

Extra
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If you're the person who knows the details on every new movie, what all the
stars are up to, and which book just hit number one on the nonfiction chart, 1
know your secret: You hang out in these eight forums on America Online. And if
you're not that person but aspire to be that way, here’s your information gold

mine. Start digging!

AEN (American Entertainment
Network)

Books
Critics

Hollywood

Music and TV

Movies
NTN Trivia
Playbill

Radio

For the music fans out there, America Online offers some truly, well, eclectic
forums. If the TV is more to your liking, check out the online areas of ABC and
NBC for scheduling, special events, and information on joining the live studio
audience of your favorite show. You can even let the studios know what you
think about their shows. (And the experts say that interactive television is
years away. I say the experts just don’t know where to look.)

ABC

Cartoon Network
Comedy Central
Comedy Pub
Court TV
Cyberserials
Discovery

E Entertainment

Dead (Grateful Dead)

Rockline
Rocklink
SciFi Channel
SPIN

v

TV Gossip

TV Spoofs

TV Viewers

VH1

(continued)
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MTV Videos
Nick at Nite Wamer
Not NBC WB

Other entertaining things

As with most groups, some things just don't quite fit. These last few forums are
out on the edge of the bell curve, expressing their unique individuality to such a
degree that I just about had a hairy conniption trying to figure out what to do
with them. But they’re fun just the same. '

\\J To fully experience LaPub, use keyword LaPub, go to the LaPub Cellar folder,
and then select LaPub Sounds. Read the “About LaPub Sounds” information and
download the “Special Events Sounds” file (in Macintosh or Windows sound
format, depending on your computer). Install these puppies and then check out
LaPub. You'll be glad you did.

Cartoons HO (Hecklers Online)
Casting LaPub

Celebrity Circle Parascope

Center Stage | Premier Dining

DC Comics Soundbites
Follywood Treasures

Each DC Comics press area offers previews of the coming weeks’ cover art, plot
overviews to whet your appetite, a discussion board to swap shop talk, and a
download library filled with your favorite heroes and villains.
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Games
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In This Chapter

p Game channel basics

b Peeking at the game genres
p Sharing a few of my favorites
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M any years ago when 1 was a little nerdlet, I discovered the family
Monopoly set. 1 immediately fell in love. Those cool little playing pieces,
the crisp feel of the multicolored money, and the tasty little houses (okay, so |
ate one — [ was really little) forever hooked me on gaming. If playing games
ranks among your true loves, join me for a jaunt through the ultimate gamer’s
candy store: America Online’s Games channel.

Whatever your pleasure, this channel covers it. Drop in for a dogfight between
classic World War Il fighters, match wits and drinks with a few dozen ogres in
the [ocal inn, race to remember the name of Dudley Do-Right’s horse in a
national trivia challenge, engage a new friend in a friendly game of chance, and
then download the Doom patch that turns the monsters into Homer Simpson
look-alikes. Hmm — not bad for your first 15 minutes!

This chapter explores the channel, shines light into the murky depths of the
various game areas, and even divulges my favorite gaming spots. This stuff is
too good to miss!

Playing the Basic Game (and Saving
the Advanced Stuff for Later)

Getting into the channel is easy; deciding what to do first is the challenge. Take
this one step at a time and work on simple arrival for now. (Content comes later
in the chapter.) To join the fun, use the map disguised as Table 13-1. After a brief
trek through the digital wilderness, the Games channel bursts onto the scene,
looking a lot like Figure 13-1.
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Figure 13-1:
It's wild, fun,
and high-
tech —it's
the America
Online
Games
channel.
S———

Tahle 13-1
To Get There with

Getting to the Games
Use This

Channels window

Keyword

Service buttons

Featured areas Service buttons

Games Channel

ALTION

o,
e

a

—Genre

- — buttons
. S;MUU‘“ON

S0L THSMMELS PIEREE]

Utility buttons

Front and center in the Games channel window are the current featured areas.
These areas change at the whims of someone who can’t seem to make up his
mind, so don’t worry if your screen doesn’t show the same options as Figure
13-1. The service buttons flank the featured areas on both sides, providing quick
links to information-oriented areas scattered throughout the channel.

The ever-cool, always-important genre buttons fill up most of the window. Each
button leads to a window focused on a particular facet of gaming. (And if you
think that sounds cool, just wait until you see it in action.) Quietly enjoying
themselves, but available nonetheless, the utility buttons round out the
window’s complement of tools. If returning to the Channels window, popping off
to Member Services, or flipping through the Channel Find window ever sound
interesting, head south to the appropriate utility button and give it a click.
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Great games make for great! times

All the myriad- chmces in the Games channel
may make your head spin. ‘Granted, that may
entertain your significant other, but it's not much
fun for you. In an effort to increase your enter-
tainment time {and minimize your entertainment
value for everyone else i in the room), here are a
few sugges’uons

{and OtherPlaces) of My Heart SBCUOI’I Iater in

" regulary.

gutde your.own dream team o v1ctory in the
-online fantasy league.

first foray into the ‘*'Dark Lord of the Sith blqws nght off the end of

Games channel. Also take a fook at the “Games . “the brave pilots of the Rebellion or enhst with the

f,;EvnI Empire n this forum s many weekly snmula-

Star Wars Sim Forum (keyword Star Wars):
Watching Star Warsis great, but actually joining -
Luke, Leia, and Ben in their struggle against the

Genre, Genre — Who's Got the Genre?

Remember when the game universe consisted primarily of playing cards and
Monopoly sets? Time, creativity, and computers changed all that. Today,
hundreds of games target the most specific tastes. That’s why the Games
Channel window greets you with eight genre areas — to make finding your

favorites that much easier.

Each genre area includes its own forums and chat rooms, plus links to the
companies that produce the games. And of course, each area includes games,
games, and more games for your playing enjoyment.

To see a genre window, click one of the big TV-ooking buttons strewn across
the lower half of the Games Channel window, or use the following specific
keywords. Both methods summon the genre window of your choice. It arrives
on-screen, much like the Action Games window in Figure 13-2. Although their
layouts ditfer a bit, every genre window includes buttons for games, chat,
forums, and company areas. When you click a button, the list area changes to
show a new collection of entries. From there, browse through the list and
double-lick whatever looks interesting.
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Don’t forget the four quiet little buttons socked away down in the corner. The
About button explains what the genre area covers (and what it doesn't).
Software displays the voluminous Games channel software library screen, with
enough software and add-on products to fill up both your hard drive and your
free time. The Events button directs you to the Events window (keyword CG
Events) for a schedule of chats and other online happenings. And because the
Games channel exists for the joy and fulfillment of its members, the Feedback
button carries your missives of encouragement, support, and occasional
outrage to the channel staff.

Action Ga

Air Warrior

Figure 13-2:
Limber up
your
reflexes
with some
time in
Action
Games.
PONIRGSSNTNE  CHANNELMENU

Even though it’s not actually one of the game zones, the Hot Games area
(keyword GC Hot) earns a special mention for being so darn useful. Use its Top
Picks buttons to see the latest Games channel goodies, check out the free
newsletter behind the Newsletter button, and make the commercial sponsors
happy by trying the Web links.

GC Action GC RPG (Role Playing Games)
GC Classic GC Simulation

GC Knowledge GC Sports

GC Persona GC Strategy
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Games (and Other Places) of My Heart

Although I truly love almost every kind of game on the planet (a trait that my wife
considers to be an attention-deficit issue), I always have a few favorites. The
following keywords lead to the games and game-related areas of America Online
that stole my heart. You'll find a little bit of everything in here, including the Air
Warrior multiplayer action game, the Federation space business simulation,
several crossword areas, and the new love of my life, collectible card games.

Feel free to pencil in your own additions to the list. And if you find something
particularly cool, send me an e-mail about it (my screen name is JKaufeld). I'm
always game for something new!

Air Warrior Game Parlor

ANT (Antagonist Trivia) Game Pro

Atlantic Monthly Word Games GIX (Gaming Information Exchange)

(keyword Atlantic, and then click

the Word Games button) NTN Trivia

CCGF (Collectible Card Games Red Dragon Inn ( keyword People

Forum) Connection in the Arts and Entertain-
ment area)

CGW (Computer Gaming World)
Star Wars Sim

Crosswords (VY Times

Crosswords) Trivial Pursuit

Fantasy League Xwords (Crosswords America)

Federation
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Chapter 14
Health and Fitness
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In This Chapter

p Covering the basics
» Looking for links

p- Fitness is where you find it
# Answering your health questions
p Sharing with people who understand
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men you need answers to tough health questions, or just want some
information about keeping fit as the seasons change, the Health and

Fitness channel is the place to go. This chapter explores America Online’s
Health and Fitness area. Get ready to feel better — it’s Health and Fitness to
the rescuel!

The Basics

The Health and Fitness channel is a quick hike from wherever you happen to be
online. Table 14-1 points out the easiest ways to get there. When you arrive,
flush from the aerobic exertion of the journey, settle into your chair and get
ready to explore the Health and Fitness window, shown in Figure 14-1.

Table 14-1  Getting to the Health and Fitness Channel
To Get There with Use This

~HEALTH,S FINES
Keyword Health and Fitness

Channels window

Like other channel windows, this one offers a variety of information and
connections. Across the middle of the window are the featured areas, advertised
with buttons and big, splashy descriptions. The Highlights list sits quietly in the
lower-right corner of the window, pointing you toward still other interesting
resources. The options in these two areas change all the time, so don’t worry if
your screen looks different than the one in the figure. Opposite the Highlights
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list are buttons for the Health and Fitness service groups. These buttons lead to
tons of related America Online areas and World Wide Web pages. Along the
bottom of the window are the utility buttons, which return you to the Channels
window, send you off to Member Services, and fire up the Find system.

The rest of the chapter lists various forums and services inside Health and
Fitness. Enjoy your journey toward better health!

Links, Links Everywhere

What'’s the claim to fame of the following areas? That’s easy: They’re loved for
their links. These areas are like interactive indexes, listing site after site, with live
links to each one. They’re great places to go when you're in a browsing mood.

Better Health Mental Health

Children’s Health Mental Health Web

Health PEN (Personal Empowerment
Health Resources Network)

Health Web Self-Help

Hot Health (What’s Hot in Health) Women’s Health

Men’s Health Women’s Health Web

Men’s Health Web

Featured areas

Service groups

Health and Fitness '

Help ciy
grief--advice frora an expert in
Onling ¥Ysych, * Get the Answers You Need in Our
o Symptorns and Hlness Datebase.
o The new vegetarians--they're not ’
[ eating sprouts and tofu. Find & Workout Buddy 1o Help Eg‘ T
] You Stay in Shape! ;ag?
R /
Figure 14-1: HIGHLIGHTS
Just L & Health Focus-- What's the Skinny on Ltn-'ﬂ
ustcoming £3 Health Zone- it's always better with a bud
here makes : < : £3 KidCare-- What's Hot?
me feel Health Fithess  Speakersg | =3 Onfine Psyc's Dream Forumt
healthier. Channel Forum  Support Groups S Smifeline
msssmems | & ACL CHANNELS § MEMBERSERVICES § FIND ¥~ "Keywond: Health and Hitness
T u|

[
Utility buttons Highlights list
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: :Evewarea in here is valuable, but some go above
»T‘and beyond the call of duty. Here are the ones
Yol ¢ shouldn t miss:

Special stuff you don’t want to miss

Explanatlon certificate to decorate sts cyber :
walls. Although you can find some great stuff in

177

here, the material is aimed at parents and other

Health (keyword Health): This area has links adults,

“ galore to all kinds of health-related areas and
discussions

Personal Empowerment Network: (keyword |
'PEN): The king of the catch-all area, this area

offers mformatton discussion, chat, anc
’ Health Zone keyword Health Zone): This area ‘darned near any health topic you can thmk of it

is just odd enough to earn a Defies Rational o mcludesa software hbrary

Getting in Shape the Online Way

When it comes to fitness, my favorite exercises are cola pumping and aerobic
reading. I'm getting better, though — | watch what [ eat, drink more water, and
really started working out. If you want to join me in the Quest to See Our Feet,
you're ready for a trip to the fitness-related areas in Health and Fitness.

Your first stop should be the Fitness Forum itself ( keyword Fitness), shown in
Figure 14-2. The links in here cover fitness-related information available all over
both America Online and the Internet.

ARFA (American Running & Fitness Association) Fitness
Backpacker Health Zone
Better Health Running
Bicycling Skiing

Cyberian, Heal Thyself

Everybody wants to know more about how to be healthy. But finding good
information about health topics is next to impossible sometimes. Oh sure, you
can ask your doctor, but those answers aren’t cheap.

When the answer to your question is somewhere between prime time’s latest
hospital drama and a professionally intelligible specialist who’s not part of your
health plan, try some of the following sites. | particularly recommend the
references and links of Better Health ( keyword Better Health) as a place to
start. The Physician On Call area of Columbia (keyword ColumbiaNet) earns a
special mention as well. That’s the place to ask your general health questions
and get answers from real health care professionals.
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¥ Summer camps and Fitness Topics
other adventures for |~ Aerobics -WEB
your Kids. %~ Backpacker
—— ' o Bicycling
<
Figure 14-2 Backpacker - Biathlons -WEB
There' e § Magazine has a new {5 Kayaking -WEB
Fre 5 i look! % Rockclimbing -WEB
alotto Rollethiading “WEB
the fitness it Check out Body <~ Running
thi d i Smarts/ USA %~ Skiing
ing —an M WEEKEND <~ Sports Medicine WEB
this is the <~ Sguash -WEB
place to find Message Fithess | Swimming -WEB
itall Boards Chats
"} Keyword: Fitness ;W
——
Alternative Medicine IMH
Better Health Mental Health
ColumbiaNet PEN (Personal Empowerment Network)
Health Live Psychology
Health Zone Self-Help

Understanding Is the Best Medicine

Just as medicine heals the body, so words soothe the soul. When you're awash
with pain and looking for someone who understands, check out these areas.
One of the best in the bunch is the Speakers and Support Groups list at key-
word Healthlive. This window maps out the scheduled support group chats
and expert presentations in the whole Health and Fitness area. This spot is
definitely one to watch.

Cancer Mental Health

Cerebral Palsy Multiple Sclerosis

Dependency NMSS (National Multiple Sclerosis Sociely
Diabetes NAMI (National Alliance of the Mentally [}
Health Live Self-Help

IMH (Issues in Mental Health)
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The Hub
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In This Chapter
p Basic Hub stuff
» Taking a quick look around
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Tle Hub is. Yes, I can say with certainty that it does, in fact, exist. Quite so.
Unfortunately, going beyond that level of description may be tough. More
than any online area I've ever played with, The Hub defies rational explanation.
Of course, that won’t keep me from trying anyway.

In an online world of information and education, The Hub’s goal is entertain-
ment. How well it succeeds in that goal depends on your point of view. And, of
course, you can’t have an informed point of view without actually giving the
place a try. With that tortured train of thought firmly entrenched in your mind,

take a ( hopefully) entertaining meander through the following pages and find
out what'’s cooking at The Hub.

One word of caution before you start: The Hub is geared toward teens and
adults, not kids, so some parts of the service have a distinctively mature flair.
Don’t say | didn't warn you.

It Doesn’t Get More Basic Than This

Because The Hub is one of America Online’s main channels, finding it is really
easy. Table 15-1 contains all the directions you need. Once you arrive, The
Hub’s main window leaps to the screen, looking a whole lot like Figure 15-1.

Table 15-1 Going to The Hub
To Get There with Use This

Channels window

Keyword Hub
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—Featured areas

THE HUB

Kaufeld, join the raging debate in the
¥en's Guide to the Bible"” message
: boards!

. Download the July “Calendar Girls"

|
Figure 15-1;
The
weirdness
starts Wlt’h Annals of improbable Research: Strange scien .
the area’s & Calendar Girls: Download sexy pin-ups : Link list
name and & Click Here: New sofiware, hardware, Web sites | ;
: N WRUEN - Cyrano: Your personal letter-writing service
JU.St keeps 5 The Dream Show: Instant dream analysis!
going from )
there. ' (3} FEECE&CK
NS, .. [A\OL CHANNELS  MEMBER SERVICES.[EIND i =

|
Utility buttons

Scattered up and down the left side of the window are the featured areas — the
sub-Hubs of interest. These areas change periodically, so don't fret if your
screen doesn’t match Figure 15-1 precisely. The big box in the window’s lower-
right corner is the link list, a menu of The Hub’s different offerings. Not all of
The Hub’s areas have keywords, so this list is the only way to get there.

Along the bottom of the window are the standard utility buttons. AOL Channels
displays the Channels window. Member Services works just like keyword Help —
it brings up the Member Services information window. Finally, Find summons
the new Find dialog box.

Exploring the Sub-Hubs

When you hit The Hub, keep the term diversity uppermost in your mind. That’s
the best word to describe the incredible mix of things waiting for you in here.
Some of the areas are deep and thought provoking; others, well, aren’t. Two
places I highly recommend trying are Global Worldwide Pictures International
(keyword GWPI) and the Annals of Improbable Research (keyword Improb).
Both of these are interactively entertaining, a mix that’s still hard to find in the
online world.

Petitioner Microsoft Corporation - Ex. 1006, p. 130



Chapter 15: The Hub ’8 ’

- Some things are just too good to miss

The ‘Hub has some interesting destmatlons for ~Heaven (keyword Heaven): This place isn't ex-,,“
- teens ~actly the one with angels playing harps, but it's
still worth the visit. | particularly like the Harass -
Your Congressman section, which is filled with
downloadable letters for your representatives in
Washington. The letters cover both sides of most
major controversies {for example, you'll find both
please save the environment and don’ tsave the
environment letters). ‘

. Cyrano (keyword Cyrano): Because lm on.a;_
en names They followed -prewritten letter kick already, the Cyrano area
rmg random flve-letter, i;deserves a mention as well. These lett
T *the more mundane things in life like noisy neigh-
bors, messy roommates, and dropping out of
college. If you're looking for just the right words
~ toeitherend a ﬂght or startong, look in Cyranos?’r :
Poison Pen section flrst , o

The following keywords are some of the other areas 1 suggest visiting in The
Hub. Two items on the list, The Other News and What Should [ Wear?, have no
keywords. To see them, use keyword Hub, scroll through the link list on the
lower-right side until you find each area, and then double-click the area’s entry
on the list. Enjoy!

Channel Zero Konspiracy
Cyrano ] Sourcerer
GWPI (Global Worldwide The Other News (on the link list)

Pictures International)
What Should I Wear? (on the link list)
Heaven

Improb (Annals of Improbable
Research)
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